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Richtlijn voor medische apparatuur
Dit product voldoet aan de vereisten van de Richtlijn 93/42/EEC van de Raad betreffende medische apparaten wanneer het voorzien 
is van het volgende CE-label: 

Dit product is een Medisch Apparaat: 
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Pr. Margrietplantsoen 33, Suite 123,
2595 AM The Haag,
The Netherlands
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Maleisisch registratienummer voor medische apparaten: GB10979720-50888
Malaysia Authorized Representative:
Emergo Malaysia Sdn. Bhd.
Level 16, 1 Sentral Jalan Stesen Sentral 5 KL Sentral, 50470
Kuala Lumpur MALAYSIA

VOORZICHTIG: Volgens de Amerikaanse federale wetgeving is verkoop van dit apparaat uitsluitend toegestaan door of 
op voorschrift van een arts. 

Ieder serieus incident met betrekking tot dit apparaat moet worden gemeld aan NeoSoft en de bevoegde autoriteit van uw lidstaat.
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Veiligheid
Inleiding

Voor een efficiënt en veilig gebruik is het van essentieel belang om deze paragraaf en alle gerelateerde onderwerpen te 
lezen, voordat u de software voor het eerst gaat gebruiken. Tevens is het belangrijk dat u de inhoud van deze handleiding 
begrijpt, voor u het product begint te gebruiken. Het is aan te raden met enige regelmaat de procedures en 
voorzorgsmaatregelen door te nemen. 

De software is alleen bedoeld om gebruikt te worden door gekwalificeerd en opgeleid personeel.

suiteDXT/suiteHEART®-software heeft een verwachte levensduur van 7 jaar vanaf de oorspronkelijke uitgavedatum.

VOORZICHTIG: Volgens de Amerikaanse federale wetgeving is verkoop, distributie en her gebruik van dit 
apparaat uitsluitend toegestaan door of op voorschrift van een arts.

De termen gevaar, waarschuwing en voorzichtig worden in deze handleiding gebruikt om risico's aan te duiden en om een 
gradatie of niveau van ernst aan te geven. Risico wordt gedefinieerd als een bron van mogelijke schade aan een persoon. 
Maak uzelf vertrouwd met de terminologieomschrijvingen in de volgende tabel:

Tabel 1:  Veiligheidsterminologie

Grafisch Definitie

GEVAAR: 

„Gevaar” wordt gebruikt voor situaties of handelingen die zullen leiden tot ernstig lichamelijk 
letsel, overlijden of aanzienlijke eigendomsschade wanneer de aanwijzingen worden 
genegeerd.

WAARSCHUWING: 

Waarschuwing wordt gebruikt voor situaties of handelingen waaraan een specifiek gevaar is 
verbonden.

VOORZICHTIG: 

Voorzichtig wordt gebruikt voor situaties of handelingen waaraan een mogelijk gevaar is 
verbonden.
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Gebruiksaanwijzingen

suiteHEART® Software is een analytische softwaretool die reproduceerbare hulpmiddelen biedt voor het beoordelen en 
rapporteren van medische beelden. suiteHEART® Software kan medische beelden van een MR-systeem importeren en 
weergeven in een weergavegebied op het computerscherm. Het beeldgebied verschaft toegang tot meerdere 
onderzoeken en series van afbeeldingen die zijn opgebouwd uit vele schijven en fasen. Opeenvolgende fasen van 
afbeeldingen kunnen worden getoond in filmmodus om visualisatie te vergemakkelijken.

Een rapportinputinterface is ook beschikbaar. Meettools in de rapportinterface maken het mogelijk om snel en 
betrouwbaar een compleet klinisch rapport van een beeldonderzoek in te vullen. Beschikbare tools zijn onder andere: 
punt, afstand, gebied en volumemeettools, zoals uitstootfractie, hartfunctie, einddiastolisch volume, eindsystolisch 
volume en volumestroommetingen.

Halfautomatische tools zijn beschikbaar voor linkerventriculaire contourdetectie, klepvlakdetectie, vatcontourdetectie 
voor stroomanalyse, signaalsterkteanalyse voor myocard- en infarctomvangmeting, en T2*-analyse.

De resultaten van de meettools worden geïnterpreteerd door de arts en kunnen worden doorgegeven aan verwijzende 
artsen.

Mits ze door een gekwalificeerde arts worden geïnterpreteerd, zijn deze tools nuttig voor het helpen bepalen van een 
diagnose.

Beoogd gebruik

suiteHEART® Software is bedoeld om opgeleid klinisch personeel te helpen bij de kwalificatie en kwantificering van de 
hartfunctie. De software biedt de hulpmiddelen om de parameters van de DICOM-afbeeldingen aan te passen en biedt 
presentatiestaten waar de gebruiker in de loop van de tijd verschillende MRI-afbeeldingen van het hart en het vaatstelsel 
kan beoordelen. Bovendien biedt de software hulpmiddelen voor het meten van lineaire afstanden, gebieden en volumes 
die kunnen worden gebruikt om de hartfunctie te kwantificeren. Ten slotte biedt de software de hulpmiddelen voor 
volumestroommetingen en de mogelijkheid om stroomwaarden te berekenen.

Ondersteunde DICOM-beeldformaten

suiteHEART® Software ondersteunt het volgende DICOM-formaat; MR en verbeterde MR. Raadpleeg de handleiding van 
de suiteHEART® Software DICOM-conformiteitsverklaring voor meer informatie over ondersteunde formaten.

VOORZICHTIG: Gegevens die zijn opgeslagen als een DICOM-afbeelding en die zijn geïmporteerd door een 
externe PACS, zijn mogelijk niet compatibel voor weergave van suiteHEART® Software. 
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Opmerkingen betreffende veiligheid

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
klinische interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve 
metingen is aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde 
diagnoses. Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd 
personeel.

WAARSCHUWING: Artefacten op een afbeelding kunnen verkeerd worden geïnterpreteerd, wat kan leiden tot 
een verkeerde diagnose. Gebruik voor het stellen van een diagnose geen beelden die 
artefacten bevatten. Analyses dienen alleen te worden verricht door goed opgeleide en 
gekwalificeerde gebruikers.

WAARSCHUWING: Als afbeeldingen geen patiëntnaam of ID bevatten, kan de patiënt een verkeerde diagnose 
krijgen. Gebruik geen afbeeldingen zonder patiëntnaam en ID voor diagnose. Bevestig voor 
de analyse visueel de patiëntinformatie.

VOORZICHTIG: Het gebruik van afbeeldingen waarop een beeldfilter is toegepast, kan leiden tot andere 
resultaten. De gebruiker dient discretie te betrachten voor het analyseren van afbeeldingen 
waarvan de pixelintensiteit is gecorrigeerd. De software zal een waarschuwing geven bij het 
laden van gefilterde afbeeldingen.

Risico's van de apparatuur

VOORZICHTIG: Het gebruik van beschadigde of onbetrouwbare apparatuur kan de patiënt in gevaar brengen 
doordat de diagnose wordt vertraagd. Zorg ervoor dat de apparatuur goed functioneert.

VOORZICHTIG: Applicaties kunnen worden uitgevoerd op apparatuur met een of meer harde schijven, waarop 
medische gegevens van patiënten kunnen voorkomen. In sommige landen kunnen richtlijnen 
betreffende het verwerken van persoonlijke gegevens en de vrije circulatie daarvan op het 
gebruik van zulke apparatuur van toepassing zijn. Het vrijgeven van persoonlijke gegevens kan 
leiden tot juridische stappen, afhankelijk van het betreffende overheidsorgaan. Het wordt 
daarom sterk aanbevolen om de toegang tot patiëntbestanden te beschermen. De gebruiker is 
verantwoordelijk voor kennis van de wetten betreffende patiëntinformatiebeheer.
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Aan de slag

De applicatie opstarten en afsluiten
suiteHEART® Software is een applicatie die kan worden gebruikt voor analyse, beoordeling en rapportage van cardiale 
MRI-onderzoeken (Magnetic Resonance Imaging). Deze handleiding geeft een gedetailleerde uitleg van de 
gebruikersinterface van suiteHEART® Software en de workflow voor het uitvoeren van kwantitatieve analyses van MRI-
hartscans.

suiteHEART® Software opstarten
1. Start suiteDXT via de snelkoppeling op het bureaublad.

OPMERKING: Zowel suiteDXT- als suiteHEART® Software-applicaties moeten (tegelijkertijd) actief blijven om de 
noodzakelijke bestandsoverdracht(en) tussen de applicaties te vergemakkelijken.

2. Ga op het hoofdscherm naar het keuzemenu Applicatie starten en selecteer suiteHEART® Software.

FIGUUR 1. Start de applicatie
 

3. Selecteer een onderzoek uit de onderzoekslijst en voer een van de volgende handelingen uit:
• Selecteer starten.
• Dubbelklik op het onderzoek.

4. Selecteer een groep onderzoeken en selecteer Starten.

5. Onderzoeken met afbeeldingen waarop pixelintensiteitsfilters zijn toegepast, worden voor het openen van het 
onderzoek in een berichtvak weergegeven. 

OPMERKING: De schermresolutie moet worden ingesteld op 1920 x 1080 of hoger, anders start de software niet.

WAARSCHUWING: Het gebruik van afbeeldingen waarop pixelintensiteitsfilters zijn toegepast voor analyse kan 
resulteren in onnauwkeurige resultaten.
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suiteHART® Software beëindigen

Om de toepassing af te sluiten, selecteert u File > Exit of klikt u op de X in de rechterbovenhoek van de interface.

FIGUUR 2. suiteHEART® Software afsluiten
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Overzicht van gebruikersinterface
Overzicht

De suiteHEART® Software-interface heeft drie hoofdpanelen zoals getoond in Figuur 1.

• Analyseoverzicht: Biedt analysetools voor elke analysemodus.
• Afbeeldingsoverzicht: Biedt snelle toegang voor beeldanalyse en beoordelingsfuncties.

- Bestaat uit miniatuuroverzichten, bewerkingsvenster en modusoverzicht.
• Rapportoverzicht: Biedt de tools die worden gebruikt voor gestructureerde rapportage.

FIGUUR 1. Drie hoofdpanelen: Analyseoverzicht, afbeeldingsoverzicht, rapportoverzicht

Analyseoverzicht

Miniatuuroverzicht

Rapportoverzicht

Afbeeldingsoverzicht

Bewerkingsvenster Modusoverzicht
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Analyse-/Viewermodi

OPMERKING: Patent Foramen Ovale (PFO) analyse kan worden geselecteerd in het keuzemenu voor bestanden of met Ctrl 5 op 
het toetsenbord.

Serienavigatie

Om afbeeldingen te bekijken of series binnen het geselecteerde onderzoek te wijzigen, gebruikt u de linker en rechter pijltjestoetsen 
bovenaan het Afbeeldingsoverzicht. Het keuzemenu van het seriebestand, links van de knop Filter, kan ook worden gebruikt om de 
serie te selecteren. Series met analyses of interessegebieden worden vetgedrukt aangeduid, zoals weergegeven in Figuur 2.

FIGUUR 2. Serienavigatie

Tabel 1:  Analysemodi

Functieanalyse Stroom 
analyse

Myocardevaluatie T1 
mapping

T2 
mapping

Analyse 
myocardiale 
perfusie

T2*-analyse

Tabel 2:  Viewermodi

Viewer Virtual
Fellow®

3D/4D Flow 
Viewer
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Bewerkingsvenster en modusoverzicht

Als u met de rechtermuisknop op een afbeelding in het Afbeeldingsoverzicht klikt, worden beeldmanipulatietools geactiveerd. 

Bestandsmenuopties
Analyse selecteren – Selecteert de analysemodus (functie, stroom, myocardevaluatie, myocardiale perfusie, PFO, T2*, 

T1-mapping, T2-mapping, 3D/4D Flow Viewer en DENSE*) 
DB doorbladeren – Opent de lokale database
Onderzoek wisselen – Toont beschikbare onderzoeken voor snelle toegang
Rapport vooraf bekijken – Vooraf bekijken van het opgemaakte rapport
Rapport afdrukken – Hiermee drukt u het rapport af
Approve Exam – Keurt de uiteindelijke versie van een rapport goed en sluit het af met een ondertekening
Goedgekeurd onderzoek laden – Herstelt een eerder geopend rapport
Exit – Sluit de applicatie af waarbij de actuele analyseresultaten worden opgeslagen in een secundaire-opnameserie (SCPT).

*Vereist onderzoeksovereenkomst

Toolsmenuopties
Voorkeuren >

Bewerken – Opent de voorkeureneditor om de software- en sjabloonvoorkeuren in te stellen
Importeren – Herstelt gebruikersvoorkeuren en macro’s
Exporteren – Exporteert alle gebruikersvoorkeuren

Exporteren >
Rapport exporteren naar DICOM – Genereert een rapport op basis van de huidige analyse en slaat het op als een 

secundaire-opnameserie (SCPT).
Rapport exporteren naar Excel – Genereert een Excel-spreadsheet met analyseresultaten.
Rapport exporteren naar XML – Exporteert rapport als een XML-bestand.
Beelden naar DICOM exporteren – Slaat een DICOM-cine van de momenteel geselecteerde serie op als een SCPT-bestand.
Rapport exporteren naar... – Exporteert resultaten naar een rapportagesysteem van derden.
Beelden naar JPEG, AVI, enz. – Exporteert momenteel geselecteerde seriebeelden naar een van de geselecteerde 

bestandsindelingen. Beschikbare formaten zijn: gecomprimeerde QuickTime-film, JPEG, TIFF, 
GIF, PNG of niet-gecomprimeerde AVI-film.

Gegevens naar Matlab – Exporteert een mat-bestand in binaire vorm. (Alleen beschikbaar op licentie)
Spanningsgegevens naar Matlab – Exporteert een mat-bestand in binaire vorm. (Spanningsanalyse vereist een 

onderzoeksovereenkomst)

Tabel 3:  Beeldmanipulatietools

Venster/Niveau

Pannen

Zoom

Roteren

Omdraaien

Verzenden naar rapport

Parameters scannen

Resetten
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Rapportdatabase – Opent de databasezoekinterface
Aantekeningen wisselen – Wisselt de weergave van de ROI-aantekeningen
Lijndikte wisselen – Wisselt tussen lijndikte van aantekeningen.
Referentieregels wisselen – Wisselt tussen referentieregels op afbeeldingen.
FOV wisselen – Beeldveld wisselen
Venster/niveau omdraaien – Draait de venster/niveau-weergave om

Helpmenuopties
Gebruiksaanwijzing – suiteHEART® Software-gebruiksaanwijzing
DICOM-conformiteitsverklaring – suiteHEART® Software DICOM-conformiteitsverklaring
Over suiteHEART® – Versie-informatie over de applicatie 
Sneltoetsen – Toetsenbordfuncties

Beeldweergavebesturing

De faseschuifregelaar  regelt de selectie van de cine-fase.

De afbeeldingsstappictogrammen  maken navigatie per plakje 
mogelijk wanneer de miniatuurweergave in plakjes of fasen gebeurt.

Op uw toetsenbord regelen de pijltoetsen links en rechts de navigatie tussen plakjes en de pijltoetsen omhoog en omlaag bepalen de 
navigatie tussen fasen, afhankelijk van uw voorkeursinstelling. 

OPMERKING: De x-as (segment) en y-as (fase) kunnen worden verwisseld. Zie Functie op pagina 34. Als ze verwisseld zijn, moet de 
applicatie opnieuw worden gestart.

Modusweergaven

De modusweergave heeft drie beschikbare formaten:

Cinemodus

 – Cine: Regelt het bekijken van een cine-beeld in een filmstand.

 – Cine-standbalk: Definieert het begin- en eindframe van de film.

 – Beelden per seconde (FPS): Klik op de pijl of voer een waarde in het tekstvak in om de cine-snelheid te wijzigen

 – Afspeelpictogram: Staat naast de cine-modusbalk
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 – Pauzepictogram: Staat naast de cine-modusbalk

Matrixmodus

– Matrixmoduspictogram: Toont de afbeeldingen in plakjes/fasen in rastervorm

De voor analyse geselecteerde afbeeldingen zijn gemarkeerd en de endocard- en epicardcontouren worden vermeld. De 
matrixmodus kan worden gebruikt om in fasen te navigeren. De ED- en ES-toetsen kunnen worden gebruikt om de fasen in de matrix 
te selecteren. Door op een cel in de matrix te klikken, wordt de plak in de Image Editor weergegeven.

De matrixmodus ondersteunt het verwijderen van contouren op een plaklocatie binnen een rij of kolom, wat kan worden uitgevoerd 
door het plaknummer of fasenummer te selecteren en met een rechtermuisklik de prullenbak te selecteren. Contouren uit een 
enkele fase, een groep fasen of plakjes kunnen ook worden gemaakt door de gewenste fase en plaklocaties op de matrix rechtstreeks 
te selecteren en met een rechtermuisklik de prullenbak te selecteren.

OPMERKING: De x-as (plak) en y-as (fase) kunnen worden verwisseld. Zie Functie op pagina 34. Als de voorkeur wordt gewijzigd, 
moet de applicatie opnieuw worden gestart.

FIGUUR 3. Matrixmodus

De matrixmodus wordt gebruikt om de eindsystolische en einddiastolische fasen te beoordelen en toe te wijzen. Het kan worden 
gebruikt in de enkele ED/ES-modus als de hartslag verandert tijdens acquisitie om een nauwkeurige meting te verkrijgen van 
eindsystolische en einddiastolische volumes. Selecteer de ES-toets en klik op de cellen in de matrixmodus om de gespecificeerde 
plak/fase als eindsystolisch in te stellen. Selecteer de ES-toets en klik op de cellen in de matrixmodus om de gespecificeerde plak/fase 
als einddiastolisch in te stellen. De volumes worden automatisch opnieuw berekend als de eindsystolische en -diastolische 
afbeeldingen zijn geselecteerd.
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Referentiemodus

De referentiemodus toont de lange-asweergave van een afbeelding terwijl de korte-asweergave wordt weergegeven in het 
beeldbewerkingsvenster. De lange-asweergave is een orthogonale plak binnen een hoek van de weergegeven afbeelding in het 
bewerkingsvenster. Er is een keuzemenu van alle beschikbare orthogonale schijven, net als een toets om te schakelen tussen de 
weergaven van de referentieschijfindicatoren. Gebruik de min en plus om tussen plaklocaties te navigeren.

FIGUUR 4. Referentiebediening

 

FIGUUR 5. Referentiemoduspictogram

Beeldmanipulatietools

Tabel 4:  Toolbeschrijvingen

Schakelen tussen beoordeling van plak/fase

Venster/Niveau – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Pannen – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Zoom – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Roteren – Selecteer en gebruik de middelste muistoets om wijzigingen te maken

Horizontaal draaien – Draait de afbeelding horizontaal

Toepassingsgebied Alle – Past beeldmanipulatie toe op alle plakken
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Toepassingsgebied Huidige tot Laatste – Past beeldmanipulaties toe van de huidige plak tot de laatste plak

Toepassingsgebied Alleen Huidige – Past beeldmanipulatie alleen toe op de huidige plak

Kijkvensterlay-out – wijzig kijkvensterlay-out

Vergelijkingsmodus – Wijzig naar vergelijkingsmodus

Beoordelingsmodus – Wijzig naar beoordelingsmodus

Referentieregels tonen – Schakelt referentieregels in/uit

Kleurenkaartoverlay – Schakelt kleurenkaart voor plakclassificatie in/uit

Resetten – Stelt Venster/Niveau, Pannen, Zoom en Roteren opnieuw in op standaard, op basis van de 
instelling van het toepassingsgebied

Interessegebied – Geeft afmetingen van oppervlakte en omtrek aan

Dradenkruis – Geeft een steekproef van gegevens met één pixel

Lineair – Geeft afmeting van de afstand van een rechte lijn aan

Label – Zorgt voor de toevoeging van gebruikersannotatie in het Bewerkingsvenster

Hoek – Geeft hoekmeting aan

Tabel 4:  Toolbeschrijvingen
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Sneltoetsen 

Zoekfunctie – Referentietool om beelden met dezelfde locatie automatisch te identificeren en weer te 
geven

Opheffen – Hef functionaliteit beschikbaar voor ROI-bewerking op

Vernieuwen – Klik op de knop om het Afbeeldingsoverzicht bij te werken met recent aan het netwerk 
toegevoegde afbeeldingen

Filter – Sorteert series op type pulssequentie volgens de analysemodus. Kan worden uitgeschakeld door 
ALLE te selecteren. Filters kunnen worden ingesteld onder Voorkeuren. De filterknop is groen als een filter 
in gebruik is.

Tabel 5:  Sneltoetsen

Functie Actie

Afbeelding zoomen Ctrl + Middelste Muistoets

Roteer afbeelding Ctrl + Shift + Middelste Muistoets

Draai afbeelding Shift + Middelste Muistoets

Venster/niveau Alt + middelste muistoets

Cine afspelen/pauzeren Spatiebalk

Selecteer alle afbeeldingen 
opnieuw voor weergave

Ctrl+A

Rapportdatabase Ctrl+D

Wijzigen Ctrl+E

Schakel beeldveld in (FOV) Ctrl+F

Onderzoek goedkeuren Ctrl+G

Venster/niveau omdraaien Ctrl+I

Dikkelijnaantekening Ctrl+L

Open Bladeren in DB Ctrl+O

Druk rapport af Ctrl+P

Sluit of verlaat applicatie Ctrl+Q

Voorbeeldrapport openen Ctrl+R

Onderzoek wisselen Ctrl+S

Wissel annotatie Ctrl+T

Wissel kruisverwijzingslijnen Ctrl+X

Annuleren Ctrl+Z

Tabel 4:  Toolbeschrijvingen
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*De actieve instelling is afhankelijk van wat is gekozen in Voorkeuren.

DENSE Ctrl+0

Functie Ctrl+1

Stroom Ctrl+2

Myocardevaluatie Ctrl+3

Myocardiale perfusie Ctrl+4

PFO Ctrl+5

T2Star Ctrl+6

T1-mapping Ctrl+7

T2-mapping Ctrl+8

3D/4D Flow Viewer Ctrl+9

Navigeren tussen plakken* Linker en rechter pijltjestoetsen

Navigeren tussen fasen* Pijltjestoetsen omhoog en omlaag

Virtual Fellow®-plak navigeren Z- en A-toets voor volgende en vorige plak

ROI-bewerkingstools

ROI kopiëren Ctrl+C

ROI plakken Ctrl+V

ROI gladmaken Ctrl+S

Verschuif ROI horizontaal W- en S-toets

Verschuif ROI verticaal A- en D-toets

Genereer een punt-splinehoek Alt + linkermuisknop

Een punt verwijderen (punt-spline) VERWIJDEREN + cursor op een punt

3D/4D Flow Viewer bewerkingstools

3D draaien Ctrl + Alt + middelste muistoets

Afbeelding zoomen Ctrl + middelste muistoets

Venster/niveau Alt + middelste muistoets

Tabel 5:  Sneltoetsen

Functie Actie
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Analyseweergave

De analyseweergave is beschikbaar voor elke analysemodus.

FIGUUR 6. Elementen van analyseweergave

 1. Resultatentabel, 2. Grafiekweergave, 3. Wissen, 4. Diagrammen, 5. Tabellen
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2
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4
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Beoordeling van analyseweergave

Resultatentabel

De meetresultaten kunnen opnieuw worden gerangschikt en geconfigureerd in voorkeuren (raadpleeg Afdruktabblad op pagina 43). 
De meettabel kan opnieuw worden gerangschikt door een rij te selecteren en naar een nieuwe positie te slepen. De volgorde van de 
tabel wordt altijd standaard ingesteld op de volgorde van voorkeur voor alle nieuwe onderzoeken. Selecteer of deselecteer een 
meting voor opname in het rapport door op het vakje naast de parameter te klikken.

FIGUUR 7. Resultatentabel

OPMERKING: Klik direct op de tabel in de kolom om de hartslag in te voeren of te bewerken.

 Grafiek- en tabelresultaten

Resultaten kunnen worden weergegeven als een grafiek of in tabelvorm door op het gewenste pictogram in de rechteronderhoek van 
de analyseweergave te klikken.

FIGUUR 8. Grafiek (links) en tabel (rechts)



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      17

Tabel 6:  Analysetools

 Linker ventriculaire endocardiale ROI  Linker ventriculaire lokale ROI

 Linker ventriculaire epicardiale ROI
 Linker ventriculaire bloedpool ROI

 Rechter ventriculaire endocardiale ROI

 

 Rechter ventriculaire epicardiale ROI

 Annulus van mitralisklep

 Annulus van tricuspidalisklep

 Insteekpunt rechter ventriculair

 Linker ventriculaire papilaire spier ROI

 Rechter ventriculaire papillaire spier ROI

 Linker atrium ROI 

 Rechter atrium ROI

 Lange-as LV endocardiale ROI 

 Lange-as LV epicardiale ROI 

 Linker ventriculaire septale ROI
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Rapportweergave

suiteHEART® Software heeft vier rapportweergaven voor gestructureerde rapportage. Raadpleeg Gestructureerd rapporteren op 
pagina 163 voor meer informatie.

FIGUUR 9. Tabbladen Rapportage

 – Voorbeeldrapport: Gebruikt voor het vooraf bekijken van een rapport          

 – Onderzoek goedkeuren: Gebruikt voor rapporthandtekening                   
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Doorzoekbare DB

Het venster Doorzoeken DB geeft een overzicht van de actuele onderzoeken van de lokale database. Er zijn bedieningselementen 
waarmee u kunt kiezen welke onderzoeken u wilt bekijken of toevoegen aan de lijst met onderzoeken om tussen te wisselen.

FIGUUR 10. Bladeren in DB

1. Lijst met lokale databases, 2. suiteHEART® Software databaseviewer, 3. Toevoegen aan Viewer-knop, 4. Verwijderen van Viewer, 
5. Weergave bijwerken, 6. Annuleren

Functies van de Doorzoekbare DB

De doorzoekbare DB verwijst standaard naar de lokale database.

1. Lijst lokale database – toont de onderzoeken die zijn opgeslagen in de lokale database. 
2. suiteHEART® Software databaseviewer – toont de onderzoeken die zich bevinden in de actuele suiteHEART® Software-database.
3. Aan viewer toevoegen – voegt het geselecteerde onderzoek uit de lokale database (te zien in het bovenste deel van het venster) 

toe aan het suiteHEART® Software-databaseweergavegebied.
4. Uit viewer verwijderen – Verwijdert het onderzoek uit het suiteHEART® Software-databaseweergavegebied.
5. Update viewer – Sluit het venster Doorzoekbare database en brengt de onderzoeken uit het te bekijken lijstgebied naar de 

applicatieviewer. Wordt gebruikt om het venster Onderzoek wisselen te vullen.
6. Annuleren – Sluit het venster Doorzoekbare database zonder veranderingen in de lijst aan te brengen.

1

2

3 4

6

5
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Procedure voor doorzoekbare DB

Onderzoeken kunnen worden bekeken door ze in de lokale database te selecteren, toe te voegen aan de suiteHEART® Software-
databaseviewerlijst en te klikken op Weergave bijwerken.

Voeg onderzoeken toe aan de suiteHEART® Software-lijst Onderzoek wisselen

1. Klik op Bestand > Doorzoekbare DB.
2. Zoek het onderzoek in de databaseviewer en klik op het onderzoek om het te markeren.
3. Klik op Aan viewer toevoegen.
4. Klik op Update View (Beeld bijwerken).
5. Het onderzoek verschijnt nu in de suiteHEART® Software-lijst Onderzoek wisselen.

Verwijder onderzoeken uit de suiteHEART® Software-lijst Onderzoek wisselen

1. Klik op Bestand > Doorzoekbare DB.
2. Zoek het onderzoek en klik vervolgens op Verwijderen uit Viewer.
3. Klik op Viewer bijwerken.

VOORZICHTIG: Wis het onderzoek niet dat momenteel is geopend in de suiteHEART® Software.

Onderzoeken moeten in suiteHEART® Software zijn geladen, voordat ze in de Viewer kunnen worden getoond. Zie Procedure voor 
doorzoekbare DB op pagina 20 voor informatie over het vullen van de lijst Onderzoek wisselen.

Wisselen tussen studies binnen suiteHEART® Software

1. Klik op Bestand > Onderzoek wisselen.
Het venster Beschikbare onderzoeken wordt weergegeven met een lijst van alle onderzoeken die eerder waren geladen via 
de procedure voor Doorzoekbare DB.

2. Selecteer het onderzoek.
Klik als u het onderzoek niet wilt wisselen na het openen van het venster Onderzoek wisselen buiten het venster om terug te 
keren naar de applicatie.
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Afbeeldingbeheertools

Viewer
Met de viewer kan een snelle controle van het onderzoek worden uitgevoerd met kruisverwijzing. De viewer-interface 
geeft de lijst weer van de series die zijn verkregen voor het geselecteerde onderzoek, waarbij elke serie wordt weergegeven 
in een kijkvenster. Er kunnen nieuwe serietypen worden gevormd voor analyse en controle in de viewerinterface. Door 
de gebruiker gedefinieerde weergaveprotocollen voor routinematig verkregen series kunnen ook worden aangemaakt 
om controle van het onderzoek te versnellen.

OPMERKING: Exporteren van beelden kan alleen worden uitgevoerd in de analysemodi. 

FIGUUR 1. Viewer 

1. Lijst van onderzoeksseries, 2. Kijkvenster voor serie/plakje, 3. Kruisverwijzing, 4. Serie opslaan, 5. Weergaveprotocollen, 
6. Overschakelen naar rapporttabs, 7. Zoekfunctie, 8. Meetinstrumenten
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Beeld-/serienavigatie

Klik op een serie en gebruik Page Up (pagina omhoog) of Page Down (pagina omlaag) op het toetsenbord om door 
plaklocaties binnen de serie te navigeren.

Navigeer naar de volgende series door te drukken op de rechter pijltoets op het toetsenbord en de linker pijltoets voor de 
vorige series.

Wanneer er wordt genavigeerd naar multi-fase series, worden ze weergegeven in een auto indeling, echter, enkele-fase 
series worden weergegeven in een 1 x 1-indeling.

Zoekfunctie*

1. Selecteer  om de kruisverwijstool te gebruiken. 

De paarse cursor is de primaire cursor die op de afbeelding kan worden geplaatst. 

2. Druk op de Ctrl-toets en selecteer de kruisverwijzingstool om de primaire cursor te activeren. Alle nabije plaklocaties 
worden automatisch weergegeven. 

De hoofdweergave wordt dan gevuld met alleen de plakken waar de secundaire groene cursor werd berekend als 
zijnde dichtbij de primaire paarse cursor. 

OPMERKING: De groene secundaire aantekeningen verschijnen op kijkvensters met niet-parallelle afbeeldingen en op 
punten waarvan wordt berekend dat deze binnen een 3D-afstand van 10 mm van de primaire cursor 
liggen.

OPMERKING: De groene secundaire aantekeningen verschijnen op kijkvensters met parallelle afbeeldingen en op 
punten waarvan wordt berekend dat deze binnen een 3D-afstand van 5 mm van de primaire paarse 
cursor liggen.

Sneltoets              

*Voorlopige Amerikaanse Patentaanvraag nr. 62/923.061
Titel: Methode en Systeem voor het Identificeren en Weergeven van Medische Beelden
Uitvinder(s): Wolff et al.

Functie Actie

Selecteer alle afbeeldingen 
opnieuw voor weergave

Ctrl+A



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      23

Viewerfunctionaliteit

Een nieuwe serie aanmaken

Met de viewer kunnen serietypen worden gevormd die kunnen worden gebruikt voor analyse van functie, 
myocardiale evaluatie, myocordiale perfusie, T2Star, T1-mapping, T2-mapping alleen voor controle (aangepast). 
Series die worden gemaakt, worden toegevoegd aan de serielijst voor dat onderzoek en zijn beschikbaar voor 
weergave en analyse in de toepassing suiteHEART® Software.

OPMERKING: Om een serie geldig te maken voor analyse, moet elke plaklocatie hetzelfde aantal fasen, dezelfde 
registratieparameters en hetzelfde scanvlakvoorschrift hebben.

WAARSCHUWING: De gebruiker is verantwoordelijk voor het maken van een nieuwe serie voor analyse die 
de juiste afbeeldingen daarvoor bevat. Onjuist samengestelde series kunnen wel worden 
geanalyseerd maar kunnen incorrecte resultaten opleveren. De gebruiker moet zijn 
gekwalificeerd in het uitvoeren van hartanalyses en moet op de hoogte zijn van de naar 
de nieuwe serie gekopieerde plaklocaties. Verwijder geen originele afbeeldingen die zijn 
gebruikt voor DICOM-import.

1. Selecteer de gewenste series of plaklocaties uit de serielijst.
2. Selecteer een groep series of plaklocaties door een Shift-klik of een Ctrl-klik uit te voeren om een enkele serie of plaklocatie 

toe te voegen.
3. Door te klikken en slepen kunt u de afbeeldingen in de kijkvensters ordenen.
4. Om een afbeelding uit een kijkvenster te verwijderen, selecteert u het kijkvenster en drukt u op de Delete-toets op het 

toetsenbord.

5. Selecteer  in het venster Save Series Figuur 2.

FIGUUR 2. Venster Save Series

6. Typ een serienaam voor de toepassingsseriebeschrijving. 
7. Selecteer het juiste serietoepassingstype in het keuzemenu (Figuur 3). Als Aangepast is geselecteerd, kunnen 

afbeeldingen met verschillende scanvlakken en volgordetypes als een serie worden opgeslagen.
FIGUUR 3. Nieuwe serie opslaan
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Maak een weergaveprotocol aan

Versnel het beoordelingsproces door een weergaveprotocol te maken waarmee een door de gebruiker 
gedefinieerde kijkvensterindeling wordt opgeslagen op basis van het serielabel.

OPMERKING: Voor weergaveprotocollen moeten de serielabels hetzelfde zijn voor elk onderzoek. Als serielabels zijn 
gewijzigd, worden de afbeeldingen niet in het kijkvenster weergegeven. 

WAARSCHUWING: De gebruiker is verantwoordelijk voor het maken van weergaveprotocollen voor 
beoordeling die de juiste serietypen bevatten. Als de serielabels in een onderzoek worden 
gewijzigd, moet het weergaveprotocol opnieuw worden opgeslagen. Controleer altijd de 
serielijst om vast te stellen of de juiste serietypen voor beoordeling worden gebruikt.

1. Selecteer de gewenste series of plaklocaties uit de serielijst. 
2. Selecteer een groep series of plaklocaties door een Shift-klik of een Ctrl-klik uit te voeren om een enkele serie of plaklocatie 

toe te voegen.
3. Door te klikken en slepen kunt u de afbeeldingen in de kijkvensters ordenen.
4. Om een afbeelding uit een kijkvenster te verwijderen, selecteert u het kijkvenster en drukt u op de Delete-toets op het 

toetsenbord.

5. Selecteer  in het weergaveprotocolpaneel.
6. Typ een labelnaam en selecteer een voorkeuzenummer in het keuzemenu (Figuur 4).
7. Klik op OK om op te slaan.

FIGUUR 4. Weergaveprotocol opslaan

Rapportageweergave-tabbladen openen

Klik op  om de rapportageweergave-tabbladen te openen.

Klik op  om terug te keren naar viewerfunctionaliteit.
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Vergelijkingsmodus
De vergelijkingsmodus biedt u de mogelijkheid om afbeeldingen/series van een huidig onderzoek of van een eerder 
onderzoek tegelijkertijd binnen dezelfde interface te bekijken.

OPMERKING: Afbeeldingen die in de vergelijkingsmodus naar een rapport worden verzonden, hebben de 
bitmapindeling. Op deze afbeeldingen zijn geen beeldmanipulaties mogelijk.

WAARSCHUWING: Controleer visueel, voorafgaand aan de beoordeling of vergelijking van onderzoeken of 
series binnen een onderzoek, alle patiëntinformatie voor beide viewers. 

FIGUUR 5. Viewer voor de vergelijkingsmodus
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Viewer Uitroepen Beschrijving

Viewer 1 1 Keuzemenu series

2 Serie-selectieknop

3 Aanduidingsregel momenteel bekeken 
patiëntonderzoek

4 Beeldbediening

5 Kijkvensterlay-out-keuzes

Viewer 2 6 Aanduidingsregel momenteel bekeken 
patiëntonderzoek

7 Onderzoeksselectieknop 

8 Serie-selectieknop 

9 Kijkvensterlay-out-keuzes

Beide viewers 10 Wijzig de bereikinstellingen

11 Schakel voor beoordelingsmodus

12 Schakel voor gesynchroniseerd filmpje
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Werkstroomvoorbeeld
1. Dubbelklik op het bewerkingsvenster op een willekeurige analysemodus.

2. Selecteer  om de interface in twee viewers te splitsen, zoals weergegeven in Figuur 6.

FIGUUR 6. Bekijken in vergelijkingsmodus

3. Wijzig de serie in Viewer 1 met behulp van het keuzemenu serieselectie of de pijlen naar rechts/links.
• Deze bovenste viewer geeft altijd het huidige onderzoek weer die eerder is gestart. 

4. Gebruik in Viewer 2 het keuzemenu om een andere serie te kiezen, binnen hetzelfde onderzoek, om te vergelijken 
met de serie in Viewer 1. 

• Wanneer in een viewer een kijkvenster is geselecteerd en het plakje parallel is, zoals een korte-asserie, wordt het 
overeenkomstige plakje, op basis van de locatie van het plakje, gemarkeerd.

Viewer 1

Viewer 2
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FIGUUR 7. Seriekeuzemenu, viewer 2

5. Gebruik de onderzoekselectieknop om een ander onderzoek in Viewer 2 te vergelijken met het huidige onderzoek dat 
wordt weergegeven in Viewer 1.

FIGUUR 8. Onderzoekselectieknop, Viewer 2

6. Bevestig selectie van het juiste onderzoek door de onderzoekaanduidingsinformatie voor beide viewers te controleren.

FIGUUR 9. Onderzoekaanduidingsinformatie

7. Door met een rechtermuisknop op een van beide viewers te klikken, worden de beeldmanipulatietools geopend.
• De bereikselectie is op beide viewers van toepassing.

OPMERKING: Het lokaliseren uitvoeren van een afbeelding vanaf het tabblad Afbeeldingen is niet geldig als de 
afbeelding uit een ander onderzoek komt. 

OPMERKING: Als in beide viewers een cine-serie is geselecteerd en beide series hetzelfde aantal fasen hebben, klikt u 

op de  om de cine-weergaves te synchroniseren.
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Voorkeuren definiëren

Als in het Toolsmenu Preferences (Voorkeuren) vanuit de suiteHEART® Software Interface wordt geselecteerd, worden 
drie opties getoond: 

• Wijzigen
• Importeren
• Exporteren

BELANGRIJK: Aanbevolen wordt om de gebruikersvoorkeuren in te stellen alvorens het eerste geval voor rapportage te 
analyseren. Om wijzigingen in voorkeuren effect te laten hebben, sluit u het huidige onderzoek en dan 
sluit u en herstart u suiteDXT. 

Voorkeuren instellen
Voorkeuren kunnen worden aangepast voor de volgende functies op het tabblad Globaal.

• Rapport
• Bevoegden om rapporten goed te keuren 
• Algemeen
• Stroom
• Inactieftimer
• Functie
• Virtual Fellow®
• Myocardevaluatie
• Seriefilter
• Exporteren (afbeelding/video) 

Door de gebruiker gedefinieerde resultaatparameterbereiken kunnen worden gemaakt op het tabblad Sjabloon. Macro’s 
voor gestructureerde rapportage kunnen worden gemaakt onder het tabblad Macro.

Tabblad globaal

Als u Reset selecteert in de linkerbovenhoek van het tabblad, worden alle gebruikerskeuzes gewist.
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Rapport 

Configureert de headerinformatie die in alle rapporten verschijnt.

FIGUUR 1. Rapportvoorkeuren

Selecties voor Rapportvoorkeuren

1. Selecteer vanuit de Image View menubalk Tools > Preferences > Edit. 

2. Selecteer het tabblad Globaal.

3. Zet de cursor in het gewenste veld van het paneel Rapport en voer informatie in. 
De titels, kopteksten en het logo verschijnen op het rapport met het gespecificeerde papierformaat. Om deze informatie uit 
het rapport weg te laten, deselecteert u het selectievakje „De onderstaande veldwaarden gebruiken in rapport”. Vervolgens 
geldt dit voor alle patiëntrapporten die worden afgedrukt. 

Als u „ondersteuning voor even en oneven rij” aanvinkt, worden de resultaatrijen op de interface en in het rapport 
gemarkeerd.

4. Geef om een sitelogo in het rapport op te nemen het bestand een .jpeg, .png, of .gif-formaat en sla het op op de harde 
schijf of een cd-rom. Selecteer Browse (Browsen) in het Logovakje en zoek het bestand in het systeembrowservenster. 
Selecteer het geschikte logobestand en selecteer Open (Openen). 

Het logo zou nu moeten verschijnen in het rapportvoorkeurenpaneel.

5. Klik met de rechtermuisknop op de Naam examenbestand om de bestandsnaam van het exportbestand te 
configureren (alleen voor goedgekeurde examens).
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6. Selecteer Opslaan en afsluiten. 
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren. 

Bevoegden om rapporten goed te keuren

De applicatie heeft een functie om rapporten goed te keuren, waarmee het uiteindelijke rapport wordt afgesloten. 
Eenmaal goedgekeurd, kan het rapport niet meer worden aangepast. De referenties van de bevoegden worden toegevoegd, 
aangepast en verwijderd zoals beschreven.

FIGUUR 2. Geautoriseerde rapportbekrachtigers

Beheren bevoegden rapporten goedkeuren

1. Selecteer vanuit de Image View menubalk Tools > Preferences > Edit. 

2. Selecteer het tabblad Globaal en zet de cursor in het paneel Bevoegden rapporten goedkeuren. 

3. Selecteer de tab Toevoegen om een gebruikersnaam toe te voegen aan een lijst van bevoegden.
• Voer de gebruikersnaam in.
• Voer het wachtwoord tweemaal in.
• Selecteer Add (Toevoegen). 

4. Selecteer de tab Bewerken om het wachtwoord te veranderen van een gebruiker op de lijst van geautoriseerde 
bekrachtigers.

• Selecteer de te wijzigen gebruiker.
• Voer het oude wachtwoord in.
• Voer het nieuwe wachtwoord tweemaal in.
• Selecteer Toepassen.

5. Selecteer de tab Verwijderen om een gebruiker te verwijderen uit de lijst van geautoriseerde bekrachtigers.
• Selecteer de te verwijderen gebruiker(s).
• Selecteer Delete (Verwijderen).

6. Selecteer Opslaan en afsluiten.
• Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.
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Algemeen

FIGUUR 3. Algemene voorkeuren

Selecties voor Algemene voorkeuren

1. Selecteer vanuit de menubalk Image Viewer Tools > Voorkeuren > Wijzigen.

2. Selecteer het tabblad Globaal.

3. Schakel het selectievakje Annotatie dikke lijn in om annotaties als dikke lijnen weer te geven.

4. Vink Actieve ROI bewerken voor geen overlap aan om overlapping uit te schakelen.
Wanneer „Actieve ROI bewerken voor geen overlap” is aangevinkt, zijn de ROI's die momenteel niet zijn geselecteerd 
dominant en wanneer dit is uitgeschakeld, is de ROI die wordt bewerkt dominant.

5. Vink Automatisch omzetten vrije hand naar punt-spline aan om automatisch een ROI uit de vrije hand om te zetten 
in punt-spline.

6. Vink Tooltips weergeven aan om interface tooltips te tonen.

7. Vink het vakje Patiënt anoniem maken aan om de patiëntnaam en -ID in het rapport te verbergen.
Alle namen van patiënten zullen worden aangeduid met „anoniem” en het ID is blanco. Deze veranderingen gelden voor het 
rapport en de beeldviewer.

8. Controleer Tabletstand om de toepassing op een tabletapparaat te gebruiken.

9. Vink Automatisch export goedgekeurd onderzoek aan om het rapport als DICOM-bestand te exporteren bij goedkeuring.

10. Vink Multi-plakbeeld naar rapport aan om een rechtermuisknopoptie toe te voegen om een groep beelden met 
meerdere frames met korte as toe te voegen.

11. Vink Plaklocatie altijd tonen aan om de annotatie van de plaklocatie weer te geven in het kijkvenster.

12. Stel Scope selectie in voor beeldmanipulatie in het vervolgkeuzemenu voor bestanden.

13. Stel het Meetsysteem imperiaal of metrisch in het vervolgkeuzemenu voor bestanden in.

14. Stel de Tijdsindeling in het vervolgkeuzemenu in.

15. Stel de Monitorselectie in het vervolgkeuzemenu in als een dubbele monitor wordt gebruikt.

16. Stel de Stand initiële annotatie wijzigen in het vervolgkeuzemenu in. Selecties omvatten Geen, Nudgefunctie of Trekfunctie.
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Stroom

FIGUUR 4. Stroomvoorkeuren

Selecties voor stroomvoorkeuren

1. Selecteer vanuit de menubalk Image Viewer Tools > Voorkeuren > Wijzigen.

2. Selecteer het tabblad Globaal.

3. Vink het selectievakje Automatische basislijncorrectie aan om automatisch de automatische fasefoutcorrectie uit te 
voeren voor 2D- en 4D-fasecontrast.

4. Vink Stand regurgitant: Auto om automatisch de netto negatieve stroom te berekenen (onder x-as). 

5. Het selectievakje Door gebruiker bewerkte ROI vervangen vervangt door gebruiker bewerkte ROI’s als propagatie 
wordt uitgevoerd.

6. Vink Tools voor bewerken weergeven aan om bewerkingstools direct op het kijkvenster van het beeld weer te geven.

7. Vink Geavanceerde opties tonen aan om toegang te krijgen tot positieve, negatieve, piektotaal en piek absolute 
resultaten.

8. Definieer categorielabels voor Stroom 1 of Stroom 2 door een nieuw label in te voeren. Deze labels verschijnen als 
tooltips op de stroominterface.

9. Selecteer de juiste Stroomeenheid van ml/slag of l/min uit het vervolgkeuzemenu.

10. Selecteer de Standaardmethode voor persistentie van de berekeningsmethode voor het Integrated Flow paneel

11. Selecteer Opslaan en afsluiten.
 Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.

Inactieftimer 

Het paneel inactieftimer stelt het tijdsinterval in minuten in voor de toepassing om af te sluiten na een ingestelde periode 
van inactiviteit. 
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FIGUUR 5. Instellingen inactieftimer

Selecties voor inactieftimer

1. Selecteer vanuit de Image View menubalk Tools > Vooerkeuren > Edit. 

2. Selecteer het tabblad Globaal en zet de cursor in het paneel inactieftimer. 

3. Vink het selectievakje inactieftimer in om de inactieftimerfunctie in te schakelen.

4. Sleep de intervalmarker voor Inactieve timer naar de gewenste tijd in minuten. 

5. Selecteer Opslaan en afsluiten om uw selecties op te slaan. 
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren. 

Functie

FIGUUR 6. Functievoorkeuren

1. Selecteer vanuit de menubalk Image Viewer Tools > Voorkeuren > Wijzigen.
2. Selecteer het tabblad Globaal.
3. Voor automatische plaatsing van de basale lijn voor functieanalyse vinkt u Automatische MV of TV Annulus Line 

Insertion aan.
4. Vink Flip x-as (plak) en y-as (fase) voor matrixstand aan om de as te verwisselen.
5. Selecteer Inschakelen LV of RV Shaduwcurve om beide curven weer te geven.
6. Schakel Persist-analysetools voor functie auto in voor het uitvoeren van bewerkingen bij het gebruik van automatische 

segmentatie.
7. Vink Bewegingscorrectie tussen plakken aan om toegang te krijgen tot deze functie in functieanalyse, raadpleeg 

Bewegingscorrectie tussen series op pagina 68. 
8. Selecteer Nieuwste, Oudste en Vragen voor de Siemens auto stand combineren in het vervolgkeuzemenu voor 

bestanden.

9. Selecteer Opslaan en afsluiten om uw selecties op te slaan. 
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren. 
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Virtual Fellow®

FIGUUR 7. Voorkeuren Virtual Fellow®

1. Selecteer vanuit de menubalk Image Viewer Tools > Voorkeuren > Wijzigen.

2. Selecteer het tabblad Globaal.

3. Vink Onderzoek openen met Virtual Fellow® aan om het onderzoek rechtstreeks te openen met de Virtual Fellow®-
applicatie. 

4. Selecteer Opslaan en afsluiten.
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.

Myocardevaluatie

FIGUUR 8. Voorkeuren myocardevaluatie

1. Selecteer vanuit de menubalk Image Viewer Tools > Voorkeuren > Wijzigen.

2. Selecteer het tabblad Globaal.

3. Raadpleeg Definieer resultaatmetingslabels op pagina 112 om meetlabels te definiëren.

4. Selecteer Nieuwste, Oudste en Vragen voor de Siemens auto stand combineren in het vervolgkeuzemenu voor 
bestanden.

OPMERKING:  Als het serielabel „null” is, wordt de serie genegeerd.

5. Selecteer Opslaan en afsluiten.
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.
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Seriefilter

Op basis van typen analysestanden kan een seriefilter worden toegepast om de selectie van de juiste serie voor analyse te 
versnellen. De filtervoorkeuren kunnen ook tijdens de analyse worden geselecteerd door te klikken op de filterknop in 
het hoofdvenster, boven de miniatuurweergave. 

FIGUUR 9. Filtervoorkeuren

Instellen filtervoorkeuren

1. Selecteer vanuit de menubalk Image Viewer Tools > Voorkeuren > Wijzigen.

2. Selecteer het tabblad Globaal.

3. Klik op de juiste aan/uit-selectie voor elk analysetype.

4. Selecteer Opslaan en afsluiten. 
• Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren. 

OPMERKING: Als een seriefilter is toegepast en de vereiste serie niet aanwezig is, verschijnt een bericht: „Er zijn geen 
series gekoppeld aan het geselecteerde analysetype.” Als u op OK klikt, wordt het filter uitgeschakeld en 
worden alle reeksen in het onderzoek weergegeven.
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Exporteren (afbeelding/video)

Met het Exportpaneel kunt u de beeldindelingen voor het exporteren van afbeeldingen en videogegevens selecteren. 
Met de exportfunctie kunt u niet-gecomprimeerde .avi-films, gecomprimeerde QuickTime-films, .GIF-, .JPEG-, TIFF- en 
.PNG-bestanden van de afbeeldingsgegevens maken.

FIGUUR 10. Voorkeuren afbeelding/video exporteren

Selecties exporteren 

1. Selecteer vanuit de Image View menubalk Tools > Preferences > Edit. 
2. Selecteer het tabblad Globaal en zet de cursor in het paneel Exporteren. 
3. Selecteer de juiste afbeeldingsgegevenssoorten. 
4. Selecteer Opslaan en afsluiten om de selecties op te slaan. 

Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren. 

Sjabloonvoorkeuren

De applicatie biedt een tool om sjablonen te creëren op basis van door de gebruiker opgegeven normale bereiken 
gespecificeerd naar leeftijd en geslacht. De berekening en rapportage van Z-scores wordt ondersteund op basis van een 
door de gebruiker gedefinieerd model. Raadpleeg de aanbevolen referenties.

FIGUUR 11. Sjabloontabblad

Overwegingen

Voordat u de analyse start, moet de door de gebruiker gedefinieerde sjabloon worden geselecteerd in de hoofdinterface. 
Klik rechtsboven op Standaard en selecteer de sjabloon die moet worden gebruikt. Als u de sjabloon wijzigt na het 
uitvoeren van de analyse, wordt het normale bereik en/of de Z-score gedefinieerd in de sjabloon.
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FIGUUR 12. Sjabloon veranderen

OPMERKING: Geïmporteerde onderzoeken met eerdere suite HEART-analyse kunnen de naam weergeven van de 
sjabloon die voor dat onderzoek is gebruikt. Die sjabloon is mogelijk niet beschikbaar voor andere 
onderzoeken.

Het wordt aanbevolen dat als twee systemen worden gebruikt voor analyse, het sjabloonvoorkeurenbestand op het 
eerste systeem wordt gemaakt en vervolgens in het tweede systeem wordt geïmporteerd. Sjabloonvoorkeurbestanden 
die zijn geïmporteerd vanuit een ander systeem, overschrijven sjabloonvoorkeuren als ze al op dat systeem zijn gemaakt.

Een sjabloon maken

WAARSCHUWING: De geldigheid van de waarden ingevoerd voor normale bereiken en Z-scoreparameters is 
uitsluitend de verantwoordelijkheid van de gebruiker. Bevestig alle invoer voorafgaand aan 
analyse. Onjuiste waarden kunnen leiden tot een verkeerde diagnose.

Alle nieuwe sjablonen worden aangemaakt door het dupliceren van het standaardsjabloon. De standaardsjabloon kan 
niet worden bewerkt. 

1. Selecteer Tools > Voorkeuren > Edit. 

2. Selecteer het tabblad Sjabloon.

3. Klik op Nieuwe aanmaken of om een sjabloon te dupliceren, klikt u op Dupliceren.
Leeftijd is de standaardinstelling.

FIGUUR 13. Sjabloonselecties aanmaken

4. Type een nieuwe naam voor de sjabloon. 
Wanneer een nieuwe naam wordt ingevoerd, wordt het vervolgmenu De huidige sjabloon is bijgewerkt.
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FIGUUR 14. Tabblad voorbeeldsjabloon – Korteasfunctie wordt getoond

1. Huidige sjabloon, 2. Balk leeftijdscategorieën, 3. Resultaatparameters per analysetype, 4. Mannelijke Z-score BSA-limieten, 
5. Mannelijke boven- en ondergrenzen, 6. Mannelijke Z-scoreparameters, 7. Vrouwelijke Z-score BSA-limieten, 
8. Vrouwelijke boven- en ondergrenzen, 9. Vrouwelijke Z-scoreparameters

5. Selecteer het gewenste applicatieanalysetype waarvoor u een sjabloon wilt maken.

6. Als leeftijdscategorieën moeten worden gebruikt, klikt u met de rechtermuisknop op de balk Leeftijdscategorieën om 
een leeftijdsverdeler te maken.

De scheidingsbalken van de leeftijdscategorieën kunnen worden gesleept en aangepast voor het gewenste leeftijdsbereik.
Er kunnen meerdere scheidingsbalken voor leeftijdscategorieën worden aangemaakt.
Scheidingsbalken voor leeftijdscategorieën kunnen worden verwijderd door de cursor dicht bij de balk te plaatsen en 
Categorie verwijderen te selecteren uit het rechtermuisknopmenu.

7. Voer de normale bereikwaarden in voor de juiste analysestand en zowel de onder- als de bovengrenzen.

8. Maak waar nodig onderscheid tussen waarden voor mannen en vrouwen. Kopieer met de pijltjes Alles kopiëren om 
waarden tussen geslachten te kopiëren. Gebruik de schuifbalk om naar de volledige lijst met metingen voor dat 
analysetype te navigeren.

9. Als Z-scores berekend moeten worden, moeten waarden voor a, b en SD alsmede de BSA-limieten door de gebruiker 
worden ingevoerd.

De rapportageprioriteit wordt beschreven in de onderstaande tabel. Afhankelijk van de voorwaarde wordt het normale 
bereik of de berekende Z-score in de tabellen met meetresultaten getoond.

1

2

3

4
5 6

7
8 9
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WAARSCHUWING: De geldigheid van de waarden ingevoerd voor normale bereiken en Z-scoreparameters is 
uitsluitend de verantwoordelijkheid van de gebruiker. Bevestig alle invoer voorafgaand aan 
analyse. Onjuiste waarden kunnen leiden tot een verkeerde diagnose.

10. Selecteer Opslaan en afsluiten om alle invoeren op te slaan.
- Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.

OPMERKING: Om een sjabloon geldig te laten zijn, moeten parameterwaarden worden ingevoerd als numerieke 
getallen met zowel de bovenste als de onderste waarde ingevoerd. Als er inconsistenties in de waarden 
worden gevonden, verschijnt het volgende bericht: „Ongeldig normaal bereik geselecteerd. Corrigeer 
dit en sla het opnieuw op.” De parameter die moet worden gecorrigeerd, wordt rood gemarkeerd. Het 
opslaan van een blanco sjabloon is niet toegestaan en zorgt ervoor dat het volgende bericht „Kan 
sjabloon(en) niet opslaan” wordt weergegeven.

OPMERKING: Normale bereiken die zijn ingevoerd voor het tabblad Stroom zijn van toepassing op zowel de 2D- als 
4D-stroomanalyseresultaten.

Aanbevolen referenties

Buechel EV, Kaiser T, Jackson C, Schmitz A, Kellenberger CJ. Normale omvang van rechter- en linkerventrikel en 
myocardiale massa in kinderen gemeten door constante vrije precessie cardiovasculaire magnetische resonantie. J 
Cardiovasc Magn Reson. 2009 jun 21;11 (1):19. doi: 10.1186/1532-429X-11-19. PMID: 19545393; PMCID: PMC2718870.

Kawel-Boehm N, Maceira A, Valsangiacomo-Buechel ER, Vogel-Claussen J, Turkbey EB, Williams R, Plein S, Tee M, Eng J, 
Bluemke DA. Normale waarden voor cardiovasculaire magnetische resonantie bij volwassenen en kinderen. J Cardiovasc 
Magn Reson. 2015 apr 18;17 (1):29. doi: 10.1186/s12968-015-0111-7. PMID: 25928314; PMCID: PMC4403942.

Maceira AM, Prasad SK, Khan M, Pennell DJ. Normaliseerde systolische en diastolische functie van het linkerventrikel 
door middel van constante vrije cardiovasculaire magnetische resonantie. J Cardiovasc Magn Reson. 2006;8 (3):417-26. 
doi: 10.1080/10976640600572889. PMID: 16755827.

Maceira AM, Prasad SK, Khan M, Pennell DJ. Referentie van de systolische en diastolische functie van het rechterventrikel 
genormaliseerd tot leeftijd, geslacht en lichaamsoppervlak met een stabiele vrije precessie cardiovasculaire magnetische 
resonantie. Eur Heart J. 2006 dec;27 (23):2879-88. doi: 10.1093/eurheartj/ehl336. Epub 2006 nov 6. PMID: 17088316.

Gerapporteerd/berekend Voorwaarde

Z-score berekend Als er Z-scoreparameters zijn ingevoerd en de BSA binnen de 
limieten ligt

Normaal bereik gerapporteerd Als de Z-score en het normale bereik worden ingevoerd en de BSA 
buiten de limieten valt 

Normaal bereik gerapporteerd Alleen als een normaal bereik is ingevoerd

Zowel normaal bereik als Z-score niet berekend Als de Z-scoreparameters worden ingevoerd. Geen normaal bereik 
ingevoerd en BSA is buiten de limieten

Zowel normaal bereik als Z-score niet berekend Zowel Z-scoreparameters als een normaal bereik zijn niet ingevoerd 
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Een sjabloon verwijderen

1. Selecteer Tools > Voorkeuren > Edit.

2. Selecteer het tabblad Sjabloon.

3. Selecteer de sjabloon uit De Huidige sjabloon is-keuzemenu.

4. Klik op Verwijderen.

Macrotabblad

Aangepaste rapportagemacro’s kunnen worden gemaakt die automatisch kunnen worden gevuld met berekende 
waarden. Macro’s zijn onafhankelijk van sjablonen, omdat gecreëerde macro’s beschikbaar zijn voor alle gebruikers.

Macro’s kunnen worden gemaakt voor de volgende rapportagesecties:

• Geschiedenis
• Indruk
• Techniek

Een Indrukkenmacro toevoegen

OPMERKING: Het maken van een Geschiedenis- of techniekmacro volgt dezelfde stappen als van een 
Indrukkenmacro.

1. Selecteer Tools > Voorkeuren > Bewerken.
2. Selecteer het tabblad Macro.
3. Selecteer Indrukkenmacro toevoegen. 

In het paneel Indrukkenmacro verschijnt een tekstveld.

FIGUUR 15. Indrukkenmacrovenster

4. Plaats de cursor in het nieuwe tekstveld en bewerk de naam naar wens.

OPMERKING: De gemaakte macro’s kunnen opnieuw worden gerangschikt. Klik en sleep de gewenste macro naar een 
nieuwe positie in de lijst.

Voer macrotekst in

1. Zet de cursor in het tekstveld Macro-informatie en voer relevante tekst in.

2. Selecteer om een parameterresultaat in te voeren een van de analysetabs hieronder en selecteer de gewenste 
parametertoets, die automatisch in de macro-informatie zal worden ingevoerd. In dit voorbeeld werd de parameter 
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LV-uitstootfractie geselecteerd en aan het eind van de tekst ingevoerd.

FIGUUR 16. Macro-informatie

FIGUUR 17. Resultaatselecties macroparameter 

3. Selecteer Opslaan en afsluiten.
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.

Een macro uitvoeren

Als een voorwaarde voor macro-uitvoering, moeten analyseresultaten worden aangemaakt voordat macro’s die 
resultaatparameters omvatten, worden uitgevoerd. Techniek- en impressiemacro’s kunnen worden gemaakt om het 
genereren van rapporten te automatiseren.

Een macro verwijderen

1. Selecteer Tools > Voorkeuren > Bewerken.

2. Selecteer het tabblad Macro.

3. Selecteer de macro uit de lijst. 

In het getoonde voorbeeld, is de macro genaamd MACRO_3 geselecteerd om te worden verwijderd.

FIGUUR 18. Macroselectielijst

4. Selecteer Geselecteerde macro's verwijderen.
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Afdruktabblad

Berekende resultaten uit elke analysestand kunnen worden geconfigureerd voor opname en worden gerangschikt op het 
rapport onder het Afdruk-tabblad.

FIGUUR 19. Afdrukvoorkeuren 

1. Selecteer vanuit het beeldweergavemenu Tools > Voorkeuren > Afdrukken.

2. Selecteer het juiste analysetabblad en vink het gewenste resultaat aan dat in het rapport moet worden opgenomen.

3. De volgorde van de resultaten zoals die in het rapport worden vermeld, kan worden gewijzigd door rechtstreeks op 
een resultaat te klikken en naar een nieuwe positie in de lijst te slepen. 

4. Herhaal dit voor elk tabblad van de analysestand.

5. Selecteer Opslaan en afsluiten.
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.

OPMERKING: Als afdrukselecties rechtstreeks in de toepassingsinterface worden gemaakt, worden deze niet met de 
sjabloon opgeslagen.

OPMERKING: Als de volgorde van de resultaten rechtstreeks op de interface wordt gewijzigd, wordt de wijziging niet 
met de sjabloon opgeslagen.
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Virtual Fellow®-tabblad

FIGUUR 20. Voorkeuren Virtual Fellow®

1.  Selecteer Tools > Voorkeuren > Bewerken.

2.  Selecteer het Virtual Fellow®-tabblad.

3. Selecteer de apicale richting voor de lange-asweergaven

4. Selecteer de serie voor weergave van Fase of Omvang voor Myocardevaluatie.

5. Selecteer de MOCO of de NO MOCO-serie voor weergave voor myocardiale perfusie. 

6. Selecteer Opslaan en afsluiten.
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      45

Tabblad T1/T2 -mapping

FIGUUR 21. T1/T2-mappingvoorkeuren

1. Selecteer Tools > Voorkeuren > Bewerken.

2. Selecteer het T1/T2 Mapping-tabblad.

3. Selecteer MOLLI of Verzadigingsherstel voor het sequentietype voor T1-mapping.

4. Selecteer de standaard Kleurmap in het vervolgkeuzemenu en het kleurmapbereik voor T1- of T2-mapping.

5. Om de kleurmap automatisch weer te geven, selecteert u de standaard Overlay voor T1, ECV of T2. 

6. Om een geldige serie voor analyse te maken, selecteert u de juiste optie voor vendor type onder Auto samenstellen 
van serie voor analyse. 

7. Selecteer Opslaan en afsluiten.
Selecteer Annuleren om af te sluiten zonder wijzigingen op te slaan of te accepteren.
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Importvoorkeuren
1. Selecteer Tools > Voorkeuren > Importeren.

FIGUUR 22. Importvoorkeuren

2. Selecteer de knop Bladeren, selecteer de locatie van het voorkeursbestand en selecteer vervolgens de knop Openen.

3. Als u weergaveprotocollen wilt importeren, selecteert u het keuzerondje voor Alleen weergaveprotocollen.

4. Selecteer OK om de gedefinieerde exportprocedure uit te voeren.
 Selecteer Annuleren om af te sluiten zonder te importeren.

OPMERKING: Het importeren van voorkeuren uit eerdere versies (4.0.4 of lager) van suiteHEART® Software wordt niet 
ondersteund. Neem contact op met NeoSoft Support op service@neosoftmedical.com voor hulp bij het 
importeren van voorkeuren uit eerdere versies.

Exportvoorkeuren
1. Selecteer Tools > Voorkeuren > Exporteren.

FIGUUR 23. Exportvoorkeuren

2. Selecteer Bladeren, selecteer de map waarin u het voorkeursbestand wilt plaatsen en selecteer vervolgens Opslaan.

3. Selecteer OK.
 Selecteer Annuleren om af te sluiten zonder te exporteren.
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Virtual Fellow®

Virtual Fellow® is een gestandaardiseerde functie voor het bekijken van afbeeldingen voor cardiale MR-onderzoeken. De 
functie verbetert de visualisatiewerkstroom waardoor het voor clinici gemakkelijker wordt om cardiale MR-onderzoeken 
te beoordelen. De functie past automatisch beeldmanipulatietools toe zoals vensterniveau, zoomen, pannen en roteren. 
Huidige en eerdere cardiale MR-onderzoeken kunnen eenvoudig worden beoordeeld met de functie Virtual Fellow®.

OPMERKING: Om de functie Virtual Fellow® bij voorbewerken in te schakelen, raadpleeg de suiteDXT-
gebruikshandleiding NS-03-040-0014.

OPMERKING: De patiënt-ID moet overeenkomen om zowel het huidige als het eerdere onderzoek te kunnen bekijken 
in Virtual Fellow®. 

OPMERKING: Het bewerken van analyseresultaten kan niet worden uitgevoerd in Virtual Fellow®, selecteer de juiste 
analysemodus om bewerkingen uit te voeren. 

WAARSCHUWING: De gebruiker is verantwoordelijk voor het controleren van de juiste beeldselectie voor de 
weergaveprotocollen die door de Virtual Fellow® zijn gegenereerd. Afbeeldingen die onjuist 
zijn aangewezen voor huidige/eerdere weergaveprotocollen kunnen handmatig worden 
geselecteerd. De gebruiker moet goed worden getraind in cardiale 
beeldvormingstechnieken om ervoor te zorgen dat de juiste afbeeldingen worden 
beoordeeld. Gebruik de Viewer-modus in Afbeeldingbeheertools op pagina 21 om alle 
afbeeldingen te bekijken die voor het onderzoek zijn verkregen.

WAARSCHUWING: Controleer, voorafgaand aan de beoordeling of vergelijking van onderzoeken, visueel alle 
informatie ter aanduiding van de te onderzoeken patiënt bovenaan de interface. Nr. 1 geeft 
het huidige onderzoek aan, nr. 2 geeft het eerdere onderzoek aan.

WAARSCHUWING: Beeldmanipulatie zoals WW/WL, pannen, zoomen, roteren en omdraaien uitgevoerd door 
Virtual Fellow® kan de verschijningsvorm van verschillende ziektebeelden en het 
onderscheiden van andere anatomische structuren beïnvloeden. Beoordeel elk 
weergaveprotocol en voer de relevante aanpassingen uit.
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Voorbewerking met Virtual Fellow®

Serieaanduiding

Automatische segmentatie
(van aangegeven series)

Automatische detectie van klepannulus
(indien ingeschakeld)

Virtual Fellow® – Weergaveoptimalisatie
(indien ingeschakeld)

Compleet
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Virtual Fellow®-interface

Virtual Fellow®-selecties

Selectie Beschrijving

Virtual Fellow®

Toon functieresultaten

Toon stroomresultaten

Toon resultaten van myocardiale evaluatie

& Resultaatweergave

Hoofd-viewer

Beeldweergavebesturing

Bekijken
Protocollen

Lange-askruisverwijzing



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      50

Link Toggle wordt gebruikt om WW/WL, pannen, 
roteren en omdraaien uit te voeren op zowel de 
huidige als de vorige serie.

Unlink Toggle wordt gebruikt om WW/WL uit te 
voeren, pannen, roteren en omdraaien op een 
enkele serie.
Opmerking: Zoom wordt altijd toegepast op 
zowel huidige als eerdere series.

Fase wordt gebruikt om fasegevoelige late 
aankleuring te bekijken.

Sterkte wordt gebruikt om de sterkte van late 
aankleuring te bekijken.

MOCO wordt gebruikt om bewegingscorrectie 
in myocadialeperfusieseries te bekijken.

NO MOCO wordt gebruikt om myocardiale 
perfusie series te bekijken zonder 
bewegingscorrectie.

#1 is de indicator voor de serie die wordt 
weergegeven voor het huidige onderzoek. Klik 
met de linkermuisknop rechtstreeks op #1 om 
de serie te wijzigen. 

#2 is de indicator voor de serie die wordt 
weergegeven voor de vorige onderzoeksserie. 
Klik met de linkermuisknop rechtstreeks op #2 
om de serie te wijzigen.

Cine-bedieningselementen worden gebruikt 
om af te spelen, te pauzeren, de frames per 
seconde te selecteren en de begin- en 
eindframes van de film te definiëren.

Referentietool om beelden met dezelfde 
locatie automatisch te identificeren en weer 
te geven. Raadpleeg Zoekfunctie* op 
pagina 22 voor informatie over het gebruik 
van deze functie.

Meetinstrumenten.

Selectie Beschrijving
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Weergaveprotocollen

Generieke meetbewerkingen ongedaan 
maken.

Kijkvensterlayout-opties*: 1x1, 1x2, 4x4 en 5x4.
*Afhankelijk van geselecteerd protocol.

Toepassingsgebied heeft dezelfde functie als 
beschreven in Beeldmanipulatietools op 
pagina 11.

Toetsenbordpijltje links Wordt gebruikt om de plaklocatie vooruit 
te zetten in een huidig/eerder 
weergaveprotocol.

Toetsenbordpijltje rechts Wordt gebruikt om de plaklocatie achteruit 
te zetten in een huidig/eerder 
weergaveprotocol.

Serietype

Korte-as cine-functieserie.

Huidige korte-as cine-functie met vorige.

Myocardevaluatie.

Huidige myocardevaluatie met vorige.

Korte-as cine-functie met myocardevaluatie.

Series van myocardialeperfusiestress.

Selectie Beschrijving
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Sneltoetsen

Huidige series van myocardialeperfusiestress met vorige.

Huidige myocardialeperfusiestress met myocardevaluatie.

Myocardialeperfusiestress/rustseries.

T1-axiale serie.

SSFP met T1-axiale serie.

Functie Toetsenbordactie

Blader vooruit op lange-asweergaven als de gele hoekindicator 
aanwezig is.

Z

Blader achteruit op lange-asweergaven als de gele hoekindicator 
aanwezig is.

A

Serietype
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Gebruikersselectie van een serie voor weergaveprotocollen

Weergaveprotocollen zijn geconfigureerd om afbeeldingen van het huidige onderzoek of van het huidige en vorige 
onderzoek te bekijken. Als de weergegeven afbeeldingen niet de verwachte te beoordelen afbeeldingen zijn, selecteert u 
de juiste serie opnieuw door met de linkermuisknop te klikken direct boven de getalnotatie (nr. 1 voor huidig onderzoek 
of nr. 2 voor eerder onderzoek) op de Virtual Fellow®-interface zoals weergegeven in Figuur 1. De serielijst voor het 
huidige onderzoek (nr. 1) wordt weergegeven, selecteer de juiste serie. 

FIGUUR 1. Virtual Fellow-interface
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Gebruikersselectie van een serie voor kijkvensters van lange-
askruisverwijzing

Als de weergegeven afbeeldingen niet de verwachte weergaven zijn, kunt u de juiste serie selecteren door direct op een 
lange-askijkvenster te klikken en vervolgens de afbeelding in het vervolgkeuzemenu voor bestanden te selecteren, zoals 
weergegeven in onderstaande Figuur.

OPMERKING: Als de toetsenbordselecties van Z of A worden gebruikt, is de door de gebruiker geselecteerde afbeelding 
niet langer aanwezig in het kijkvenster.

OPMERKING: Om de gewenste apicale richting in het Image Viewer-menu in te stellen, selecteer Tools > Voorkeuren > 
Wijzigen en selecteer het Virtual Fellow®-tabblad.
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Contouren wijzigen

Contouren wijzigen, zoals beschreven in dit onderdeel, is beschikbaar in alle analysemodi. Deze functie is beschikbaar in 
zowel het bewerkingsvenster als in de Review-modus.

Conventionele bewerking
1. Klik in het bewerkingsvenster met de linkermuisknop op de contour. Als de contour wordt geselecteerd, wordt hij 

paars.

2. Klik met de linkermuisknop en sleep in het midden van de contour om deze te verplaatsen, zoals weergegeven in 
Figuur 1.

• Als de geselecteerde contour is gemaakt met behulp van de punt-splinemethode, worden de punten tijdens het 
wijzigingsproces getoond. Klik met de linkermuisknop en sleep een van de punten om de omvang en vorm van de contour 
te wijzigen zoals getoond in Figuur 1.

• Als de geselecteerde contour is gemaakt met behulp van de traceerfunctie uit de vrije hand, klikt u met de linkermuisknop 
om de contour bij te werken uit de vrije hand.

FIGUUR 1. Conventionele contourbewerking
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Nudge-functie
1. Klik met de linkermuisknop op de contour om de nudge-functie te activeren. Klik vervolgens met de rechtermuisknop 

en selecteer de nudge-functie in het pop-upmenu, zoals weergegeven in Figuur 2.
• Wanneer de nudge-functie wordt toegepast, wordt de geselecteerde puntwervel-ROI automatisch een ROI uit de vrije hand.

FIGUUR 2. Activatie van nudge-functie

2. De cursor verschijnt als een vierkant. Plaats de cursor weg van de ROI en houd de linkermuisknop ingedrukt. 
De nudge-functie verschijnt, zoals getoond in Figuur 3.

OPMERKING: De grootte van de nudge-cirkel is standaard de grootte die een gelijke afstand is van het muispunt tot de 
geselecteerde ROI. Verplaats de cursor om de grootte te wijzigen.

FIGUUR 3. Nudge-functie
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3. Als u de nudge-functie wilt deactiveren, klikt u met de linkermuisknop op de contour en klikt u vervolgens met de 
rechtermuisknop en selecteert u de nudge-functie in het pop-upmenu, zoals weergegeven in Figuur 4.

FIGUUR 4. Nudge-functie deactivering

OPMERKING: De standaard aan/uit-status van de nudge-functie kan worden ingesteld in Voorkeuren.

Contourtrekfunctie
1. Klik met de linkermuisknop op de contour om de trekfunctie te activeren. Klik vervolgens met de rechtermuisknop 

en selecteer de trekfunctie in het pop-upmenu, zoals weergegeven in Figuur 5. Het maakt het mogelijk om een 
contoursegment aan te passen door delen van de contour te verslepen om kleine aanpassingen te maken.

FIGUUR 5. Activatie van trekfunctie



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      58

2. Klik met de linkermuisknop op het segment van de te bewerken contour. De lengte van het zwart gestippelde segment 
kan worden geregeld door het middelste muiswieltje. De positie van de muiscursor op de zwarte stippellijn regelt de 
wijziging van de bewerking voor dat segment van de contour.

FIGUUR 6. Trekfunctie

3. Als u de trekfunctie wilt deactiveren, klikt u met de linkermuisknop op de contour, en vervolgens met de 
rechtermuisknop en selecteer de nudge-functie in het pop-upmenu, zoals weergegeven in Figuur 7.

FIGUUR 7. Deactivering van trekfunctie
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Een contour verwijderen
1. Klik met de linkermuisknop op de contour om deze te selecteren en druk op de delete-toets op het toetsenbord.

Of

2. Klik met de linkermuisknop op de contour om deze te selecteren, klik dan met de rechtermuisknop en kies  om 

een enkele contour te verwijderen of  om contouren uit alle fasen of alle tijdpunten te verwijderen, zoals 
weergegeven in Figuur 8.

FIGUUR 8. Contour verwijderen
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Functieanalyse
De gebruiker is verantwoordelijk voor de juiste en volledige plaatsing (en correcte toewijzing) van alle interessegebieden 
(ROI's), inclusief de gebieden die zijn gegenereerd of aangepast door de automatische segmentatiealgoritmen. De 
kwantitatieve waarden die door de software worden gegenereerd, zijn afhankelijk van de juiste en volledige plaatsing 
(en correcte toewijzing) van deze interessegebieden.

De functie voorverwerken van het onderzoek maakt de voorverwerking van functieanalyse mogelijk. Raadpleeg de 
gebruiksaanwijzing van suiteDXT NS-03-040-0014.

Deze paragraaf beschrijft de stappen die benodigd zijn voor een hartfunctieanalyse. De voorbeelden geven een overzicht 
van de in de applicatie toegepaste stappen om een hartfunctieanalyse uit te voeren. De procedures beschrijven hoe 
kwantitatieve analyse moet worden uitgevoerd.

BELANGRIJK: Aanbevolen wordt om de hartanalyse te laten uitvoeren door gekwalificeerd personeel, als de 
analyseresultaten moeten worden gebruikt om een diagnose te stellen.

WAARSCHUWING: Na het voorverwerken is de gebruiker verantwoordelijk voor het beoordelen van de 
nauwkeurigheid van de gehele analyse en het aanbrengen van eventuele noodzakelijke 
correcties. Een uitgebreide beoordeling moet inhouden:

- ROI-plaatsing/identificatie
- ED/ES-toewijzingen
- Plaatsing van MV-/TV-annulus
- RV-inbrenglocatie

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
klinische interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve 
metingen is aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde 
diagnoses. Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd 
personeel.

WAARSCHUWING: Een onjuist scanvlak kan leiden tot verkeerde analyseresultaten. Zie Bijlage B.

OPMERKING: Bij retrospectieve 2D-series gemaakt op basis van 4D Flow is mogelijk handmatige segmentatie vereist.
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Er zijn drie categorieën voor analyse:

 – omvat volumeanalyse voor de linkerventrikel (LV) en rechterventrikel (RV)

 – omvat volumeanalyse voor het linkeratrium (LA) en rechteratrium (RA).

 – omvat vooraf gedefinieerde lineaire metingen en door de gebruiker gedefinieerde metingen die kunnen 
worden toegevoegd.

 Ventrikels
Selecteer de analysewijze:

 Klik op  om contouren te wissen.

OPMERKING: De matrixmodus kan worden gebruikt voor het wissen van contouren.

Indexmetingen berekenen
1. Selecteer het tabblad Geschiedenis.

2. Voer lengte en gewicht van de patiënt in.

De eind-diastolische volume-index, eind-systolische volume-index, eind-diastolische massa-index, eind-systolische 
massa-index, massa-indexfase, cardiale outputindex en beroerte volume-indexmetingen worden berekend op de 
meettabel.

OPMERKING: De BSA-berekeningsmethode kan worden geselecteerd op het tabblad Geschiedenis in de 
rapportweergave.

Korte as Lange as
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Automatische LV- en RV-segmentatie

De automatische segmentatiefunctie berekent standaardparameters van de hartfunctie zonder anatomische invoer. 
Nadat segmentatieresultaten zijn gegenereerd, kunnen soorten ROI worden geselecteerd of gedeselecteerd om te 
bekijken. Segmentatiebewerking kan ook worden uitgevoerd op basis van gebruikersinvoer. 

OPMERKING: Als de knoppen LV en RV in Functie Korte as beide zijn uitgeschakeld of als de knop voor kamerkeuze in 
Lange as is uitgeschakeld, wordt de knop Start Automatisch Propageren uitgeschakeld. 

Voer de volgende handelingen uit om LV- & RV- segmentatie te starten: 

1. Selecteer de korte-asserie en wijzig het venster/niveau.

2. Klik op .

3. Klik op  voor automatische segmentatie.

4. Maak de relevante selecties op de segmentatiewerkbalk, zoals weergegeven in Figuur 1.

5. Selecteer  om automatische segmentatie te starten.

FIGUUR 1. Segmentatiewerkbalk

Tabel 1:  Automatische segmentatie contourtypes

Gladde modus – 
inclusief de 
papillaire 
spieren in het 
ventriculaire 
volume. 

Ruwe modus – 
exclusief de 
papillaire 
spieren van het 
ventriculaire 
volume. 

Endocardiale 
en epicardiale 
contouren 
tonen. 

Endocardiale 
contouren 
tonen.

Toon 
contouren.

Ruwe LV, 
gladde RV.

Gladde LV, 
ruwe RV
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*De propagatiefunctionaliteit zal worden gewisseld wanneer de voorkeur wordt aangevinkt voor x-as (plakje) en y-as 
(fase) omdraaien voor Matrixmodus.

Voer automatische segmentatie uit voor alle plakjes en alle fasen

Deze optie is vereist voor het genereren van resultaten van regionale analyse, dyssynchronie en klepvlakanalyse. 

1. Selecteer de korte-asserie en wijzig het venster/niveau.

2. Klik op .

3. Klik op  voor automatische segmentatie.

4. Selecteer in de segmentatiebalk een gladde  of ruwe modus .

5. Selecteer  om myocardiale massa-resultaten te genereren.

6. Selecteer  voor alle fasen en alle plakjes.

7. Selecteer  of  of beide.

OPMERKING: Selecteer voor een optimale RV-segmentatie zowel de epicardiale als de endocardiale sporen.

8. Selecteer  om automatische segmentatie te starten.

OPMERKING: De knop Start Automatisch Propageren wordt uitgeschakeld als de LV- en RV-selectie beide zijn 
uitgeschakeld.

Tabel 2:  Automatische segmentatie propageertypes*

Verspreid alle plakjes 
gedurende alle fasen of 
toon alle plakjes 
gedurende alle fasen

Propageer alle plakken; 
enkele fase

Propageer alle fasen; 
enkele plak

Toon alleen contouren 
voor ED/ES-fasen tijdens 
propagatie

Tabel 3:  Ventriculaire selectie

Linker ventrikel – Genereer segmentatie of weergave Rechter ventrikel – Genereer segmentatie of weergave
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Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.
De fasetoewijzingen voor ED en ES zijn vergrendeld. Om ED of ES opnieuw toe te wijzen, klikt u op de ED- of ES-knop en 
selecteert u het fasenummer direct in de matrix. Vergrendelde fasen worden aangegeven met een lichtere kleur voor de 
driehoek.

3. Controleer de plaatsing van het RV-insertiepunt op elk plakje. Corrigeer het RV-insertiepunt voor de basale plakjes.

4. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

OPMERKING: Contourbewerking wordt ondersteund voor gladde modus. Voer een contourbewerking uit en selecteer 
automatische segmentatie starten.

Voer automatische segmentatie uit voor alle plakjes in één fase

1. Selecteer de korte-asserie en wijzig het venster/niveau.

2. Klik op .

3. Klik op .

4. Selecteer in de segmentatiebalk een gladde  of ruwe modus .

5. Selecteer  om myocardiale massa-resultaten te genereren.

6. Bekijk de korte-asafbeeldingen en selecteer de eind-diastolische fase.

7. Selecteer  of  of beide.

8. Selecteer  voor alle plakjes in één fase.

9. Selecteer  om automatische segmentatie te starten.

10. Bekijk de korte-asafbeeldingen en selecteer de eind-systolische fase.

11. Selecteer  om automatische segmentatie te starten. 

OPMERKING: De knop Start Automatisch Propageren wordt uitgeschakeld als de LV- en RV-selectie beide zijn 
uitgeschakeld.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

3. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

4. Bekijk alle resultaten op de meettabel.
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Procedure voor handmatige LV- en RV-functieanalyse
OPMERKING: Het wordt aanbevolen om de eind-diastolische en eind-systolische fasen te gebruiken. Het verwerken 

moet in de einddiastolische fase beginnen. De analyse wordt uitgevoerd van de basis tot aan de apex.

1. Selecteer .

2. Selecteer de geschikte korte-asserie uit de beeldweergave. 

3. Klik op .

4. Klik op de knop  voor Volumemetingen.

5. Wijs de einddiastolische fase aan.

Het endocard definiëren

1. Selecteer  voor LV of  voor RV. 

2. Breng de endocardiale contour aan.

3. Ga naar het volgende plakje met  of gebruik <- en -> of selecteer de miniatuur.

4. Herhaal stap 2 en 3 tot de hele linker- en/of rechterventrikel is gesegmenteerd.

De Endocardcontourtool blijft geselecteerd om het segmenteren van meerdere plakjes te bespoedigen.

5. Wijs de eindsystolische fase aan.

6. Herhaal stap 2 en 3 aan de eindsystolische fase, tot de hele linker- en/of rechterventrikel is gesegmenteerd.

OPMERKING: De software bepaalt automatisch de einddiastolische fase als de fase met het grootste volume en 
de eindsystolische fase als de fase met het kleinste volume. De einddiastolische en eindsystolische 
fasebepalingen worden tijdens de segmentatie bijgewerkt.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

3. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

4. Bekijk alle resultaten op de meettabel.
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Procedure voor handmatige LV- en RV-myocardiale massa

1. Selecteer de relevante hartfase.

2. Selecteer  voor LV-epicard of  voor RV-epicard. 

3. Trek de epicardiale contour na.

4. Ga naar het volgende plakje met  of gebruik <- en -> of selecteer de miniatuur.

5. Herhaal stap 3 en 4 tot het epicard van de hele linker- en/of rechterventrikel is gesegmenteerd.
De massaresultaten worden automatisch bijgewerkt wanneer de epicardiale contouren worden gedefinieerd.

Controleer juistheid van segmentatie/bewerking

1. Speel de korte-asserie in filmmodus af en controleer de nauwkeurigheid van de contouren.

2. Werk contouren die onnauwkeurig zijn bij.

3. Bekijk de matrixmodus en bevestig ED- en ES-toewijzingen.

4. Bekijk alle resultaten op de meettabel.

Basale interpolatie

Om segmentatie-interpolatie voor de basale plakjes uit te voeren, identificeert u de mitralisklep of de annulus van de 
tricuspidalisklep op een lange as-weergave.

OPMERKING: Automatisch invoegen van de klepring voor de LV en RV kan worden ingesteld in Voorkeuren. Selecteer 
Tools > Voorkeuren > Bewerken. Selecteer Automatische MV van TV-annulusinsertie onder Functie.

1. Selecteer voor LV-basale interpolatie een 2-kamerweergave in de kruisverwijzingsmodus.

2. Selecteer .

3. Definieer de MV-annulus, zoals weergegeven in Figuur 2. Bekijk de plaatsing van de lijn op de relevante 
eindsystolische en einddiastolische fasen met behulp van de cine-knoppen.

OPMERKING: Multi-vlak basale interpolatie wordt ondersteund. De MV-annulus kan bijvoorbeeld worden 
geïdentificeerd op 2-kamer- en 4 kamer-weergaves; fit wordt uitgevoerd tussen de twee vlakken.

OPMERKING: Zoek de serie van MV- of TV-annulusplaatsing door te klikken op  of  linksonder in het 
kijkvenster. 
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FIGUUR 2. MV-annulus

4. Controleer de bijgewerkte berekening door de kruisverwijzingsplakjes te beoordelen in relatie tot de lijn. 

Zoals weergegeven in Figuur 3, is de geïnterpoleerde volumeberekening gebaseerd op de relatie van het snijpunt tot het 
plakje (roze lijn). Dit volume is nu opgenomen in de volumeresultaten. Het daadwerkelijke te onderzoeken gebied wordt 
niet getoond. Plakjes die zijn geïnterpoleerd, geven het volume aan met het percentage interpolatie in de linkerhoek van 
de afbeelding, zoals weergegeven in Figuur 3.

FIGUUR 3. Volumeberekening

5. Selecteer voor RV-basale interpolatie een 4-kamerweergave in de kruisverwijzingsmodus.

6. Selecteer .

7. Definieer de TV-annulus, zoals weergegeven in Figuur 4. Bekijk de plaatsing van de lijn op de relevante eindsystolische 
en einddiastolische fasen met behulp van de cine-knop.
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FIGUUR 4. TV-annulus

8. Controleer de bijgewerkte berekeningen door de kruisverwijzingsplakjes in relatie tot de lijn te bekijken en bekijk de 
ED- en ES-toewijzingen in matrixmodus.

9. Om het resultaat terug te zetten naar de oorspronkelijke waarde, klikt u met de rechtermuisknop en houdt u deze 
direct op de regel om verwijderen te selecteren of klikt u met de linkermuisknop op de regel en gebruikt u de delete-
toets op het toetsenbord. 

Nauwkeurigheid controleren

1. Speel de lange-asserie in filmmodus en controleer de plaatsing van de lijn.

2. Pas de plaatsing van de lijn naar wens aan.

3. Als automatisch invoegen is uitgevoerd, controleer dan of de juiste serie is geselecteerd en de lijn correct is geplaatst. 
Indien niet correct geplaatst, klik met de rechtermuisknop op de lijn en verwijder deze.

Bewegingscorrectie tussen series

Bewegingscorrectie tussen series compenseert cardiale vertaling die kan optreden tussen de registratie van lange-
asbeelden en korte-asbeelden. Fouten in kamervolumes kunnen optreden als annulaire vlakken worden afgeleid van 
lange-asbeelden die niet ruimtelijk registreren met korte-asbeelden die de endocardiale contouren bevatten die worden 
gebruikt voor volumetrische analyse. De fout kan optreden als de korte en lange asbeelden worden verkregen in 
verschillende fasen van de ademhalingscyclus of als de patiënt van positie verandert (d.w.z. vertaalt) tussen de registratie 
van lange- en korte-asbeelden. Wanneer Bewegingscorrectie tussen series is geselecteerd, wordt het einddiastolische 
midden van het atrioventriculair klepvlak gedefinieerd door de meest basale einddiastolische endocardiale contour van 
het ventrikel. De angulatie van het klepvlak van de annulus en de relatieve positie van het middelpunt op andere 
hartfasen wordt bepaald door de angulatie van de annuluslijnen en de relatieve positie van de annuluscenters zoals 
gedefinieerd op de lange-asbeelden. 

OPMERKING: Voor toegang tot de functie in de Functieanalysemodus. Selecteer Tools > Voorkeuren > Bewerken. 
Selecteer Bewegingscorrectie tussen plakken onder Functie.
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1. Voer LV- en RV-automatische segmentatie uit voor alle fasen voor alle plakken.

2. Voer de Basale interpolatie uit voor de LV en RV. 

3. Selecteer .

4. Overeenkomst kan worden bevestigd wanneer de stippellijn over de plaatsing van de MV-annuluslijn verschijnt, zoals 
weergegeven in Afbeelding 5 (links).

FIGUUR 5. Bevestigde overeenkomst (links) Hartvertaling (rechts)

5. Afbeelding 5 (rechts) toont een opening tussen de ononderbroken en onderbroken annuluslijnen. 

6. De ononderbroken lijn vertegenwoordigt het annulusvlak getekend op het lange-asbeeld. De stippellijn 
vertegenwoordigt het vertaalde annulusvlak op basis van de locatie van de meest basale endocardiale contour. 

OPMERKING: Het is de verantwoordelijkheid van de gebruiker om de reden voor de afstand tussen de ononderbroken 
en stippellijn vast te stellen, en om de analyse indien nodig te corrigeren. Mogelijke redenen voor een 
opening zijn:

- De meest basale endocardiale contour op het beeld van de korte as wordt niet op de juiste plak getekend. Indien niet 
gecorrigeerd, zal de software verkeerd compenseren voor vertaling. 

- De annuluslijn vertegenwoordigt niet de positie van de annulus. Indien niet gecorrigeerd, zal de software verkeerd 
compenseren voor vertaling. 

- Hartvertaling tussen de registratie van de lange as en de registratie van de korte as.

Als de meest basale endocardiale contour op de juiste plak wordt getekend en de annuluslijn correct op het 
lange asbeeld wordt getekend, vertegenwoordigt de ruimte tussen de ononderbroken en onderbroken lijn de 
werkelijke hartvertaling en zal de software corrigeren voor die vertaling.

7. Controleer de vertaling als de RV-segmentatie is uitgevoerd en de TV-annulus is geplaatst. 
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Interpolatiefunctionaliteit 

Bij het uitvoeren van functieanalyses voor de LV of de RV wordt de interpolatiefunctionaliteit uitgeschakeld. 

Interpolatiefunctionaliteit kan worden toegepast voor de volgende omstandigheden:

• Als dezelfde hartfase over plakjes voor zowel eind-systole of eind-diastole wordt getraceerd en een plakje is overgeslagen, 
kan de interpolatie worden ingeschakeld door interpolatie „Aan” te selecteren, zoals weergegeven in Figuur 6.

• Als dezelfde hartfase over plakjes wordt getraceerd voor ofwel eind-systole of eind-diastole en/of een plakje is 
overgeslagen, kan de basale interpolatie automatisch worden toegepast. 

FIGUUR 6. Interpolatie

Beoordeling van eind-diastolische (ED) en eind-systolische (ES) opdrachten

Nadat de segmentatie is voltooid, bekijkt u de matrixmodus en bevestigt u de eind-diastolische of eind-systolische 
toewijzingen. 

OPMERKING: Voor elk ventriculair volume-analysetype verschijnt het volgende bericht, als de eind-diastolische (ED) of 
eind-systolische (ES) tracering handmatig op een andere fase wordt uitgevoerd.

Interpolatie UIT Interpolatie AAN
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FIGUUR 7. ROI-indelingsbericht

1. Selecteer de Matrixmodus  knop.

2. Selecteer de plak-voor-plak ED-/ES-modus 
Het kijkvenster verandert en toont een matrix die alle verkregen plaklocaties en fasen weergeeft. In Figuur 8 zijn alle 
LV-eind-diastolische fasen toegewezen zoals aangegeven door de rode driehoeken. De blauwe driehoeken geven de 
toegewezen LV-eind-systolische fasen aan. De rode stippen duiden nog niet toegewezen fasen aan.

3. Om in dit voorbeeld de LV-systolische fasen toe te wijzen, klikt u op de knop  en klikt u op de juiste fase met een 
rode stip. Er verschijnt een blauwe driehoek nadat u op het matrixvak hebt geklikt. Zoals getoond in Figuur 9, zijn alle 
eind-diastolische en/of eind-systolische toewijzingen nu correct.

4. Herhaal de bovenstaande stappen indien nodig voor de RV. Klik op het tabblad RV voor de RV. 

FIGUUR 8. Toewijzing van LV-eind-diastolische fasen FIGUUR 9. Toewijzing van LV-eind-systolische fasen
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Bepaling volumemethode

De volumemethodebepaling voor ED en ES is gebaseerd op de keuze van de schakelknop voor globaal en plakje voor plakje.

Resultaten ventriculaire functieanalyse 

Volumecurve

Wanneer autosegmentatie wordt uitgevoerd voor alle fasen en alle plakjes voor LV of RV, wordt een ventriculaire 
volume-tijdcurve gegenereerd, zoals weergegeven in Figuur 10. Deze curve kan in het rapport worden opgenomen. 
Markeringen met schuifjes kunnen worden aangepast.

Tabel 4:  Schakelknop voor volumemethodebepaling

Globale ED/ES Wanneer globaal is geselecteerd, wordt het gecombineerde 
volume gebaseerd op de ED- en ES-toewijzingen op basis van 
dezelfde fase.

Plakje voor plakje 
ED/ES

Wanneer plakje voor plakje wordt geselecteerd, wordt het 
gecombineerde volume gebaseerd op het grootste en kleinste 
volume per fase voor elk plakje. De modus Propageer alle plakjes, 
alle fasen moet worden geselecteerd om dit te activeren.
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FIGUUR 10. Resultaten automatische ventriculaire segmentatie

1. Volumetrische resultaten, 2. Volumecurve, 3. Matrixmodus

• De rode cursor markeert het eind-diastolische volume.
• De blauwe cursor markeert het eind-diastolische volume.
• De groene cursor markeert de hoogste uitstootwaarde (HUW) ml/sec. (interactieve verticale cursor).
• De gele cursor markeert de hoogste vulwaarde (HVW) ml/sec. (interactieve verticale cursor).
• De overeenkomstige selectie van de beeldfase wordt aangegeven door de witte markering op de volumecurve.

De volumetrische resultaten worden weergegeven in de metingentabel. 

• Klik met de linkermuisknop op de omgekeerde driehoek voor LV of RV om de ventriculaire massa-resultaten of massa-
indexfase te bekijken.

• Alleen de uit de tabel geselecteerde fase wordt in het rapport getoond. De standaardinstelling is ED.

1

2

3
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FIGUUR 11. Massaresultaten

FIGUUR 12. Tabel kamervolume

LV en RV volumetrische resultaten worden weergegeven in de Tabel kamervolume. 
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Linker ventriculaire regionale analyse

Met LV-regionale analyse kunnen de resultaten van wandbeweging, wanddikte en wandverdikking worden bekeken.

OPMERKING: Als de knoppen LV en RV in Functie Korte as beide zijn uitgeschakeld of als de knop voor kamerkeuze in 
Lange as is uitgeschakeld, wordt de knop Start Automatisch Propageren uitgeschakeld. 

1. Voer automatische LV-segmentatie uit voor alle plakjes in alle fasen (zie pagina 63).

2. Bekijk de plaatsing van het RV-insertiepunt op elk plakje en pas het RV-insertiepunt aan voor de basale plakjes.

3. Als u een RV-insertiepunt aan een plaklocatie wilt toevoegen, klikt u op RV-insertiepunt , selecteert u een 
automatisch gesegmenteerde plak en plaatst u het RV-insertiepunt. 

4. Bevestig basale, midden en apicale classificatie. 

5. Klik op Regionale analyse . Dikte, procentuele verdikking en wandbeweging worden weergegeven in een 
grafiek-, diagram- of tabelindeling.

FIGUUR 13. Regionale analyse
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Dyssynchronie-analyse

Dyssynchronie is een uitbreiding van de resultaten van de regionale analyse waarmee de Temporele Uniformiteit van 
Wanddikte (TUWT) kan worden berekend op basis van informatie over omtrek verkregen uit de regionale analyse. 
Literatuurverwijzing in Tabel 5.

Procedure voor dyssychronie-analyse

1. Voer LV automatische segmentatie uit (Zie Voer automatische segmentatie uit voor alle plakjes en alle fasen op 
pagina 63).

2. Selecteer Regionale analyse .

3. Selecteer de dyssychronie-tab.

4. De meettabel toont de resultaten voor elk plakje en het gemiddelde globale resultaat.

5. De globale resultaatberekening is optimaal wanneer alleen LV midden-ventriculaire plakjes daarin worden 
opgenomen. Om een resultaat van een plakje uit de globale resultaatberekening te verwijderen, klikt u rechtstreeks 
op het vakje met het vinkje in de uiterst rechtse kolom (Figuur 14).

FIGUUR 14. Globale resultatenberekening

Tabel 5:  

Resultaat Referentie

Temporele uniformiteit van 
wanddikte (TUWT)

*Bilchick et al., „Cardiac Magnetic Resonance Assessment of Dyssynchrony and 
Myocardial Scar Predicts Function Class Improvement Following Cardiac 
Resynchronization Therapy”, JACC, Vol.1:No 5: 2008 p. 561-8
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Procedure voor snelle LV-functieanalyse

1. Selecteer .

2. Selecteer een lange-asserie.

3. Selecteer .

4. Selecteer de  voor propagatie van alle segmenten en alle fasen.

5. Klik op .

OPMERKING: De knop Start Automatisch Propageren wordt uitgeschakeld als selectie van de lange-asweergave wordt 
uitgeschakeld.

6. Controleer alle traceringen. Zorg ervoor dat de middellijn overeenkomt met de lange as van de linker hartkamer van 
basis tot top.

7. Handmatig traceren kan worden uitgevoerd. Klik op  om het endocard van de linker hartkamer te traceren voor 
zowel eind-diastole als eind-systole.

8. Trek voor de berekening van de linker ventriculaire massa het linker ventriculaire epicardium na .

FIGUUR 15. Plaatsing middenlijn

De resultaten worden weergegeven in de Tabel metingen.
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 Atria

Procedure voor handmatige LA- en RA-functieanalyse
1. Selecteer de juiste serie in de beeldweergave. 

OPMERKING: Voor optimale resultaten wordt het aanbevolen om een stapel met 4 kamers te gebruiken voor analyse. 
De 4-kamerweergave beeldt de atriale anatomie beter uit.

2. Klik op .

3. Selecteer de -toets.

4. Wijs de eind-diastolische fase aan.

Het endocard definiëren

1. Selecteer  voor LA-endocard of  voor RA-endocard.

2. Breng de endocardiale contour aan.

3. Ga naar het volgende plakje met  of gebruik <- en -> of klik op de miniatuur.

4. Herhaal stap 2 en 3 tot de hele boezem is gesegmenteerd.

5. Wijs de eind-systolische fase aan.

6. Herhaal stap 2 en 3 aan de eind-systolische fase, tot de hele boezem is gesegmenteerd.

OPMERKING: De software bepaalt automatisch de einddiastolische fase als de fase met het grootste volume en de 
eindsystolische fase als de fase met het kleinste volume. De einddiastolische en eind-systolische 
fasebepalingen worden tijdens de segmentatie bijgewerkt.

7. Als een korte-asweergave is gebruikt, identificeer dan de MV- en/of TV-annulus.
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Procedure voor snelle LA- of RA-functieanalyse

Deze methode wordt uitgevoerd op een lange-asserie. 

1. Klik op .

2. Selecteer een lange-asserie.

3. Selecteer de eind-diastolische fase.

4. Selecteer de -toets.

5. Selecteer  voor LA-endocard of  voor RA-endocard.

6. Geef het endocard van de boezem aan. Nu wordt automatisch een centrale rotatielijn aangegeven.

7. Zorg ervoor dat de centrale rotatielijn overeenkomt met de lange as van de boezem.

8. Herhaal de stappen 5-7 voor de eindsystole.

Atriale dimensies en oppervlakte

1. Klik op .

2. Selecteer de relevante serie.

3. Om een atriale dimensiemeting uit te voeren, klikt u rechtstreeks op de tabel in de kolom voor LA of RA en plaatst u 
vervolgens twee punten. Zie Figuur 16.

4. Om een atriale oppervlaktemeting uit te voeren, klikt u rechtstreeks op de tabel in de kolom voor LA of RA en tekent 
vervolgens een ROI. Zie Figuur 16.

FIGUUR 16. Atriale meting
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Standaardmetingen
Met de applicatie kunnen lineaire metingen en oppervlaktemetingen worden gerapporteerd. Tooltips zijn beschikbaar 
door de cursor op de meting in de tabel te plaatsen.

FIGUUR 17. Standaardmetingen

1. Opnemen op rapport, 2. Tekstinvoerveld voor pericardium, 3. Zelfgedefinieerde meting toevoegen/verwijderen, 4. Wis alle metingen

Voer een meting uit

1. Selecteer .

2. Selecteer de serie. 

3. Klip op de -knop.

4. Wijs de afbeelding met het te onderzoeken deel aan.

5. Klik op de gewenste meting, die dan wordt gemarkeerd om aan te geven dat de selectie actief is. 

1

2

3 4
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VOORZICHTIG: Voor goede meetresultaten is het van essentieel belang dat de lijn nauwkeurig wordt geplaatst. 
Uit onnauwkeurige metingen kunnen verkeerde diagnoses volgen. Metingen dienen alleen te 
worden verricht door goed opgeleid en gekwalificeerd personeel.

6. Klik op annotatie om te bewerken en wanneer de kleur verandert naar paars, is deze actief. Plaats de cursor boven 
een van de eindpunten en wijzig die. 

Als u de cursor buiten het Beeldbewerkingsvenster plaatst, wordt de meetafstandwaarde automatisch bijgewerkt 
in de Tabel metingen.

Plaats om de hele meetafstandlijn te verplaatsen de cursor boven de middelste marker.

OPMERKING: Selecteer om de meting te resetten de meetafstandlijn en open het rechtermuisknopmenu en selecteer 
Prullenbak; of gebruik de Delete-toets op het toetsenbord. 

Metingen wissen

Klik op  om alle metingen te wissen.

Zelfgedefinieerde meting toevoegen

1. Selecteer .

2. Voer een uniek label in in het pop-upvenster Zelfgedefinieerde meting toevoegen.

3. Selecteer bij measurement type (soort meting) Linear (Lineair) of Area (Oppervlakte).

4. Selecteer OK. 

Zelfgedefinieerde meting verwijderen

1. Selecteer de .

2. Selecteer de uit de lijst te verwijderen zelfgedefinieerde meting(en).

3. Kies Selecteren.

OPMERKING: Zelfgedefinieerde metingen zijn beschikbaar voor alle toekomstige analyses totdat ze uit de lijst worden 
verwijderd.
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Klepvlakanalyse
Met de functie voor klepvlakanalyse kan de pieksnelheid van de klep, de piekdrukgradiënt en de gemiddelde 
drukgradiënt voor de klep worden berekend.1

Met behulp van de resultaten van de LV-autosegmentatie, wordt de drukgradiënt berekend op basis van het 
hartminuutvolume, op basis van de beeld voor beeld veranderingen in het systolische volume van de linker ventrikel.

Procedure voor klepvlakanalyse

1. Voer LV-autosegmentatie uit op alle plakjes in alle fasen (zie pagina 63).

2. Selecteer een serie die de anatomie van de klep toont.

3. Selecteer Klepgebied uit de meettabel (Figuur 18) en voer planimetrie van de klep uit, zoals getoond in Figuur 19.

FIGUUR 18. Klepgebied

4. Na voltooiing van de ROI zal de tabel worden bijgewerkt met de resultaten en een diagram presenteren met de 
drukgradiënt in de tijd.

Klik op  om alle metingen te wissen.

1. Wolff, Steven D., MD, Ph.D. Niet-invasieve methoden voor het bepalen van de drukgradiënt over een hartklep zonder 
snelheidsgegevens bij de klepopening te gebruiken. Amerikaans octrooi 9.585.568, 7 maart 2017.
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FIGUUR 19. Klepvlakanalyse

WAARSCHUWING: Aanbevolen wordt om de hartanalyse te laten uitvoeren door gekwalificeerd personeel, 
als de analyseresultaten moeten worden gebruikt om een diagnose te stellen.

OPMERKING: De resultaten van Pieksnelheid, Piekdrukgradiënt en Gemiddelde Drukgradiënt verkregen door middel 
van Value Plane Analysis zijn niet geldig bij patiënten met mitralisregurgitatie of een shunt.
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Stroomanalyse
De Stroomanalysemodus ondersteunt zowel 2D- als 4D-stroomacquisities. Zowel handmatige als volledig automatische 
segmentatie met de kwantificering van stroomvolume, snelheid, regurgiterend volume, drukgradiënt, drukhalfwaardetijd 
en Qp/Qs worden ondersteund. Op basis van de gebruikersmethodeselectie(s) kan automatische berekening van aorta-, 
mitralis-, long- en tricuspidalisregurgitatie worden verkregen. Nauwkeurige stroomresultaten zijn afhankelijk van de 
beelden die worden geregistreerd met het juiste scanvlak, de juiste registratieparameters en doorstroomcodering.

OPMERKING: Automatische segmentatie kan minder nauwkeurig zijn in gevallen waarin de beeldkwaliteit slecht is. 
In die gevallen is de gebruiker verantwoordelijk voor het bewerken van contouren of het uitvoeren van 
handmatige segmentatie.

OPMERKING: Als zowel 2D-fasecontrast als inline 4D-stroomanalyse zijn uitgevoerd, zijn alle resultaten beschikbaar in 
de stroomanalysemodus.

De voorbewerkingsfunctie ondersteunt de identificatie van bloedvattypes voor 2D-fasecontrast zoals vermeld in Tabel 1. 
Raadpleeg de gebruiksaanwijzing van suiteDXT NS-03-040-0014.

WAARSCHUWING: Na het voorverwerken is de gebruiker verantwoordelijk voor het beoordelen van de 
nauwkeurigheid van de gehele analyse en het aanbrengen van eventuele correcties. Een 
uitgebreide beoordeling moet inhouden:

- Plaatsing ROI 
- Correcte bloedvatidentificatie voor elke categorie
- Basislijncorrectie

WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing en correcte categorietoewijzing 
van alle interessegebieden (ROI’s), inclusief de gebieden die zijn gegenereerd of aangepast 
door de automatische segmentatiealgoritmen. De kwantitatieve waarden die door de 
software worden gegenereerd, zijn afhankelijk van de juiste plaatsing en correcte toewijzing 
van bloedvatcategorieën van alle interessegebieden.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
klinische interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve 
metingen is aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde 
diagnoses. Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd 
personeel.
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FIGUUR 1. Overzicht interface stroomanalyse

1. Bloedvatcategorieën, 2. Keuze voor volwassenen/kinderen, 3. Actieve ROI-selectie, 4. Diagram omkeren, 5. Propageer selecties, 
6. Opties wissen, 7. Vervolgkeuzemenu basislijncorrectie 8. Offset: Fase, verwijding, stroom, 9. Ruispixels uitsluiten, 10. Kleurdekkingsregeling, 
11. Aliasing-correctie, 12. Selecties curvemodus, 13. Resultatentabelselecties, 14. Curveresultaat/-weergave, 15. Regurgitatiemodus, 
16. Bewerkingsfuncties, 17. Geïntegreerde analyse

OPMERKING: Stroomanalyse geeft de grootte- en fasebeelden weer in een beeldweergave naast elkaar. Andere 
beeldtypes verkregen op dezelfde scanlocatie worden niet weergegeven en moeten worden beoordeeld 
in de Viewer.

OPMERKING: De hartslag kan worden verkregen door over het stroomresultaat op de curveweergave te bewegen.
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Stroomanalyse met gebruik van automatische segmentatie
Als de voorbewerking is voltooid, op basis van de 2D-fasecontrastserie die aanwezig is in het onderzoek, wordt de 
segmentatie automatisch uitgevoerd op de 2D-fasecontrastserie en toegewezen aan de juiste bloedvatcategorie (Tabel 
1). Automatische segmentatie vereist niet dat een initiële ROI op het bloedvat wordt geplaatst. Selecteer gewoon de 
juiste bloedvatcategorie en de juiste serie die dat bloedvat weergeeft. Als voorbewerking niet wordt uitgevoerd is het 
belangrijk om de juiste categorie te selecteren die overeenkomt met de verkregen anatomie van het bloedvat.

WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing en correcte categorietoewijzing 
van alle interessegebieden (ROI’s), inclusief de gebieden die zijn gegenereerd door 
voorbewerking. 

OPMERKING: Als er meer dan zes bloedvaten worden verkregen voor fasecontrast per tabblad, behoudt de functie 
Voorbewerking alleen de zes meest recente resultaten.

OPMERKING: Het netto stroomresultaat wordt weergegeven onder elke bloedvatcategorie. Als er meer dan één 
flowmeting in een bloedvatcategorie is, wordt het gemiddelde resultaat weergegeven. Om deze waarde 
te verbergen, selecteer Tools > Voorkeuren > Bewerken en stel de floweenheid in op NONE onder Flow. 

Tabel 1:  Bloedvatcategorieën

Bloedvatcategorie Tooltip Label

LVOT Uitstroombaan linkerventrikel (pediatrisch) 

pAAo Proximale stijgende aorta

mAAo Middelste stijgende aorta

pDAo Proximale dalende aorta
(Pediatrisch)

SVC Bovenste holle ader
(Pediatrisch)

MPA Hoofdlongslagader

RPA Rechterlongslagader
(Pediatrisch)



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      87

Voer automatische of handmatige segmentatie uit 
(Voorbeeld van proximale neergaande aortasegmentatie)

1. Selecteer Volwassen of Pediatrie .

2. Selecteer  categorie.

3. Selecteer de juiste fasecontrastseries die de proximale stijgende aorta demonstreren, zoals weergegeven in Figuur 2.

FIGUUR 2. Proximale stijgende aorta

4. Selecteer de actieve ROI-kleur, zoals weergegeven in Figuur 3.

FIGUUR 3. Actieve ROI-selectie

LPA Linkerlongslagader
(Pediatrisch)

IVC Onderste holle ader
(Pediatrisch)

dDAo Distale dalende aorta
(Pediatrisch)

Flow 1, Flow 2 Door de gebruiker gedefinieerde categorieën. Klik met de 
rechtermuisknop en voer een nieuw label voor de 
categorie in. Het label verschijnt als een tooltip. 

Tabel 1:  Bloedvatcategorieën

Bloedvatcategorie Tooltip Label
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Er zijn zes ROI’s beschikbaar, genummerd 1 - 6. De kleurcode is hetzelfde in de analyseweergave, afbeeldingkijkvensters 
en diagrammen.

5. Selecteer .

6. Bekijk de segmentatie op het bloedvat. Controleer of het juiste bloedvat is gesegmenteerd. 
Als het verkeerde bloedvat gesegmenteerd is, voer dan handmatige segmentatie uit.

7. Selecteer  om handmatige segmentatie uit te voeren.

8. Creëer een contour rond een bloedvat door 4 punten rond het betreffende vat te plaatsen en beweeg de cursor 
buiten het bewerkingsvenster om de ROI af te bakenen.

• Kies  voor automatische segmentatie voor alle fasen in de plak.

Of

• Kies  ervoor om dezelfde contour over alle fasen in de plak over te dragen. Dit is handig voor het analyseren van 
kleine, stationaire bloedvaten.

9. Klik op een contour, om te bewerken, voer de bewerking uit en klik op . Zie Contouren wijzigen op pagina 89.

10. Stroomresultaten worden getoond in het diagram en de resultaattabellen. Klik het vinkje aan in het hokje naast het 
stroomresultaat om de bijbehorende curve uit het diagram te verwijderen. 

11. Selecteer een optie voor basislijncorrectie in de keuzebestanden.
Curven met een toegepaste basislijncorrectie hebben gegevenspunten in de vaste fase, zoals weergegeven in Figuur 8. 
Zie Opties voor basislijncorrectie op pagina 92.

FIGUUR 4. Stroomdiagram – Geen correctie (linker diagram); Correctie toegepast (rechter diagram)

Alle gegenereerde stroomcurven worden in een positieve richting weergegeven. Omgekeerde curven worden 

aangegeven door .
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Bloedvatcategorie verplaatsen

Na beoordeling, als een voltooid stroomresultaat niet in de juiste bloedvatcategorie ligt, kan het naar de juiste categorie 
worden verplaatst.

Klik met de linkermuisknop op de contour en vervolgens met de rechtermuisknop, sleep de cursor naar het bloedvattype 
en selecteer vervolgens de juiste stroomcategorie zoals weergegeven in Figuur 5. (Pediatrische categorieën worden 
getoond.) Het stroomresultaat wordt nu in die categorie weergegeven.

FIGUUR 5. Selectie bloedvatcategorie verplaatsen

Contouren wijzigen
1. Selecteer de gewenste fase om te wijzigen.

2. Klik met de linkermuisknop op de contour om deze te activeren voor wijzigen.
De contour wordt paars, wat betekent dat hij kan worden gewijzigd.

3. Bewerk, indien weergegeven, de contour door de punten voor punt-splinecontouren te verplaatsen.

4. Voer een wijziging uit de vrije hand uit door te klikken en te traceren. 

5. Klik met de linkermuisknop op de contour om te selecteren, en vervolgens met de rechtermuisknop om tools te 
gebruiken, zoals beschreven in Tabel 2. 

6. Gebruik de bewerkingstools van het kijkvenster zoals beschreven in Tabel 3.
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Het wijzigen van meerdere fasen

1. Selecteer de gewenste plak.

2. Selecteer  om de thumbnails te tonen van alle fasen van een bepaalde plaklocatie.

3. Selecteer de eerste fase van de te wijzigen reeks fasen.

4. Houd de shift-toets ingedrukt en selecteer de laatste fase van de te wijzigen reeks.

5. Wijzig de contour in het Beeldbewerkingsvenster.

6. Deselecteer de contour door buiten de geselecteerde contour op de afbeelding te klikken of door de cursor buiten 
het bewerkingsvenster te verplaatsen.

Tabel 2:  Rechtermuisknopopties

Tool Beschrijving

Een enkele ROI in de huidige fase verwijderen

Alle ROI’s op alle fasen verwijderen

Selectie nudge-functie

Selectie trek-functie

De huidige bloedvatcategorie wordt getoond. Stroomresultaten verplaatsen naar een andere 
categorie

Tabel 3:  Wijzigingsfuncties kijkvenster 

Tool Beschrijving

Kopieer bewerken naar einde van fasen 

Kopieer wijzigen naar begin van fasen 
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Kopieer ROI van vorige fase 

Kopieer ROI naar volgende fase 

ROI-grootte verkleinen 

ROI-grootte vergroten

Navigeer naar vorige en volgende fase

ROI naar rechts of links verschuiven

ROI omhoog of omlaag verschuiven 

Tabel 3:  Wijzigingsfuncties kijkvenster 

Tool Beschrijving
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Opties voor basislijncorrectie

Er zijn drie methoden voor basislijncorrectie voor 2D-fasecontrast. Stroomcurven waarop een correctiemethode is 
toegepast, hebben gegevenspunten in de vaste fase.

OPMERKING: Fasecontrastafbeeldingen die worden gebruikt voor analyse mogen geen faseomloop in de afbeelding 
hebben. Faseomloop in de afbeelding maakt de automatische basislijncorrectie ongeldig.

Automatische basislijncorrectie

De Automatische basislijncorrectie corrigeert fasefouten die optreden tijdens beeldverwerving door de fasefout in verre 
stationaire organen (bijvoorbeeld borstwand, lever, enz.) te onderzoeken en de gegevens ruimtelijk in te passen met 
behulp van lineaire of hogere orde interpolatie.

OPMERKING: Als een 2D-magnitude- en faseserie wordt gecreëerd met behulp van de 3D/4D Flow Viewer, maakt 
de applicatie een niet-gecorrigeerde serie en een tweede serie waarop fasefoutcorrectie is toegepast. 
Pas automatisch uit het keuzemenu basislijncorrectie niet toe op de serie met het label „Gecorrigeerd”.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer automatisch in het keuzemenu Basislijncorrectie.

OPMERKING: Automatische basislijncorrectie wordt automatisch toegepast als Automatische basislijncorrectie is 
aangevinkt in Voorkeuren.

3. De correctie wordt toegepast met de bijgewerkte resultaten direct in het stroomdiagram weergegeven.

4. Series die niet passen bij de aanpassingsanalyse, worden aangegeven met een waarschuwingssymbool, zoals 
weergegeven in Figuur 6.

OPMERKING: Faseomloop in de afbeelding zal onjuiste stroomresultaten tot gevolg hebben, zoals weergegeven in 
Figuur 7. 2D-Cine Fasecontrastafbeeldingen die worden gebruikt voor stroomanalyse mogen geen 
faseomloop in de afbeelding hebben, zoals weergegeven in Figuur 8.

FIGUUR 6. Basislijncorrectiefout

Typen fouten:

1 – Omloop in het beeld
2 – Ruis op het beeld
3 – Beeld is ongeldig
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FIGUUR 7. Voorbeeldafbeeldingen met faseomloop (witte pijlen)

FIGUUR 8. Voorbeeldafbeeldingen zonder faseomloop

Schaduwcorrectie

Om de nauwkeurigheid van de resultaten van het fasecontrast te verbeteren en om te corrigeren voor fouten in de 
basislijnfaseverschuiving, kan een fantoomverwerving worden gebruikt om deze fout te berekenen.

OPMERKING: De fantoomcorrectieserie moet zijn verkregen met dezelfde scanbepaling en parameters als de originele 
fasecontrastserie. Er moet een signaal komen van een stationair voorwerp dat de contour op de 
fantoomserie helemaal opvult.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer de bijbehorende fantoomserie in het keuzemenu Basislijncorrectie.

3. De correctie wordt toegepast met de bijgewerkte resultaten direct in het stroomdiagram weergegeven.

Correctie van achtergrondcontouren

Deze correctiemethode kan worden overwogen voor vaten die zijn omgeven door vast weefsel.

OPMERKING: Voor een optimale correctie moet de achtergrondcontour worden geplaatst in vast weefsel vlak naast 
en om het stroomgebied.
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1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer de Achtergrond-ROI in het keuzemenu Basislijncorrectie.

3. Klik op  om een contour te tekenen.

4. De correctie wordt toegepast met de bijgewerkte resultaten direct in het stroomdiagram weergegeven.

Flowtools

Offsetopties 

Het bestandskeuzemenu heeft 3 opties: Fase, flow, verwijding

Ruispixels uitsluiten

Deze optie herkent pixels met lage intensiteit (hoge schommeling van snelheden) indien aanwezig binnen de ROI, 
aangegeven met de roze overlay zoals getoond in Figuur 10 en sluit ze uit van de stroomberekening. Het percentage 
ruispixels kan worden aangepast met de schuifbalk.

FIGUUR 9. Ruispixels

Tabel 4:  

Selectie Beschrijving

Fase Wijzigt de ordinaat van de stroomcurve.

Stroom Verandert de absciswaarde van de stroomcurve, waardoor de basislijnwaarden van het 
stroomresultaat veranderen.

Verwijding Verandert gelijkmatig de radius van het gesegmenteerde bloedvat voor alle fasen met een 
gespecificeerde pixelhoeveelheid om geldige stroompixels op te nemen.
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FIGUUR 10. Ruispixels aangegeven door middel van roze overlay

Kleuroverlap

Klik op de schuifbalk kleurdekking en versleep deze om een rode/blauwe kleuroverlay weer te geven die snelheden 
vertegenwoordigt op het magnitudebeeld. Pas het snelheidsbereik aan door de blauwe of rode markeringen in te stellen 
zoals getoond in Figuur 11.

FIGUUR 11. Bedieningselementen kleuroverlay

Correctie van snelheidsaliasing

Om snelheidsaliasing te corrigeren, schuift u de schuifbalk om faseomloop opheffen uit te voeren. Het effect van de 
wijziging wordt direct op het fasebeeld bijgewerkt en het stroomdiagram wordt bijgewerkt. Aliasingcorrectie kan worden 
uitgevoerd zonder dat er een ROI op het beeld aanwezig is. Als er meer dan één plaklocatie aanwezig is in de serie die de 
instelling wijzigt, heeft dit invloed op alle plaklocaties. Als u één plaklocatie wilt wijzigen, gebruikt u de Ctrl- of Alt-toets 
op het toetsenbord om de schuifbalkbesturing te wijzigen. 
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Door de gebruiker gedefinieerde pieksnelheid
1. Selecteer de juiste fase in de hartcyclus.

2. Plaats met  de cursor boven het fasebeeld.
De cursor wordt gesynchroniseerd met zowel de magnitude- als de fasebeelden. Het snelheidsresultaat verschijnt in mm/s 
op het fasebeeld naast de cursor.

FIGUUR 12. Pixelstroomsnelheid

Selecties curvemodus

Tabel 5:  

Selectie Modus Beschrijving

Stroom Curve vertegenwoordigt het stroomvolume van elke fase in 
de gehele hartcyclus (standaard). Elk punt op de curve 
vertegenwoordigt de stroom voor die fase. Het netto 
stroomresultaat wordt weergegeven.

Histogram Deze diagram toont een grafiek van de snelheid van elke pixel 
binnen elk interessegebied voor elke fase van de hartcyclus. 
De resultaten van piek- en gemiddelde drukgradiënt worden 
weergegeven.

Drukhalfwaardetijd (PHT) De tijd die nodig is om de piek transmitrale drukgradiënt met de 
helft te verminderen. Hiermee kan de helling van de grafiek 
worden bepaald om het PHT- en mitralisklepoppervlak (MVA) te 
berekenen.

Vergelijken Voor de weergave van curven uit twee verschillende 
categorieën. 
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*Deze selecties zijn alleen beschikbaar als de voorkeur is geselecteerd. Selecteer Tools > Voorkeuren > Bewerken. 
Selecteer Geavanceerde opties tonen onder Flow. 

Histogrammodus

Selecteer de histogrammodus om een grafiek van snelheden per pixel en de berekening van de piek- en gemiddelde 
drukgradiënt weer te geven.

1. Genereer een stroomcurve met de juiste fasecontrastseries.

2. Selecteer .

3. Klik direct op de diagram om een dradenkruiscursor op het fasebeeld te activeren, die de bijbehorende locatie van 
die pixel aangeeft.

4. Gebruik de dubbele pijlknoppen onderaan de diagram om de hoogste of laagste snelheidswaarde te vinden, 
(Figuur 13).

5. Gebruik de enkele pijlknoppen om stap voor stap door de snelheidswaarden te gaan, zoals weergegeven in Figuur 13.

OPMERKING: De serielokalisatiefunctie wordt uitgeschakeld in de histogrammodus wanneer u rechtstreeks op de 
stroomcurve klikt. Schakel naar de stroommodus om de lokalisatiefunctionaliteit in te schakelen.

OPMERKING: Om ervoor te zorgen dat de bijbehorende magnitude- en faseafbeeldingen worden weergegeven, 
moet u met één stroomcurve tegelijk werken en de andere histogramcurven in de grafiekweergave 
deselecteren.

OPMERKING: Onderzoeken die zijn geanalyseerd met behulp van de histogrammodus met een eerdere versie van 
suiteHEART® Software moeten mogelijk opnieuw geanalyseerd worden.

Regurgitatie Berekent de netto negatieve stroom (onder x-as). 

Positief* Toont de som van het positieve stroomgebied gedurende de 
hartcyclus.

Negatief* Toont de som van het negatieve stroomgebied gedurende de 
hartcyclus.

Piek totaal* Toont een grafiek van piekpositieve en -negatieve snelheden 
voor elke fase van de hartcyclus.

Piek absoluut* Toont een grafiek van absolute pieksnelheid voor elke fase

Tabel 5:  

Selectie Modus Beschrijving
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FIGUUR 13. Histogrammodus

Drukhalfwaardetijd

De drukhalfwaardetijd (PHT) kan worden verkregen door het meten van de deceleratietijd van de E-golf op 
fasecontrastbeelden die zijn verkregen van de mitralisklep. Met deze modus kan de helling van de grafiek worden 
bepaald om het PHT- en mitralisklepoppervlak (MVA) te berekenen.

1. Genereer een stroomcurve met de juiste fasecontrastseries van de mitralisklep.

2. Gebruik voor de ROI-propagatie de optie copy-paste.

3. Selecteer .

4. Klik direct op de grafiek om de hoogste snelheid van het deceleratiegedeelte van de curve aan te geven.

5. Klik op een eindpunt om de helling van de curve te berekenen zoals weergegeven in Figuur 14.

6. Om de berekening opnieuw in te stellen, plaatst u de cursor op een eindpunt, klikt u met de rechtermuisknop en 
selecteert u de prullenbak.
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FIGUUR 14. Resultaten drukhalfwaardetijd

OPMERKING: Resultaten van het mitralisklepgebied (MVA), drukhalfwaardetijdresultaten (PHT) zijn niet geldig bij 
patiënten met aorta-insufficiëntie, cardiale shunt of verminderde ventriculaire compliantie.

OPMERKING: De serielokalisatiefunctie wordt uitgeschakeld in de PHT-modus wanneer u rechtstreeks op de 
stroomcurve klikt. Schakel naar de stroommodus om de lokalisatiefunctionaliteit in te schakelen.

Referentie:

http://www.csecho.ca/mdmath/?tag=mvaph
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Stroomresultaten bekijken

Selecteer een van de volgende opties om stroomresultaten in tabelformaat te bekijken.

Categorie label wijzigen voor Flow 1, Flow 2
Alleen de labels voor de categorieën Flow 1 of Flow 2 kunnen worden gewijzigd.

FIGUUR 15. Flow 1, Flow 2

Label wijzigen

1. Klik met de rechtermuisknop op Flow 1 of Flow 2 (Figuur 15).

2. Voer de nieuwe labelnaam in (Figuur 16).

3. De nieuwe labels verschijnen als tooltips. 

OPMERKING: Aan het label van de curvelegenda wordt hetzelfde label toegewezen. 

Tabel 6:  Opties resultatentabel

Selectie Label Beschrijving

Geïntegreerde 
analyse

Analyseresultaten van het stroompaneel weergeven. Bevat 
resultaten voor aorta-, mitralis-, long- en tricuspidalisregurgitatie 
en Qp/Qs. Zie Geïntegreerde analyse op pagina 102.

Stroomanalyse Overzicht van resultaten per stroomcurve. 

Gegevenstabel Geeft een lijst van gedetailleerde flowparameters voor elke fase 
per stroomcurve.
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FIGUUR 16. Categorielabel wijzigen 

OPMERKING: Als u de labels van de stroomcategorie wijzigt, wordt de labeltitel voor het rapport gewijzigd.

Curve legenda’s bewerken 

1. Klik met de rechtermuisknop op Flow 1:1 onderaan de stroomdiagram (Figuur 17).

OPMERKING: Als het categorielabel is gewijzigd, wordt dat label weergegeven.

FIGUUR 17. Curvelegenda’s bewerken

2. Voer de nieuwe labelnaam in.

FIGUUR 18. Wijzig het label van de stroomcurvelegenda’s

OPMERKING: De nieuwe stroomcurvelegenda’s worden opgeslagen met de huidige sjabloon.
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Geïntegreerde analyse 
Op basis van een door de gebruiker geselecteerde methode berekent Geïntegreerde analyse Qp, Qs, Qp/Qs, aorta-, 
mitralis-, long- en tricuspidalisregurgitante volumes en regurgitante fracties (RF%).

WAARSCHUWING: De gebruiker is verantwoordelijk voor het selecteren van de methode voor het bepalen van 
Qp, Qs en aorta-, mitralis-, long- en tricuspidalis regurgiterende volumes en regurgiterende 
fracties. 

WAARSCHUWING: Sommige of alle methoden zijn mogelijk niet geschikt, afhankelijk van de patiëntpathologie. 
De gebruiker is verantwoordelijk voor het bepalen van welke methode dan ook geldig is 
voor interpretatie.

WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing en correcte categorietoewijzing 
van alle interessegebieden (ROI’s), inclusief de gebieden die zijn gegenereerd door 
voorbewerking.

OPMERKING: De gebruiker kan de standaard berekeningsmethode voor Geïntegreerde analyse instellen door 
Tools > Voorkeuren > Bewerken te selecteren. In het vervolgkeuzemenu voor bestanden. 
Standaardmethodeselecties zijn: geen, alle of laatste.
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Overzicht geïntegreerde analyse (volwassene wordt getoond)

• ml/slag of l/min eenheidselectie
• Index naar BSA-selectie (hoogte en gewicht moeten worden ingevoerd in het 

tabblad Geschiedenis)
Selecties voor Qp en Qs

• Qp: Toont de flowwaarden uit de MPA-categorie 
• Qs: Toont de flowwaarden uit de pAAo- of mAAo-categorieën
• Qp/Qs-resultaat
• Weergave van LV en RV slagvolumeresultaten van de korte asfunctieanalyse

Onderstreepte Qp- of Qs-waarden kunnen handmatig worden ingevoerd. Om te 
resetten verwijdert u de waarde en drukt u op enter op het toetsenbord.

De berekeningsmethode kan worden geselecteerd voor het volgende: 
• 1- Aortaregurgitatie en RF%
• 2- Mitralisregurgitatie en RF%
• 3- Longregurgitatie en RF%
• 4-Tricuspidalis regurgitatie en RF%

Onderstreepte regurgitatiewaarden kunnen handmatig worden ingevoerd. 
Om te resetten verwijdert u de waarde en drukt u op enter op het toetsenbord. 

1

2

3

4
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Bereken Qp/Qs

1. Om de geïntegreerde analysefunctie te gebruiken, selecteert u FLOW in de rapportagetabbladen, zoals weergegeven 
in Figuur 19.

FIGUUR 19. Tabbladen rapportage

Tabel 7:  Qp/Qs-selecties

OPMERKING: Als een bloedvatcategorie meer dan één meting heeft, wordt het gemiddelde gebruikt.

OPMERKING: Voor Qp of Qs kan de waarde worden verkregen uit een enkele of een combinatie van de selecties 
beschreven in de tabel.

Resultaat Selectie Beschrijving

Qp Stroomresultaat van de MPA-categorie. 

Qp
(Pediatrisch)

Stroomresultaat van LPA + RPA

Qs Stroomresultaat van de pAAo- of mAAO-categorie. Selecteer beide bloedvattypes om 
het resultaat van de Qs te berekenen. 

Qs Stroomresultaat van de LVOT-categorie.

Qs
(Pediatrisch) 

Stroomresultaat SVC + pDAo

Qs
(Pediatrisch)

Stroomresultaat SVC + IVC

Qs
(Pediatrisch)

Stroomresultaat SVC + dDAo

Qp/Qs = Resultaat is gebaseerd op de bovenstaande selecties.
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2. Controleer voordat u de geïntegreerde analyse gebruikt alle bloedvattoewijzingen en nauwkeurige contouren in alle 
categorieën.

• Als het bloedvat gesegmenteerd is in de onjuiste categorie, klikt u met de rechtermuisknop en gaat u naar de juiste 
categorie.

• Als het gesegmenteerde bloedvat het verkeerde bloedvat voor die categorie is, verwijder dan de actieve ROI en klik 

op .
• Als na het gebruik van automatische segmentatie het bloedvat niet correct is geïdentificeerd, voer dan handmatige 

segmentatie uit. Zie Voer automatische of handmatige segmentatie uit op pagina 87.

WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing en correcte categorietoewijzing 
van alle interessegebieden (ROI’s), inclusief de gebieden die zijn gegenereerd door 
voorbewerking.

3. Voor Qp selecteer .

4. Voor Qs selecteer  of  of beide bloedvatcategorieën (de waarden uit de twee categorieën worden 
berekend).

5. Het Qp/Qs-resultaat wordt berekend zoals weergegeven in Figuur 20.

FIGUUR 20. Resultaten Qp/Qs (volwassene afgebeeld)
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Bereken regurgiterend volume en regurgitante fractie (RF%)

1. Om de geïntegreerde analysefunctie te gebruiken, selecteert u FLOW in de rapportagetabbladen, zoals weergegeven 
in Figuur 21.

FIGUUR 21. Tabbladen rapportage

2. Controleer voordat u de geïntegreerde analyse gebruikt alle bloedvattoewijzingen en nauwkeurige contouren in alle 
categorieën.

• Als het bloedvat gesegmenteerd is in de onjuiste categorie, klikt u met de rechtermuisknop en gaat u naar de juiste 
categorie. 

• Als het gesegmenteerde bloedvat het verkeerde bloedvat voor die categorie is, verwijder dan de actieve ROI en klik 

op .
• Als na het gebruik van automatische segmentatie het bloedvat niet correct is geïdentificeerd, voer dan handmatige 

segmentatie uit. Zie Voer automatische of handmatige segmentatie uit op pagina 87.

Tabel 8:  Berekeningsmethoden voor regurgiterend volume

Selectie Kleptype Methodebeschrijving

Aorta Direct van stroomcurve (proximaal)

Aorta Direct van stroomcurve (mid)

Aorta
(Pediatrisch)

LVOT positieve stroomsnelheid – Qp

Mitralis Indirect 
(De gebruikte LVSV wordt verkregen op basis van resultaten van korte-asfuncties) 

Mitralis Indirect
(De gebruikte LVSV-waarde wordt verkregen uit resultaten van korte-asfuncties)

Long Direct van stroomcurve (MPA)

Long
(Pediatrisch)

Direct van stroomcurve 
LPA + RPA negatieve stroom 

Tricuspid Indirect
(De gebruikte RVSV wordt verkregen op basis van resultaten van korte-asfuncties)

Tricuspid Indirect
(De gebruikte RVSV wordt verkregen op basis van resultaten van korte-asfuncties)
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WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing en correcte categorietoewijzing 
van alle interessegebieden (ROI’s), inclusief de gebieden die zijn gegenereerd door 
voorbewerking.

3. Selecteer de berekeningsmodus. Zoals weergegeven in Figuur 22 wordt de aortaregurgitatie en regurgitatiefractie 

berekend door  te selecteren en de longregurgitatie en regurgitatiefractie wordt berekend door 

 te selecteren.

FIGUUR 22. Methodeselecties voor aorta en long (volwassene getoond)

4. Het regurgitante volume en RF% wordt berekend zoals weergegeven in Figuur 22. De gebruikte noemerwaarde is de 
LVSV voor aorta en mitralis, de RVSV voor tricuspidalis en long. Als u een andere waarde wilt invoeren, klikt u met 
de linkermuisknop op de driehoek en typt u een nieuwe waarde in het veld. Als u de oorspronkelijke waarde wilt 
herstellen, wist u het veld en drukt u op enter op het toetsenbord, zoals weergegeven in Figuur 23.

OPMERKING: Als de LVSV en RVSV niet beschikbaar zijn, wordt de RF% niet automatisch berekend. 

FIGUUR 23. RF-noemer



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      108

5. Als meer dan één berekeningsmethode is geselecteerd, worden de waarden gemiddeld voor het resultaat van het 
regurgiterend volume. 

6. Voor de berekening van mitralisregurgitatie en RF% moet er een Qp, Qs en aortaregurgitatiemethode geselecteerd 
zijn, zoals weergegeven in Figuur 24.

7. Voor de berekening van tricuspidalisregurgitatie en RF% moet er een Qp, Qs en een longregurgitatiemethode 
geselecteerd zijn, zoals weergegeven in Figuur 24.

8. Elk resultaat dat negatief is, wordt beschouwd als een ongeldig resultaat en wordt aangegeven door een gele 
driehoek, zoals weergegeven in Figuur 24. 

FIGUUR 24. Methodeselecties (volwassene getoond)
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Overzicht resultaten geïntegreerde analyse

Selecteer  om alle resultaten te controleren. 

OPMERKING: De selectie van de flow-eenheden bevindt zich bovenaan het paneel Geïntegreerde analyse, selecteer 
ml/slag of l/min.

OPMERKING: U kunt de resultaten indexeren naar BSA door de Index naar BSA te selecteren bovenaan het paneel 
Geïntegreerde analyse. Zowel de hoogte als het gewicht moeten worden ingevoerd in het tabblad 
Geschiedenis. 

FIGUUR 25. Geïntegreerde resultaten
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Myocardevaluatie 
De gebruiker is verantwoordelijk voor de juiste en volledige plaatsing van alle interessegebieden (ROI's), inclusief de gebieden die 
zijn gegenereerd of aangepast door de automatische segmentatiealgoritmen. De kwantitatieve waarden die door de software 
worden gegenereerd, zijn afhankelijk van de juiste en volledige plaatsing van deze interessegebieden en toegepaste drempelvoering.

De functie Voorverwerken van het onderzoek maakt de voorverwerking van late aankleuring mogelijk. Raadpleeg de 
gebruiksaanwijzing van suiteDXT NS-03-040-0014.

De analysetool Myocardevaluatie (ME) helpt bij het kwantitatief bepalen van gebieden met verschillende signaalsterktes 
binnen het myocard. 

Er zijn vier analyse-tabbladen beschikbaar:

• Late aankleuring – Bepaalt myocardiale segmenten met verhoogde en lage signaalintensiteit.
• T2 – Bepaalt myocardiale segmenten met verhoogde signaalintensiteit met behulp van beeldvormingstechnieken met 

zwart bloed.
• Signaaldifferentieel – Geeft de Salvage Mass-resultaten weer met behulp van zowel late aankleuring en T2-analyse als de 

T2-signaalintensiteitsverhouding (SI).
• Vroege aankleuring – Bepaalt de verhouding van de signaalintensiteit van het myocard en het percentage absolute 

myocardiale aankleuring met T1 gewogen beelden.

WAARSCHUWING: Na het voorverwerken is de gebruiker verantwoordelijk voor het beoordelen van de 
nauwkeurigheid van de gehele analyse en het aanbrengen van eventuele correcties. 
Een uitgebreide beoordeling moet inhouden:

- ROI-plaatsing/identificatie
- RV-inbrenglocatie
- Signaalintensiteitsdrempel

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch klinische 
interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is aan 
de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. Metingen 
dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

Analyse-tabbladen
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Definieer resultaatmetingslabels
De resultaatmetingslabels kunnen door de gebruiker worden gedefinieerd; het standaardlabel is Aankleuring.

1. Selecteer Tools > Voorkeuren > Bewerken.

2. Typ extra labels in de lege velden, zoals weergegeven in Figuur 1.

3. Selecteer het standaardlabel. 
Dit label wordt gebruikt voor alle nieuwe analyses. 

4. Klik op Save and Exit.

FIGUUR 1. Labels definiëren

Om het label op de meettabel te wijzigen, klikt u met de linkermuisknop op de pijl om een nieuw label te selecteren. 

FIGUUR 2. ME-meetlabels

Analyseprocedure late aankleuring

1. Selecteer .
2. Selecteer het tabblad Late aankleuring.
3. Selecteer de relevante korte-asserie.

4. Selecteer  om automatische segmentatie uit te voeren.
5. Bekijk alle endocardiale en epicardiale sporen, RV-insteekpunt en de drempelvoering op elke plak. 

Bewerk drempelvoering indien nodig.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      113

FIGUUR 3. Myocardevaluatieanalyse

1. Resultatentabel, 2. Selectie poolcoördinatendiagram, 3. Weergave poolcoördinaten, 4. Weergave resultatentabel, 5. Verwijder, 6. Poolcoördinaten

6. Om handmatige segmentatie uit te voeren, traceert u het LV-endocard op de meest basale plak door  te 
selecteren.

7. Geef het LV-epicard aan door  te selecteren.

8. Plaats het onderste RV-insteekpunt door  te selecteren. 
9. Plaats de cursor buiten het bewerkingsvenster om de ROI te voltooien.
10. Herhaal stap 6 - 9 tot de hele ventrikel is gesegmenteerd.
11. Bevestig de basale, midden en apicale classificatie. 

1

2 
3

5 

6

4
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Selectie drempelvoering

1. Selecteer het juiste drempelvoeringalgoritme in het vervolgkeuzemenu voor bestanden (Figuur 4).

FIGUUR 4. Selecteren drempelalgoritme

2. Klik indien nodig op  om de drempelvoeringwaarde voor die plak te maximaliseren. Klik op  om 
die waarde toe te passen op alle plakken. Gebruik de schuifbalk om het drempelalgoritme voor elke plak aan te 
passen, indien nodig.

3. Voor gemiddelde +2 tot +7 SD-resultaten plaatst u een normale ROI  in een normaal myocardium segment. 
Deze ROI wordt naar alle plakken gekopieerd als de Propageren Normaal ROI is aangevinkt.

Bewerking drempelvoering

1. Selecteer  om gebieden met een hoge signaalintensiteit toe te voegen. 

2. Selecteer  om gebieden met een lage signaalintensiteit toe te voegen.

3. Selecteer  kleine erasertool of  grote erasertool om beide signaalintensiteitsgebieden te verwijderen.

Poolcoördinaten weergaveformaten

De ME-analysetool heeft 2 indelingen voor poolcoördinaten: een 16-segmenten indeling en een concentrische indeling

Optie 1: Poolcoördinaten met 16 segmenten

1. Selecteer het tabblad 16-segmenten .

2. Selecteer 2 Gekleurd, 4 Gekleurd of Continu.

Kleurtoewijzingen kunnen worden gedefinieerd door op de kleurenschaalbalk te klikken.

Klik en sleep rechtstreeks naar de kleurverdeler om de percentagewaarden te wijzigen.
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FIGUUR 5. Poolcoördinaten

3.  Selecteer  om de Overzichtstabel poolcoördinaten weer te geven.

Optie 2: Plak-voor-plak-indeling

1. Selecteer het tabblad Concentrisch. 

FIGUUR 6. Tabblad Concentrisch

De tabblad Concentrisch biedt de voorkeuren die het formaat van de poolcoördinatendiagram veranderen in een 
plak-voor-plakindeling, waarin elke ring een plak vertegenwoordigt. Het aantal ringen wordt bepaald door het aantal 
geanalyseerde plakken.

2. Selecteer het aantal sectoren.

3. Controleer de subsectoren om de percentuele veranderingen van de ROI-massa binnen de sector te tonen.

Als de subsector wordt geselecteerd, wordt een effeningfunctie toegepast.

4. Vink het vakje naast Continu aan om de poolcoördinatendiagram te veranderen in procenten signaalsterkte en de 
waarden te kleuren in een continu spectrum van 0-100%.

Klik op  om contouren te wissen.

OPMERKING: De semiautomatische drempelvoering voor analyse van late aankleuring werkt optimaal op myocardiale 
evaluatiebeelden van hoge kwaliteit, zoals hieronder weergegeven (Afbeelding A). In afbeeldingen die 
zijn verkregen zonder signaal van de bloedpool (Afbeelding B) of onjuiste inversietijd, moet de 
drempelvoering subjectief worden ingesteld door de gebruiker. 

Poolcoördinaten met 2 kleuren Poolcoördinaten met 4 kleuren Poolcoördinaten met continue 
kleuren
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FIGUUR 7. Beelden myocardiale late aankleuring

T2-analyse
1. Selecteer het T2-tabblad.

2. Als de serie Late aankleuring eerder is geanalyseerd, kunnen de ROI's worden gekopieerd naar de T2-serie door 
kopiëren te selecteren (zie Figuur 8).

OPMERKING: Om ROI’s te kopiëren, is het vereist dat het aantal plakken overeenkomt voor elke serie om 
nauwkeurige resultaten te krijgen; als het aantal plakken niet overeenkomt, is de knop kopiëren niet 
beschikbaar. Het DICOM-importproces kan worden gebruikt om de juiste serie te maken die hetzelfde 
aantal plakken bevat. Acquisitieparameters, zoals matrix en FOV, moeten voor elke serie hetzelfde zijn 
voor de beste resultaten. Nadat voer een kopie uit, bekijk de ROI's zorgvuldig op alle plaklocaties en 
breng de juiste bewerkingen aan. 

FIGUUR 8. Kopieerknop
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3. Als er geen eerdere Late aankleuringsanalyse is, kunnen de ROI's handmatig worden gemaakt.

4. Geef het LV-endocard op de meest basale plak aan door  te selecteren.

5. Geef het LV-epicard aan door  te selecteren.

6. Markeer het onderste RV-insteekpunt door  te selecteren.

7. Plaats de cursor buiten het bewerkingsvenster om de ROI te voltooien.

8. Herhaal stap 4-7 tot de hele ventrikel is gesegmenteerd.

9. Om een 2 standaardafwijking drempelvoering uit te voeren, selecteert u Normale ROI toevoegen  en plaatst u 
een ROI in een normaal myocardiumsegment. Deze ROI wordt naar alle segmenten gekopieerd als de Propageren 
Normaal ROI is aangevinkt. Controleer elke plaklocatie en pas indien nodig de ROI aan.

OPMERKING: Wanneer de skeletspier ROI en Normale ROI worden verstrekt, voert de software de volgende 
berekening uit:
Genormaliseerde myocardiale T2 SI = SI myocardium/Sl skeletspier; 
Drempelvoeringberekening: drempelvoering = 2 * STD NORMAAL + AVG NORMAAL

10. Selecteer de eerste basale plak en gebruik het vervolgkeuzemenu voor plakclassificatie om Basis te selecteren. 
Bevestig de classificaties voor de resterende plakken. Gebruik de schuifbalk om het drempelalgoritme voor elke plak 
aan te passen, indien nodig.

11. Om T2-signaalintensiteitsanalyses uit te voeren, selecteert u de Toevoegen Skeletspierweefsel ROI  en plaatst u 
een ROI in de skeletspieren. Deze ROI wordt naar alle afbeeldingen gekopieerd. Controleer elke plaklocatie en pas 
indien nodig de ROI aan. 

OPMERKING: Zwartbloedbeelden kunnen onvoldoende stroomonderdrukking hebben, wat kan leiden tot een 
onnauwkeurige signaalintensiteitsanalyse en drempelvoering. Onvoldoende flowonderdrukking kan 
resulteren in een hoge signaalintensiteit die verward kan worden met myocardiaal oedeem. Artefacten 
met een lage signaalintensiteit kunnen een vals laag resultaat veroorzaken.

Bewerken

Selecteer  om gebieden met een hoge T2-signaalintensiteit toe te voegen.

Als u gebieden met een hoge T2-signaalintensiteit wilt verwijderen, selecteert u  kleine erasertool of  grote 
erasertool.

Klik op  om contouren te wissen.
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Gecombineerde analyse

Late aankleuring en T2

De gecombineerde-analysemodus maakt analyse naast elkaar mogelijk met bewerkingstools voor Late aankleuring en 
T2 (oedeem) afbeeldingen.

OPMERKING: Om de gecombineerde-analysemodus in te schakelen, moet de analyse van een late aankleuringsserie 
met korte assen eerst worden voltooid met behulp van het tabblad Late aankleuring. T2 (oedeem) 
afbeeldingen moeten aanwezig zijn in hetzelfde onderzoek. 

1. Selecteer .

2. Selecteer een geschikt onderzoek met zowel late aankleurings- als T2 (oedeem) afbeeldingen. Voltooi de 
analyseprocedure voor late aankleuring.

OPMERKING: Controleer de drempel voor elke plak met korte as op het tabblad Late aankleuring voordat u 
gecombineerde analysemodus selecteert. 

3. Selecteer het tabblad T2 en voltooi de analyseprocedure voor de T2-serie.
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4. Selecteer  om de gecombineerde analyse te starten, zoals weergegeven in Figuur 9.

FIGUUR 9. Gecombineerde analysemodus

5. Na selectie verschijnen de eerder geanalyseerde late aankleuringsseries in het modusweergavevenster. Dit venster 
wordt vervolgens een bewerkingsvenster voor de late aankleuringsafbeeldingen.

6. Gebruik voor het bewerken van de late aankleuringsafbeeldingen de bewerkingstools onder het kijkvenster zoals 
weergegeven in afbeelding 10.

OPMERKING: Bevestig alle updates van de resultaten rechtstreeks op het tabblad Late aankleuring.

OPMERKING: Als de LV-endocard of LV epicard ROI's zijn verwijderd, gaat u terug naar het tabblad Late aankleuring 
om ze te reconstrueren.

T2 (oedeem)
Late Aankleuring
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FIGUUR 10. Bewerkingstools voor late aankleuring

7. Gebruik voor het bewerken van de T2-serie (oedeem) aan de linkerkant de bewerkingstools boven het beeldvenster, 
zoals weergegeven in Figuur 11.

FIGUUR 11. T2 (oedeem) analysetools
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8. Gebruik de min- en plustoets om naar een ander plakniveau te navigeren voor de late aankleuringsseries, zoals weergegeven 
in Figuur 12.

• Locatie-informatie van plakken bevindt zich in de rechterbenedenhoek van elk kijkvenster.

OPMERKING: De plaklocatie die wordt weergegeven voor de late aankleuring wordt bepaald door de plaklocatie in het 
T2 (oedeem) bewerkingsvenster. Gebruik de min- en plustoets om deze selectie te overschrijven. 

FIGUUR 12. Plaknavigatie regelt late aankleuring

9. Gebruik de min- en plustoets onder het T2 (oedeem)-bewerkingsviewport om naar een ander plakniveau te navigeren 
voor zowel de Late aankleuring als de T2 (oedeem)-serie, zoals weergegeven in Figuur 13. 

OPMERKING: In de gecombineerde analysemodus zijn de plus- en mintoets op de linkerplaknavigatie links voor beide 
kijkvensters.

FIGUUR 13. Gecombineerde plaknavigatiebesturing

Plaklocatie Plaklocatie
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Signaaldifferentieelresultaten

Selecteer het tabblad Signaaldifferentieel

OPMERKING: Late aankleuring en T2-analyse moeten worden voltooid om de Salvage Mass-resultaten te verkrijgen. 
De T2-analyse moet worden voltooid met de plaatsing van de ROI van de skeletspier voor T2 
Signaalintensiteit (SI)-analyse.

OPMERKING: Als het T2-resultaat (oedeem) minder is dan het resultaat van de late verbetering (Infarct + MVO), zal 
het Salvage Mass-resultaat blanco zijn.

FIGUUR 14. Tabblad Signaaldifferentieel
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Analyse vroege aankleuring
Beelden vereist voor de analyse zijn een korte-asstapel met behulp van een gated spin-echo T1-sequentie, voor en na 
aankleuring. De analyse maakt handmatige segmentatie van het epicardium en endocardium op de initiële serie mogelijk 
met een kopieerfunctie. Een lokale ROI kan worden gebruikt om regio’s in het myocard te analyseren. 

OPMERKING: Zwartbloedbeelden kunnen onvoldoende stroomonderdrukking hebben, wat kan leiden tot een 
onnauwkeurige signaalintensiteitsanalyse en drempelvoering.

1. Selecteer het tabblad Vroege aankleuring.

2. Selecteer de relevante korte as T1-gewogen serie. 

3. Geef het LV-endocard op de meest basale plak aan door  te selecteren.

4. Geef het LV-epicard aan door  te selecteren.

5. Markeer het onderste RV-insteekpunt door  te selecteren.

6. Plaats de cursor buiten het bewerkingsvenster om de ROI te voltooien.

7. Herhaal stap 3-6 tot de hele ventrikel is gesegmenteerd. 

8. Voeg een ROI toe aan de skeletspier door  te selecteren.

9. Selecteer een basale plaklocatie. Klik op het vervolgkeuzemenu plakclassificatie en selecteer Base. 

10. Bevestig de basale, midden en apicale classificaties voor elke plak. 

11. Om een specifieke myocardiale regio te analyseren, selecteer  en traceer een ROI in het myocard.
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FIGUUR 15. Selectie plakclassificatie en serietype

12. Selecteer het serietype van Pre. 
Als de serie Early Post als eerste werd gesegmenteerd, selecteert u Early Post.

13. Selecteer het juiste korte as T1 gewogen Early Post-serietype. 
Als de serie Early Post als eerste werd gesegmenteerd, selecteert u de Pre-serie.

14. Selecteer Kopiëren.

15. Controleer alle endocardiale en epicardiale sporen, RV-insteekpunt en plaatsing van skeletspieren en bewerk indien 
nodig.

16. ROI’s kunnen alleen worden gekopieerd wanneer alle ROI’s en RV-plaatsing, plakclassificatie, serietype (stappen 3-12) 
zijn voltooid op de geselecteerde serie.

OPMERKING: Als een Endocardiale of Epicardiale contour wordt verwijderd, gebruikt u Ongedaan maken.

OPMERKING: De skelet ROI kan worden aangepast op elke plaklocatie. Indien verwijderd, moet de analyse opnieuw 
worden uitgevoerd. 

17. Klik op  en selecteer ALL: Vroege aankleuring om alle analyses te verwijderen.

OPMERKING: Om ROI’s te kopiëren, is het vereist dat het aantal plakken overeenkomt voor elke serie om 
nauwkeurige resultaten te krijgen; als het aantal plakken niet overeenkomt, is de knop kopiëren niet 
beschikbaar. Het DICOM-importproces kan worden gebruikt om de juiste serie te maken die hetzelfde 
aantal plakken bevat.

OPMERKING: Registratieparameters, zoals matrix en FOV, moeten voor elke serie hetzelfde zijn voor de beste 
resultaten. Controleer na het uitvoeren van een kopie de ROI’s zorgvuldig op alle plaklocaties en breng 
de juiste bewerkingen aan.

Locale ROI tool
1. Selecteer de relevante Voorkleuring korte as T1-gewogen serie. 

2. Traceer een lokale ROI in de specifieke myocardregio door  te selecteren.

3. Voeg een ROI toe aan de skeletspier door  te selecteren.

4. Selecteer de juiste plakclassificatie en het serietype zoals weergegeven in Figuur 16.

FIGUUR 16. Selectie plakclassificatie en serietype
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5. Selecteer het juiste korte as T1 gewogen Early Post-serietype.

6. Selecteer Kopiëren. 

7. Klik op  en selecteer ALL: Vroege aankleuring om alle analyses te verwijderen.
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T1-mappinganalyse
Deze functie maakt de signaalkwantificering van de longitudinale spinrooster-relaxatietijd (T1) mogelijk. De applicatie 
ondersteunt T1-analyse voor zowel originele (niet-aangekleurde) afbeeldingen als afbeeldingen na aankleuring en de 
berekening van de extracellulaire volumefractie (ECV).

Vereiste afbeeldingen: Herstelafbeeldingen voor inversie of verzadiging met verschillende inversietijden (TI) of inline 
maps. Series waarop beweging gecorrigeerd is worden aanbevolen voor analyse. Representatieve plaklocaties voor de 
linkerventrikelbasis, midden en apex worden aanbevolen.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing van alle interessegebieden (ROI’s), 
inclusief de gebieden die zijn gegenereerd door automatische segmentatie.

OPMERKING: Om de voorkeuren voor T1-mapping in te stellen, selecteert u Tools > Voorkeuren > Bewerken. 
Selecteer het tabblad T1/T2-mapping.

OPMERKING: Het wordt aanbevolen de Auto serie samenstellen voor analyse in te stellen in voorkeuren voor uw 
scannertype. De analyse vereist dat alle plaklocaties aanwezig zijn in de serie. Selecteer Tools > 
Voorkeuren > Bewerken. Selecteer het tabblad T1/T2-mapping.
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FIGUUR 1. T1-mappinginterface

1. Automatische segmentatie, 2. T1-resultaten, 3. Invoer van hematocriet, 4. Volgorde typeselectie, 5. Selectie kleurenkaartoverlay, 
6. Kleurenkaartopties, 7. Geef sectoroverlay weer, 8. Propagatie bewerken, 9. Curve of poolcoördinaten met 16 segmenten, 10. T1-curves 

Analyse uitvoeren

1. Selecteer .
2. Selecteer de relevante T1-mappingserie.
3. De kleurenkaart wordt automatisch weergegeven als de voorkeur voor overlay is geselecteerd.
4. Om een andere kleurschaal te selecteren, gebruikt u het vervolgkeuzemenu voor bestanden.

5. Selecteer  om een globaal T1-resultaat te creëren.

6. Bekijk alle endocardiale en epicardiale sporen, RV-insteekpunt en plaatsing van de bloedpool.

7. Bewerk onnauwkeurige contouren.

9

3

4

1

2

5
6

7 8

10



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      128

8. Om een enkele inversietijd te wijzigen, vinkt u  uit.

9. Bevestig plakclassificatie voor elke plaklocatie en elk serietype.

OPMERKING: Als een stapel van korte-asafbeeldingen wordt gesegmenteerd, worden het T1-resultaat voor de basis, 
mid of apex en de poolcoördinatensectoren met 16 segmenten gemiddeld genomen op basis van de 
plakclassificatie. Het resultaat van de bloedpool T1 wordt niet gemiddeld.

10. Om de ECV te berekenen, voert u automatische segmentatie uit op zowel de Native- als de Post-serie.

11. Bekijk alle endocardiale en epicardiale sporen, RV-insteekpunt en plaatsing van de bloedpool op beide series.

12. Om een segment van het myocard te meten, selecteer .

OPMERKING: Als een lokale ROI wordt gebruikt om de ECV te berekenen, moet er een lokale ROI en een ROI van de 
bloedpool zijn voor zowel Native als Post.

OPMERKING: Er kunnen maximaal vijf lokale ROI-metingen worden gemaakt op een afbeelding voor Basis, Midden en 
Apex.

13. Selecteer  om een bloedpool ROI te plaatsen, indien nodig. 

14. Voer de Hematocriet-waarde (HCT) in.

15. Het ECV-resultaat (%) wordt weergegeven in de resultatentabel.

16. Handmatige segmentatie kan worden uitgevoerd. 

• Geef het LV-epicard aan door  te selecteren.

• Geef het LV-epicard aan door  te selecteren.

• Markeer het RV-insteekpunt door  te selecteren.

• Als de ECV berekend moet worden, plaats dan de ROI van de bloedpool door  te selecteren.

• Bevestig plakclassificatie voor elke plaklocatie en elk serietype.

Referentie: Wong. et al., „Association Between Extracellular Matrix Expansion Quantified by Cardiovascular Magnetic 
Resonance and Short-Term Mortality.” Circulatie (2012):126:1206-1216.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      129

Polaire kaart met 16 segmenten
OPMERKING: ECV-poolcoördinaten vereist dat de ECV-analyse is voltooid.

1. Voltooi de globale T1-analyse voor de tabbladen Basis, Midden en Apex.

2. Bevestig het RV-insteekpunt voor elke plaklocatie. 

3. Bevestig de juiste plakclassificatie en het juiste serietype.

4. Selecteer de poolcoördinaten met 16-segmenten .

5. Selecteer  om de sectoroverlay direct op het beeld weer te geven.

6. Selecteer grafieken  om terug te keren naar de T1-curven.

Indeling T1-resultaatwaarden

Resultaat DICOM-afbeeldingen Mapafbeeldingen

Globaal gemiddeld +/- std gemiddeld +/- std

Basis/midden/apex waarde +/- fout gemiddeld +/- std

Lokale ROI’s waarde +/- fout gemiddeld +/- std

Lokaal gemiddeld +/- std gemiddeld +/- std

Bloedpool waarde +/- fout gemiddeld +/- std
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Contouren verwijderen

Klik op  op de interface om ALLE contouren van de geselecteerde serie te verwijderen.

Klik met de linkermuisknop op een contour gevolgd door een klik met de rechtermuisknop om een enkele contour te 

verwijderen of selecteer  om contouren op alle tijdpunten te verwijderen.

De T1-curven controleren 
1. De resultaten van de curveaanpassing tonen het signaalgedrag van de beeldgegevens. In geval van beeldartefacten als 

gevolg van verkeerde registratie, ademhalingsartefacten of aritmieën is de curveaanpassing mogelijk niet optimaal.

2. Een signaalintensiteitspunt kan uit de berekening worden geëlimineerd door direct op het punt in de grafiek te klikken 
en de contour te selecteren op de afbeelding die paars wordt.

3. Selecteer verwijderen met de rechtermuisknop (klikken en ingedrukt houden) of selecteer de delete-knop op het 
toetsenbord.

WAARSCHUWING: De resultaten van de T1-curveaanpassing moeten worden beoordeeld door een goed 
opgeleide en gekwalificeerde gebruiker. 

Referentie: *Messroghli DR et al. „Modified Look-Locker Inversion Recovery (MOLLI) for High Resolution T1 Mapping of 
the Heart.” Magnetic Resonance in Medicine (2004) 52: 141-146. 

Resultaat Vergelijkingsreferentie Type aanpassing

T1 Look-Locker 
(MOLLI) 

y=A-B exp(-t/T1*) Niet-lineaire curveaanpassing met een 
Levenberg-Marquardt-algoritme*
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T2-mappinganalyse
Deze functie maakt de signaalkwantificering van de T2-relaxatietijd mogelijk. T2-mapping is een 
weefselkarakteriseringstechniek.

Vereiste afbeeldingen: T2-voorbereidingsvolgorde met een stabiele vrije precessie uitlezing met verschillende echotijden 
(TE) of inline maps. Representatieve plaklocaties voor de linkerventrikelbasis, midden en apex worden aanbevolen.

De berekening voor de T2-vervalcurve is: y = a exp(-TE/T2*) + c

Er zijn 2 correctiemethoden voor aanpassing – een aanpassing met 2 parameters waarbij de achtergrondruis c wordt 
berekend met behulp van een op histogrammen gebaseerd algoritme en afgetrokken van de signaalintensiteit, waarna 
een niet-lineaire aanpassing wordt uitgevoerd. De aanpassing met 3 parameters maakt gebruik van een niet-lineaire 
benadering.

OPMERKING: Ernstige afbeeldingsomloop kan ertoe leiden dat de ruisberekening mislukt voor de aanpassing van 
2 parameters. Het is belangrijk om beelden te analyseren die geen faseomloop hebben.

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
kwantificeerbare resultaten op. Het gebruiken en plaatsen van kwantitatieve metingen is 
aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde diagnoses. 
Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd personeel.

WAARSCHUWING: De gebruiker is verantwoordelijk voor de juiste plaatsing van alle interessegebieden (ROI’s), 
inclusief de gebieden die zijn gegenereerd door automatische segmentatie.

OPMERKING: Om de voorkeuren voor T2-mapping in te stellen, selecteert u Tools > Voorkeuren > Bewerken. 
Selecteer het tabblad T1/T2-mapping.

OPMERKING: Het wordt aanbevolen de Auto serie samenstellen voor analyse in te stellen in voorkeuren voor uw 
scannertype. De analyse vereist dat alle plaklocaties aanwezig zijn in de serie. Selecteer Tools > 
Voorkeuren > Bewerken. Selecteer het tabblad T1/T2-mapping.
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FIGUUR 1. T2-mappinginterface

1. Automatische segmentatie, 2. T2-resultaten, 3. Selectie parameteraanpassing, 4. Selectie kleurenkaartoverlay, 5. Kleurenkaartopties 
6. Geef sectoroverlay weer, 7. Propagatie bewerken, 8. Curve of poolcoördinaten met 16 segmenten, 9. T2-curves 

Analyse uitvoeren

1. Selecteer .
2. Selecteer de relevante T2-mappingserie. 
3. Selecteer voor correctie van de aanpassing, een aanpassing met twee parameters of een aanpassing met drie 

parameters.
4. Stel indien gewenst de voorkeur in voor het automatisch weergeven van de kleurmap.
5. Gebruik het vervolgkeuzemenu voor bestanden om een andere kleurschaal te selecteren.

6. Maak een globaal T2-resultaat aan door  te selecteren.
7. Bekijk alle endocardiale en epicardiale sporen en het RV-insteekpunt.

8. Bewerk onnauwkeurige contouren.
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9. Om een enkele echotijd te wijzigen, vinkt u  uit.

10. Bevestig plakclassificatie voor elke plaklocatie en elk serietype.

OPMERKING:  Als een stapel van korte-asafbeeldingen wordt gesegmenteerd, worden het T2-resultaat voor de basis, 
mid of apex en de poolcoördinatensectoren met 16 segmenten gemiddeld genomen op basis van de 
plakclassificatie.

11. Om een segment van het myocard te meten, selecteer .

OPMERKING: Er kunnen maximaal vijf lokale ROI-metingen worden gemaakt op een afbeelding voor Basis, Midden en 
Apex.

12. Handmatige segmentatie kan worden uitgevoerd. 

• Geef het LV-epicard aan door  te selecteren.

• Geef het LV-epicard aan door  te selecteren.

• Markeer het RV-insteekpunt door  te selecteren.

• Bevestig de plakclassificatie voor elke plaklocatie.

Polaire kaart met 16 segmenten
1. Voltooi de globale T2-analyse voor Basis, Midden en Apex. 

2. Bevestig het RV-insteekpunt voor elke plaklocatie.

3. Bevestig de juiste plakclassificatie.

4. Selecteer de poolcoördinaten met 16-segmenten .
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5. Selecteer  om de sectoroverlay direct op het beeld weer te geven.

6. Selecteer grafieken  om terug te keren naar de T2-curven.

Indeling T2-resultaatwaarden

Contouren verwijderen

Klik op  op de interface om ALLE contouren van de geselecteerde serie te verwijderen.

Klik met de linkermuisknop op een contour gevolgd door een klik met de rechtermuisknop om een enkele contour te 

verwijderen of selecteer  om contouren op alle tijdpunten te verwijderen.

De T2-curven controleren 
1. De resultaten van de curveaanpassing tonen het signaalgedrag van de beeldgegevens. In geval van beeldartefacten 

als gevolg van omloop, verkeerde registratie, ademhalingsartefacten of aritmieën is de curveaanpassing mogelijk niet 
optimaal.

2. Een signaalintensiteitspunt kan uit de berekening worden geëlimineerd door direct op het punt in de grafiek te klikken 
en de contour te selecteren op de afbeelding die paars wordt.

3. Selecteer verwijderen met de rechtermuisknop (klikken en ingedrukt houden) of selecteer de delete-knop op het 
toetsenbord.

WAARSCHUWING: De resultaten van de T2-curveaanpassing moeten worden beoordeeld door een goed 
opgeleide en gekwalificeerde gebruiker. 

Resultaat DICOM-afbeeldingen Mapafbeeldingen

Globaal gemiddeld +/- std gemiddeld +/- std

Basis/midden/apex waarde +/- fout gemiddeld +/- std

Lokale ROI’s waarde +/- fout gemiddeld +/- std

Lokaal gemiddeld +/- std gemiddeld +/- std
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Myocardiale perfusie 

Met de analysemodus voor myocardiale perfusie kan de gebruiker myocardialeperfusiebeelden bekijken en analyseren.

OPMERKING: Semi-kwantitatieve analyse wordt ondersteund. Als een serie met dubbele reeks beschikbaar is, kan een 
functie voor schaduwcorrectie worden toegepast. 

VOORZICHTIG: Parameters van helling en relatieve helling zijn mogelijk niet nauwkeurig op beelden waarop 
schaduwcorrectie niet is uitgevoerd. 

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
klinische interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve 
metingen is aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde 
diagnoses. Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd 
personeel.

FIGUUR 1. Interface myocardialeperfusieanalyse
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Tabel 1:  Analysetools

Propageer alle plakken en alle fasen.

Propageer alle fasen; enkele plak.

Voer autosegmentatie uit.

Analyse opnieuw berekenen na bewerking (alleen als automatische segmentatie is 
uitgevoerd).

Contouren kopiëren/plakken over alle fasen. 

Analyse opnieuw berekenen na bewerking (alleen als kopiëren/plakken is uitgevoerd).

Schaduwcorrectie toegepast, alleen beschikbaar voor een serie met dubbele reeksen.

Kleurenoverlay van segment weergeven.

Geen overlay weergeven.

Pixelgewijze kleurenoverlay weergeven voor berekende parameter.

Grafiekweergave.

Geef grafieken van stress en rust weer.

Tabel met parameterresultaten weergeven.

Selectie van poolcoördinaten met 16 segmenten of concentrisch.

Kleurselectie poolcoördinaten met 2 kleuren, 4 kleuren of continue kleuren.

Selecties uit concentrische poolcoördinaten.
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Voer myocardialeperfusieanalyse uit

1. Selecteer .

2. Selecteer het tabblad voor Stress of Rust. 

   

3. Selecteer de myocardialeperfusieserie.

4. Selecteer  om berekening Automatische Segmentatie en analyse uit te voeren.

5. Controleer alle endocardiale en epicardiale sporen, RV-insteekpunt op elk segment en bewerk indien nodig.

6. Bevestig de basale, midden en apicale classificatie.

7. Als u handmatige segmentatie wilt uitvoeren, kies dan ervoor  om de endocardiale contour op een enkele 
plak of alle plakjes te tekenen.

8. Selecteer  om de epicardiale contour op een enkele plak of alle plakjes te tekenen.

9. Selecteer  om de contouren naar alle fasen te kopiëren/plakken.

10. Plaats het onderste RV-insteekpunt door  te selecteren.

11. Controleer alle endocardiale en epicardiale sporen, RV-insteekpunt op elk segment en bewerk indien nodig.

12. Bevestig de basale, midden en apicale classificatie.

13. Selecteer om de begin- en eindfase te kiezen.

14. Klik op  om de startfase toe te wijzen en klik vervolgens rechtstreeks op de cel in de matrix. 

15. Klik op  om de eindfase toe te wijzen en klik vervolgens rechtstreeks op de cel in de matrix.
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Contouren wijzigen

Wanneer een bewerking wordt uitgevoerd, moet de analyse opnieuw worden berekend. Het bewerkingswaarschuwings-

symbool verschijnt. Klik op  om de herberekening uit te voeren.

Resultaten controleren: poolcoördinaten met 16 segmenten
1. Selecteren om de berekende parameters te controleren in het vervolgkeuzemenu voor bestanden. Zie Figuur 2.

Door de cursor op een segment op het polaire diagram te plaatsen, wordt de bijbehorende grafiek voor dat 
segment gemarkeerd.

FIGUUR 2. Vervolgkeuzemenu Berekende Parameters

Grafiek-/Tabelresultaten controleren
1. Selecteren om grafiekresultaten te bekijken in het vervolgkeuzemenu voor bestanden, Figuur 3, linksonder in de 

grafiekweergave.

2. Klik op  om de grafieken weer te geven.

Door de cursor direct op een gekleurd segment op de afbeelding te plaatsen, wanneer de segmentkleuroverlay 
op de afbeelding wordt weergegeven, wordt de bijbehorende grafiek voor dat segment gemarkeerd.

3. Klik op  om de parameterresultaten weer te geven.

FIGUUR 3. Grafiekresultaten
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Relatieve Helling (RU) en Reserve-Index (RI) berekenen

1. Selecteer  en plaats een ROI in de bloedpool op het basale plakniveau.

2. Om de bloedpoel ROI te verwijderen, klikt u met de rechtermuisknop en selecteer 

OPMERKING: Voor de berekening van de gereserveerde index moet zowel Stress- als Rustanalyse aanwezig zijn.

VOORZICHTIG: Resultaatparameters myocardiale perfusie van helling en relatieve helling zijn mogelijk niet 
nauwkeurig op beelden waarop schaduwcorrectie niet is uitgevoerd. 
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Definitie van parameters berekend uit de myocardialeperfusiecurve 
    

 

Aankomsttijd tijd (in seconden) van het snijpunt van de basislijn en de helling

Piektijd tijd (in seconden) waarvan de signaalintensiteit het maximum bereikt 

SI-Ratio SI (piektijd – basislijn)/basislijn

Helling De helling wordt berekend door de gewogen lineaire aanpassing met behulp van punten 
tussen aankomsttijd en piektijd

Relatieve Helling RU = helling van de hartspier/helling van de bloedpool

Reserve-index De myocardiale reserve-index (RU) wordt gedefinieerd als:
                    RI = RU STRESS/RU RUST

Signaalintensiteit

Helling

Aankleuring

Baseline

Aankomsttijd Piektijd
Tijd
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Patent Foramen Ovale (PFO)-analyse 

Met de PFO-analysetool kunnen, om een vroege piek aan te tonen, curves worden gemaakt waarin signaal tegen tijd 
wordt afgezet, zodat een PFO kan worden opgespoord. 

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
klinische interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve 
metingen is aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde 
diagnoses. Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd 
personeel.

Start PFO

1. Selecteer Bestand > Analyse selecteren > PFO.

 

2. Selecteer een realtime-serie.
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FIGUUR 1. PFO Analysevenster

1. PFO bewerkbare tabbladen, 2. Actieve ROI's, 3. Wissen, 4. Start- en eindfase, 5. Signaalintensiteit versus fasecurve, 6. PFO Analyse-iconen

Atriumanatomie selecteren

Selecteer een beeld waarbij de anatomie van het linkeratrium (LA) en het rechteratrium (RA) kan worden gewaardeerd. 

Genereer intensiteitscurve linkeratrium (LA)

1. Teken de curve door  te selecteren. 

2. Teken een contour op de RA in het Beeldbewerkingsvenster. 

3. Zet de cursor buiten het Beeldbewerkingsvenster.

4. Een LA-intensiteitcurve maken.

De signaalintensiteitcurve voor de LA wordt automatisch aangemaakt.

Genereer intensiteitscurve rechteratrium (RA)

1. Maak de RA-intensiteitcurve op de hierboven beschreven wijze voor een LA-intensiteitcurve met behulp van .

De curven worden over elkaar weergegeven in het curveresultatenvenster.

OPMERKING: Als er bijvoorbeeld een ROI op fase 1 is geplaatst en de startfase is gewijzigd, blijft de door de gebruiker 
getekende ROI aanwezig op de oorspronkelijke afbeelding waar de ROI's zijn geplaatst.

1
3

5

6

2

4
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FIGUUR 2. PFO-curveresultaten

Bekijk curve-gegevens en selecteer fasebereik

1. Bekijk de curven in het rapportvenster en pas de startfase en eindfase aan.

2. Selecteer met de pijltjes omhoog en omlaag de startfase en eindfase om het fasebereik in te stellen voor een curve.

Het wijzigen van de start- en eindfasen heeft invloed op de weergave van de PFO-curven.

Door te klikken op een punt in het diagram, wordt de in het Beeldbewerkingsvenster getoonde fase geüpdate.

FIGUUR 3. Start- en eindfasescherm

OPMERKING: Als er voor een serie twee acquisities plaatsvinden, kunt u de start- en eindfase voor de eerste instellen, 
de LA- en RA-ROI's tekenen (zodat curven automatisch worden aangemaakt) en dan deze werkwijze 
herhalen op een andere PFO-tab voor de tweede set afbeeldingen. Alle PFO-tablabels zijn te wijzigen.

Contouren wijzigen

Het wijzigen van meerdere fasen op een enkele plaklocatie:

1. Selecteer de schijflocatie

2. Selecteren 

3. Selecteer de eerste fase van de te wijzigen reeks fasen.
4. Houd de shift-toets ingedrukt en selecteer de laatste fase van de te wijzigen reeks.

De geselecteerde thumbnails worden nu rood omlijst.
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5. Wijzig de contour in het Beeldbewerkingsvenster.
6. Deselecteer de contour door buiten de geselecteerde contour op de afbeelding te klikken of door de cursor buiten 

het bewerkingsvenster te verplaatsen.

ROI-bewerking kan worden geregeld door het bereik in te stellen.

Selecteer de juiste scoopfunctie in de beeldweergave.

 Scope Alles – Past ROI-bewerkingen toe op alle fasen.

 Scope Huidige tot einde – Past ROI-bewerkingen toe vanaf de huidige fase tot het einde.

 Scope Alleen huidige – Past alleen ROI-bewerkingen toe op de huidige fase.

Contouren verwijderen

Klik op  om ALLE contouren te wissen.

Klik met de linkermuisknop op een beeld en selecteer vervolgens met de rechtermuisknop  om contouren op alle 
tijdspunten te verwijderen.

Beoordelen eindresultaten curve

Uit de contouren wordt een diagram aangemaakt waarin pixelintensiteit wordt afgezet tegen tijd. Klik met de 

rechtermuisknop op  om naar het rapport te verzenden.



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      146

T2Star

De T2*-analysetool berekent de T2*-waarden van weefsel uit een multi-echo snelle gradiënt echosequentie.

De T2*-curve is een grafiek van de signaalsterkte versus echotijd met een exponentiële vervalcurveformule. 
Het T2*-pasalgoritme is gebaseerd op het niet-lineaire kleinste-kwadratenalgoritme van Levenberg-Marquardt.

De berekening van de T2*-vervalcurve is: y = a *exp(-TE/T2*) + c

 Waar:

WAARSCHUWING: De applicatie helpt alleen bij de analyse van de afbeeldingen en levert niet automatisch 
klinische interpretatie van de resultaten op. Het gebruiken en plaatsen van kwantitatieve 
metingen is aan de gebruiker. Onnauwkeurige metingen kunnen leiden tot verkeerde 
diagnoses. Metingen dienen alleen te worden verricht door goed opgeleid en gekwalificeerd 
personeel.

Tabel 1:  

y de signaalsterkte is op het moment TE

a de dwarse magnetisatie op tijdstip 0 (nul) is

TE de echotijd is

T2* de vervalconstante is en

c de achtergrondruis is
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Hartanalyseprocedure
FIGUUR 1. T2*-analyse-interface

1. Selecteer . 

2. Selecteer de relevante serie.

3. Selecteer de korte-asplak in het miniaturenpaneel.

4. Geef met behulp van  een contour aan dat het kamertussenschot omsluit.

De T2* en R2* worden berekend en worden weergegeven in de tabel resultaten.

De waarde van R2 wordt berekend en weergegeven in de grafiek.
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Een myocard kleurmap maken

1. Teken met behulp van  een contour om de endocardrand.

2. Teken met behulp van  een contour om de epicardrand. 

De T2*-/R2*-kleurmap wordt over de afbeelding geplaatst. 

3. De van R2* kleurmapwaarde kan worden gewijzigd.

OPMERKING: Het standaardbereik voor 1,5T-afbeeldingen is 5 ms - 500 ms voor T2*. Het standaardbereik voor 
3,0T-afbeeldingen is 2,5 ms - 1.000 ms voor T2*. 

4. Klik en sleep omhoog of omlaag op pijltjes om het dynamische kleurbereik voor de kleurmap bij te stellen. 

De kleuroverlay op de Image Editor verandert dynamisch.

De Hz- en ms-waarden veranderen eveneens dynamisch.

5. De T2*- en R2*-waarden kunnen worden bepaald door de  te selecteren en over de kleurmapoverlay op de 
afbeelding te plaatsen.

Parameters aanpassen

Selecteer ofwel de 2 Parameter of de 3 Parameter Fit voor de T2*-vervalcurve. 

FIGUUR 2. Parameteraanpassing

De aanpassing van 2 parameters wordt algemeen aanvaard op basis van peer review literatuur [1]. In dit model wordt de 
achtergrondruis, c, berekend met behulp van een op histogrammen gebaseerd algoritme en afgetrokken van de 
signaalintensiteit, waarna een niet-lineaire aanpassing wordt uitgevoerd.

De aanpassing met 3 parameters is ook beschikbaar, zoals te lezen in wetenschappelijke literatuur [2]. Dit model is een 
niet-lineaire benadering die rechtstreeks op basis van het oorspronkelijke inputsignaal werkt.

Voor beide modellen wordt de initiële T2*-waarde geschat met behulp van een proef lineaire aanpassing.

1. D.J Pennell, et al. „Cardiovascular T2-star (T2Star) magnetic resonance for the early diagnosis of myocardial iron 
overload,” Eur Heart J 2001; 22: 2171-2179.

2. Ghugre NR, et al. „Improved R2* Measurements in Myocardial Iron Overload,” Journal of Magnetic Resonance 
Imaging 2006; 23: 9-16.
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De T2*-resultaten controleren
1. Controleer de contourpositie op alle afbeeldingen. 

2. De tabel toont de afzonderlijke T2*/R2*-metingen en berekent bovendien een gemiddelde.

OPMERKING: De T2*-curve is een grafiek van de signaalsterkte versus echotijd met een exponentiële 
vervalcurveformule. Soms kan het nodig zijn om latere echopunten uit de vervalcurve te verwijderen 
voor een betere curveaanpassing. Dit kan gebeuren in extreme gevallen van ijzeroverbelasting wanneer 
de signaalintensiteit zeer laag kan zijn.

Om een enkele contour uit een afbeelding te verwijderen

1. Klik met de linkermuisknop om de contour, die paars wordt, te selecteren.

2. Gebruik de rechtermuisknop om de prullenbak te selecteren of gebruik de Delete-toets op het toetsenbord om een 
contour te verwijderen.

• De contour wordt verwijderd en de curveaanpassing wordt opnieuw berekend.

FIGUUR 3. T2*-curve

WAARSCHUWING: De resultaten van de T2*-curveaanpassing moeten worden beoordeeld door een goed 
opgeleide en gekwalificeerde gebruiker.

De factor 1000 wordt gebruikt omdat de T2 en T2* in eenheden van milliseconden (ms) worden weergegeven en R2 en 
R2* zijn Hertz (of s-1).

Tabel 2:  R2*-/T2*-conversies

Resultaat Eenheid Conversie

R2* Hz R2*=1000/T2*

T2* ms T2*=1000/R2*
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3D/4D Flow Viewer
Biedt interactieve schuine herformattering van 3D- en 4D-stroombeelden. Er zijn tools beschikbaar voor het maken van 
2D-fasecontrastbeelden en 2D-functiebeelden van 4D die kunnen worden geanalyseerd. Inline-stroomanalyse kan 
worden uitgevoerd. 

OPMERKING: Een 3D-serie met isometrische voxels en overlappende plakken verbetert de kwaliteit van de 
geherformatteerde beelden.

OPMERKING: De 3D/4D Flow Viewer geeft een 4D-serie alleen weer als u voor 4D een licentie heeft.

OPMERKING: Als zowel 2D-fasecontrast als inline 4D-stroomanalyse zijn uitgevoerd, zijn alle resultaten beschikbaar in 
de stroomanalysemodus. 

VOORZICHTIG: 3D-afbeeldingen of geherformatteerde afbeeldingen bieden alleen aanvullende informatie bij 
het formuleren van een diagnose en moeten altijd worden gebruikt in combinatie met 
conventionele beeldvormingstechnieken.

WAARSCHUWING: Correleer een 3D-herformattering altijd met de originele acquisitiegegevens.

WAARSCHUWING: De instellingen voor vensterbreedte en niveau (WW/WL) kunnen het uiterlijk van 
verschillende pathologieën en het vermogen om andere anatomische structuren te 
onderscheiden, beïnvloeden. Onjuiste WW/WL-instellingen kunnen ertoe leiden dat de 
beeldgegevens niet worden weergegeven. Verschillende WW/WL-instellingen kunnen nodig 
zijn om alle beeldgegevens te bekijken.
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Interfacecomponenten 3D/4D Flow Viewer

FIGUUR 1. Weergavecontroletools en kijkvensters

Beeldcontroletools

3D-kijkvenster Axiaal kijkvenster

Schuin kijkvenster 1 Schuin kijkvenster 2
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Tabel 1:  Beeldcontroletools

Tool Beschrijving
Dradenkruiscursor – Synchroniseert de navigatie tussen alle 
kijkvensters. 

Richtingsknoppen – Veranderen het beeldvlak in de 3D en schuine 
kijkvensters.

S = Superior (Hoger)
I = Inferior (Lager)
A = Anterior (Voorste) 
P = Posterior (Achterste) 
L = Links
R = Rechts 
Schuine modus – Toont het vlak van de schuine herformattering en 
het loodrechte snijpunt om de gewenste anatomie weer te geven. 

Dubbele schuine modus – Toont drie schuine vlakken gedefinieerd 
door drie instelbare kleurassen – blauw, geel, groen. Pas een 
willekeurige as aan om de twee andere schuine vlakken bij te 
werken. 

3D-weergavemodus – Biedt beeldweergavemodi in het 
3D-kijkvenster

Oppervlak 
MIP = maximale intensiteitsprojectie (standaard)
MINIP = minimale intensiteitsprojectie 

Stroomlijnen – Visualiseer 3D-snelheidsvelden in een specifieke 
tijdsfase.

Kleuroverlay – Schakelt de kleuroverlay in/uit. Alleen beschikbaar 
voor 4D Flow-afbeeldingen.

Fase – Schakelt tussen de afbeeldingsweergave van grootte en fase.
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Snelheidsbereik – Past de kleurtoewijzing van de stroomrichting 
aan. 
Alleen beschikbaar voor 4D Flow-afbeeldingen.
De kleurenbalklegenda voor het snelheidsbereik wordt aan de 
rechterkant van elk kijkvenster weergegeven. De waarde is een 
schatting.
Dekking – Regelt de kleurdekking op de afbeelding om de 
visualisatie van de onderliggende anatomie te verbeteren. Alleen 
beschikbaar voor 4D Flow-afbeeldingen. 

Cine – Regelt frames per seconde en definieert het begin- en 
eindframe van de film. Alleen beschikbaar voor 3D-tijdgeresolveerde 
magnitude- en 4D Flow-afbeeldingen. Gebruik de spatiebalk op het 
toetsenbord om film af te spelen of te pauzeren.

Save Series – Maakt conventionele 2D-functionele afbeeldingen 
of een serie stroomafbeeldingen voor analyse of nabewerkte 
MIP-afbeeldingen. Gebruiken om het aantal plakken, de plakdikte, 
de tussenruimte en het beeldveld in te voeren. Deze parameters 
zijn in de linkerbovenhoek van elk kijkvenster geannoteerd. Gebruik 
Ctrl + T om in/uit te schakelen.

Alleen magnitude – Maakt een magnitudeserie van enkele of 
meerdere plakjes met meerdere fasen van de originele 
afbeeldingen voor gebruik bij functieanalyse.

Magnitude en fase – Maakt een magnitude- en faseserie van enkele 
of meerdere plakjes met meerdere fasen van de originele 
afbeeldingen voor gebruik bij stroomanalyse. Deze optie is alleen 
beschikbaar wanneer een 4D Flow-serie is geselecteerd. (Er wordt 
ook een dubbele serie gemaakt die automatisch in fase wordt 
gecorrigeerd.)

Nabewerkt – Creëert projectiebeelden met maximale intensiteit 
van 3D-beelden. Wanneer er 4D Flow-gegevens aanwezig zijn, 
worden voor de beoordeling series van enkele of meerdere plakken 
in meerdere fasen met kleuroverlay op de afbeeldingen gemaakt. 

Allemaal nabewerkt – Slaat alle geformatteerde beelden op vanuit 
elk kijkvenster.
Opslaan – Slaat alle afbeeldingsreeksen die door de seriedefinitie 
zijn gemaakt, op in de lokale database. 

Rx-planning – Definieert de gewenste scanvlakas gemaakt door 
seriedefinitie. 

Tabel 1:  Beeldcontroletools

Tool Beschrijving
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Bladeren en indikken – Wijzigt de dikte van de MIP-afbeelding en 
bladert door de afbeeldingenset. 

1 = klik en sleep beide zijknoppen om de dikte van de 
MIP-afbeelding te wijzigen
2 = klik en sleep de schuifregelaar om door de afbeeldingenset te 
bladeren. 

Besturingselementen bevinden zich aan de rechterkant van het 
geselecteerde kijkvenster.

Lineair – Verstrekte afmeting van de afstand van een rechte lijn. 
Klik precies op de afmeting en klik vervolgens met de 
rechtermuisknop om te Verwijderen, Lokaliseren of Labelen.

3D-Roteren – Kantelt of roteert de afbeeldingen in het 
3D-kijkvenster en/of de schuine kijkvensters 1 en 2. Klik met de 
linkermuisknop en sleep rechtstreeks in het kijkvenster om te 
kantelen of roteren. 

Stroomrichting – Geeft het loodrechte vlak weer in de schuine 
kijkvensters 1 en 2. Klik met de linkermuisknop rechtstreeks op 
het relevante lichaamsdeel om deze functie te gebruiken. Alleen 
beschikbaar voor 4D Flow-afbeeldingen.
Venster/Niveau – Beschikbaar in alle kijkvensters.

Zwenken – Beschikbaar in alle kijkvensters.

Inzoomen – Beschikbaar in alle kijkvensters.

Roteren – Beschikbaar voor het 3D-kijkvenster, kijkvenster 1 en 
kijkvenster 2.

Tabel 1:  Beeldcontroletools

Tool Beschrijving
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Indeling van 3D/4D Flow Viewer en output van seriecreatie

Afhankelijk van het type afbeeldingsreeksen dat is geselecteerd voor herformattering, wordt het type beeldvorming samengevat in 
de onderstaande tabel. 

Resetten – Beschikbaar in alle kijkvensters.

Parameters scannen – Beschikbaar in alle kijkvensters.

Tabel 2:  Sneltoets

Functie Actie
Doelcursor Druk op de Shift-toets en verplaats de draadkruiscursor 

naar het gewenste lichaamsdeel.

Tabel 3:  3D/4D Flow Viewer indelingen en output

3D/4D Flow Viewer-indeling 3D-afbeeldingenserie-uitvoer 4D Flow-afbeeldingenserie-uitvoer

3D-weergave (kijkvenster linksboven) Nabewerkt Nabewerkt
Axiaal (kijkvenster rechtsboven) Alleen omvang

Nabewerkt (MIP)

Alleen omvang*, omvang en fase* en 
nabewerkt (kleuroverlay)*

Schuin 1 (kijkvenster linksonder) Alleen omvang

Nabewerkt (MIP)

Alleen omvang*, omvang en fase* en 
nabewerkt (kleuroverlay)*

Schuin 2 (kijkvenster rechtsonder) Alleen omvang

Nabewerkt (MIP)

Alleen omvang*, omvang en fase* en 
nabewerkt (kleuroverlay)*

*Dit serietype kan worden gebruikt voor conventionele analyse in suiteHEART® Software
Voor elke omvang- en faseserie wordt een duplicaatserie gemaakt die automatisch in fase wordt gecorrigeerd.

Tabel 1:  Beeldcontroletools

Tool Beschrijving
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Werkstroomvoorbeeld: Maak MIP-afbeeldingen van een 3D-afbeeldingenserie

1. Selecteer het juiste onderzoek en start de suiteHEART® Software.

2. Selecteer .

3. Selecteer de juiste 3D-serie in het keuzemenu serienavigatie. Het geselecteerde afbeeldingstype wordt op de knop 
aangegeven, zoals weergegeven in Figuur 2.

FIGUUR 2. Serienavigatie

4. Selecteer  en klik op het gewenste kijkvenster. Het actieve kijkvenster wordt rood gemarkeerd. De lijnen voor 
opnieuw formatteren verschijnen zoals weergegeven in Figuur 3. 

FIGUUR 3. Dubbele schuine modus
 

5. Klik op de ononderbroken lijn, klik met de linkermuisknop en sleep en kantel de lijn om de gewenste anatomie weer 
te geven. 

a.) Klik op het gewenste kijkvenster om op te slaan. 
b.) Pas de MIP-dikte aan met behulp van de bedieningselementen aan de rechterkant van het kijkvenster. 
c.) Voltooi de invoergegevens voor seriedefinitie, zoals weergegeven in figuur 4. 
d.) Klik op de knop Opslaan om de MIP-afbeelding op te slaan in de lokale database.
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FIGUUR 4. Seriedefinitie

6. Maak een stapel MIP-afbeeldingen door  te selecteren.

OPMERKING: Het maximale aantal nabewerkte MIP-afbeeldingen dat kan worden gemaakt, is 512.

7. Klik op het kijkvenster dat als referentieafbeelding moet worden gebruikt en definieer een stapel batchafbeeldingen, 
zoals weergegeven in Figuur 5.

a.) Vergroot het plakbereik.
b.) Pas de hoek aan en pijlen geven de richting van de plak aan.
c.) Verplaats de Rx.

FIGUUR 5. Rx-planning

8. Voer de seriedefinitie-opties in en klik op  om de stapel afbeeldingen in de lokale database op te slaan. 

9. Om de gemaakte serie te bekijken, schakelt u over naar de functieanalysemodus, selecteert u de beoordelingsmodus 
en klikt u op Vernieuwen. 

1. Selecteer Nabewerkt
2. Klik op Opslaan

b

a a

c
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Werkstroomvoorbeeld: Maak een 2D-serie voor analyse

Voor het creëren van conventionele 2D-fasecontrast of 2D-functionele afbeeldingen is een 4D Flow-serie vereist met 
zowel tijd-opgeloste magnitudeconventies als stroomconventies van R/L, A/P en S/I. 

Series gemaakt als magnitude alleen of magnitude en fase uit 4D flow-beelden zijn een geldige conventionele 2D-serie die 
kan worden gebruikt in functie- of stroomanalyse.

Series die zijn gemaakt als nabewerkingen van 4D Flow hebben een overlay met kleurenstromen.

1. Selecteer het juiste onderzoek en start de suiteHEART® Software.

2. Selecteer .

3. Selecteer de juiste 4D-serie in het keuzemenu Serienavigatie, zoals weergegeven in Figuur 6. Het geselecteerde 
afbeeldingstype wordt op de knop aangegeven, zoals weergegeven in Figuur 6.

FIGUUR 6. Serienavigatie

4. Selecteer  en klik op het gewenste kijkvenster. Het actieve kijkvenster wordt rood gemarkeerd. De gele lijnen 
voor opnieuw formatteren verschijnen zoals weergegeven in Figuur 7.

FIGUUR 7. Schuine modus 4D herformatteren

5. Klik op de ononderbroken gele lijn, klik met de linkermuisknop en sleep en kantel de lijn om het gewenste 
lichaamsdeel weer te geven. 

a.) Klik op het gewenste kijkvenster om op te slaan en selecteer de modus Magnitude en fase om een 2D-fasecontraserie te 
maken of selecteer Magnitude om een functionele serie te maken. 

b.) Pas de plakdikte aan met behulp van de bedieningselementen aan de rechterkant van het kijkvenster. 
c.) Voltooi de invoergegevens van de seriedefinitie, zoals weergegeven in figuur 8, en klik op de knop Opslaan om de serie op te 

slaan in de lokale database.
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FIGUUR 8. Seriedefinitie en opslaan

6. Selecteer  om een stapel met meerdere plakken uit meerdere fasen te maken.

OPMERKING: Het maximale aantal afbeeldingen uit meerdere fasen dat kan worden gemaakt, is 32. 

OPMERKING: Bij het opslaan van magnitude- en faseseries heeft de tweede serie automatische basislijncorrectie 
toegepast. De serie krijgt het label „gecorrigeerd”, zoals weergegeven in Figuur 9. 

FIGUUR 9. Voorbeeld van serie met gecorrigeerde auto faseverschuivingsfout

1. Selecteer Magnitude en Fase

2. Klik op Opslaan
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7. Klik op het kijkvenster dat als referentieafbeelding moet worden gebruikt en definieer een stapel batchafbeeldingen, 
zoals weergegeven in Figuur 10.

FIGUUR 10. Rx-planning

8. Selecteer de seriedefinitie-opties in en klik op  om de stapel afbeeldingen in de lokale database op te slaan. 

9. Om de gemaakte serie te analyseren, schakelt u over naar de juiste analysemodus en klikt u op Vernieuwen. 

Werkstroomvoorbeeld: Maak een Stroommeting 

Voor gedetailleerde informatie over de interfacetools voor stroomanalyse, zie Stroomanalyse op pagina 84.

1. Selecteer het tabblad Analyse.

2. Lokaliseer het betreffende bloedvat. Alleen anatomie van de aorta of de longvaten wordt ondersteund voor de 

autosegmentatie zoals weergegeven. Klik op de  om een stroomcurve te genereren.
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FIGUUR 11. Voorbeeld Aorta en Longvaten

WAARSCHUWING:  De gebruiker is verantwoordelijk voor de juiste plaatsing en correcte categorietoewijzingen 
van alle interessegebieden (ROI’s), inclusief de gebieden die zijn gegenereerd door 
voorbewerking.

3. Lokaliseer voor handmatige segmentatie het betreffende bloedvat en klik op de  zoals getoond in Figuur 12.

Er zijn zes ROI’s beschikbaar, genummerd 1 - 6. De kleurcode is hetzelfde in de analyseweergave, afbeeldingkijkvensters 
en diagrammen.

4. Creëer een contour rond een bloedvat door 4 punten rond het betreffende bloedvat te plaatsen.

5. Klik op  voor segmentatie over alle fasen.

FIGUUR 12. Handmatige ROI-plaatsing
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Voer correctie van snelheidsaliasing uit

Versleep de schuifregelknop om phase unwrapping uit te voeren om te corrigeren voor snelheidsaliasing. Het effect van 
de wijziging wordt direct op het fasebeeld bijgewerkt en de resultaten worden direct in de stroomdiagram weergegeven. 
Om elk van de drie snelheidsgecodeerde afbeeldingen langs de drie orthogonale (x, y, z) richtingen te controleren, moet u 
een keuze maken in het vervolgkeuzemenu zoals getoond in Figuur 13.

FIGUUR 13.
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Gestructureerd rapporteren

Rapportinhoud definiëren
De metingen en diagrammen in de rapporten worden opgesteld op basis van de resultaten van de analysemodi. 
Elk afzonderlijk analyseresultaat kan worden geselecteerd voor opname in het rapport.

Vooraf gedefinieerde klinische indrukken en technieken stroomlijnen zelfgedefinieerde rapporten. Zie ook paragraaf 
Tabblad Indruk op pagina 165 voor procedurele details over het aanmaken van klinische indrukken en technieken. 
Met Rapportvoorkeuren kunt u site-informatie invoegen die als koptekst in het rapport verschijnt.

Gestructureerde rapportweergave
De gestructureerde rapportweergave helpt bij het aanmaken van klinische rapporten. Er zijn vier tabbladen:

• Geschiedenis
• Indruk
• Afbeeldingen
• Poolcoördinaten

Elke parameter is gekoppeld aan een selectievakschakelaar . Klik op het selectievakje om de parameter in het 
rapport op te nemen of eruit te laten.

OPMERKING: Afdrukselecties kunnen worden geconfigureerd op het tabblad Afdrukvoorkeuren onder Tools > 
Voorkeuren > Wijzigen Afdrukken.

Tabblad geschiedenis

Het tabblad Geschiedenis bevat patiëntinformatie uit de DICOM-titel. Bij het wijzigen van informatie wordt het veld 
gemarkeerd.

OPMERKING: Gewijzigde patiëntinformatie heeft alleen invloed op het rapport. De DICOM-titel blijft intact.
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FIGUUR 1. Tabblad Geschiedenis

1. DICOM-titelinformatie, 2. BSA-selectie, 3. Patiëntgeschiedenis, 4. Opmerkingen 

Het BSA-berekeningstype kan worden geselecteerd door met de rechtermuisknop op de omgekeerde driehoek te klikken.

Referentie: http://halls.md/formula-body-surface-area-bsa/

BSA-berekeningsmethode Formule

DuBois en DuBois BSA (m2) = 0,20247 x Hoogte (m) 0,725 x Gewicht (kg) 0,425

Mosteller BSA (m2) = SQRT ([Hoogte (cm) x Gewicht (kg)]/3600)
BSA (m2) = SQRT ([Hoogte (inch) x Gewicht (pond)]/3131)

Gehan en George BSA (m2) = 0,0235 x Hoogte (cm) 0,42246 x Gewicht (kg) 0,51456

Haycock BSA (m2) = 0,024265 x Hoogte (cm) 0,3964 x Gewicht (kg) 0,5378

Boyd BSA (m2) = 0,0003207 x Hoogte (cm) 0,3 x Gewicht (gram) (0,7285 - (0,0188 x LOG (gram))

1

2

3

4
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Tekstvakken voor Geschiedenis en Opmerkingen

Voer in het veld Geschiedenis alle informatie in die relevant is voor de patiëntgeschiedenis of selecteer de juiste macro. 
Het deelvenster Notities geeft de notities weer die door de gebruiker zijn ingevoerd tijdens de analyse, maar zijn niet 
beschikbaar voor opname in het rapport.

Tabblad Indruk 

FIGUUR 2. Tabblad Indrukken

                                1. Indruk, 2. Techniek

Indruk 

Voer informatie over indrukken in door in het tekstvakje te typen en/of te klikken op een indrukkenmacrotoets.

Vooraf gedefinieerde indrukkenmacro's bevinden zich op toetsen onder het Indrukkenpaneel. 

OPMERKING: Alle geschikte analyses moeten worden uitgevoerd voordat resultaatberekeningen worden gemaakt 
met macro's.

Techniek 

Voer techniekinformatie in door in het tekstvakje te typen en/of te klikken op een techniekmacrotoets.

Vooraf gedefinieerde techniekmacro's bevinden zich op toetsen onder het Techniekpaneel. 

OPMERKING: Alle geschikte analyses moeten worden uitgevoerd voordat resultaatberekeningen worden gemaakt 
met macro's.

1

2
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Tabblad afbeeldingen 

FIGUUR 3. Tabblad Afbeeldingen 

                                          1. Grafieken/Tabellen, 2. Afbeeldingen voor het rapport

2

1
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Diagrammen en overzichtstabellen voor het rapport controleren

Het paneel Diagrammen bekijken bevat alle diagrammen en overzichtstabellenresultaten die zijn opgenomen in het 
rapport tijdens de analyse.

1. Ga met behulp van de -iconen door elke diagram en overzichtstabel.

2. Klik in het witte tekstvak om een bijschrift voor een grafiek of samenvattende tabel toe te voegen voor het afgedrukte 
rapport. 

3. Als  is ingeschakeld, wordt de grafiek of tabel in het rapport opgenomen.

4. Klik op  om een grafiek of tabel te verwijderen.

Afbeeldingen controleren

Het Afbeeldingenpaneel bevat alle afbeeldingen die tijdens de analyse naar het rapport zijn gestuurd.

OPMERKING: Multiplak-afbeeldingen kunnen naar het rapport worden verzonden. Selecteer vanuit de menubalk Image 
Viewer Tools > Voorkeuren > Bewerken. Vink de optie Multiplak-afbeeldingen naar rapport aan. Klik in 

de controlestand met de rechtermuisknop op ; de cine-stand moet worden gepauzeerd.

1. Ga met behulp van het -pictogram door elke afbeelding.

2. Klik in het witte tekstvak om een bijschrift voor een afbeelding toe te voegen voor het afgedrukte rapport. 

3. Selecteer de afbeeldingsgrootte door de kleinformaat-  of grootformaat  -toetsen te kiezen.

4. Afbeeldingen in het afbeeldingspaneel kunnen opnieuw worden gerangschikt door op de afbeelding te klikken en 
deze naar een ander kijkvenster te slepen.

5. Klik met de rechtermuisknop op een afbeelding om toegang te krijgen tot de hulpmiddelen voor het bewerken van 
afbeeldingen.

6. Klik met de rechtermuisknop op de afbeelding en selecteer de knop  lokaliseren om de reeks te vinden waaruit 
de afbeelding afkomstig is.

7. Als  is ingeschakeld, wordt de afbeelding in het rapport opgenomen.

8. Verwijder een afbeelding door  te selecteren.

OPMERKING: Als een onderzoek wordt geopend dat is geanalyseerd vanuit een eerdere softwareversie (2.1.0 of 
lager), kunnen afbeeldingen die eerder toegevoegd zijn aan de rapportweergave niet worden 
gemanipuleerd met behulp van de hulpmiddelen voor het bewerken van afbeeldingen. Nieuwe 
toegevoegde afbeeldingen kunnen worden gemanipuleerd zoals verwacht.
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Tabblad poolcoördinaten
Deze tabel maakt de identificatie mogelijk van functionele, myocardevaluatie en afwijkingen van myocardiale perfusie 
kwalitatief in een poolcoördinatenformaat. Als u de kleurcodering van de segmenten wilt wijzigen, klikt u met de 
rechtermuisknop op de kleurlegenda's van het segment om het kleurenpalet te openen.

FIGUUR 4. Tabblad Poolcoördinaten

Poolcoördinaten toevoegen aan rapport

Als u extra Poolcoördinaten aan het rapport wilt toevoegen, klikt u op  en selecteert u het type poolcoördinaten in 

het vervolgkeuzemenu voor bestanden. 
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Kleuren per segment selecteren

Klik op het kleurvak naast de gewenste terminologie om de afwijking te beschrijven. De cursor verandert in een penseel. 
Klik vervolgens op het segment direct op het poolcoördinaat om de kleur in te stellen. 

Kleuren selecteren voor alle segmenten

Klik met de rechtermuisknop buiten de omtrek van het poolcoördinaat in de hoeken en maak de gewenste selectie uit 
de lijst. 

FIGUUR 5. Selectie voor functie

Coördinaten van 16 of 17 segmenten

Selecteer het juiste keuzerondje links van het poolcoördinaat.

De titel van het poolcoördinaat bewerken

De typetitel van elke polaire plot kan worden bewerkt door in het invoerveld te klikken.

FIGUUR 6. Bewerk het invoerveld voor de titel van het poolcoördinaat

Een poolcoördinaat verwijderen

Elke plot kan van het tabblad worden verwijderd door op de knop  te klikken. Schakel het selectievakje uit om het 
poolcoördinaat uit te sluiten van het rapport. 

FIGUUR 7. Sluit het poolcoördinaat uit van het rapport

Selecteer  om het poolcoördinaat terug te zetten naar standaard.
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Het rapport vooraf bekijken  

1. Selecteer Bestand > Voorbeeldrapport of selecteer  rechtsonder.

2. Controleer het rapport om ervoor te zorgen dat alle gewenste analyseresultaten en gestructureerde informatie is 
opgenomen.

3. Selecteer  om het rapport op te slaan op de lokale harde schijf. 

Met het keuzemenu Opslaan kunnen de bestemming, naam en formaatopties van het rapport worden 
gedefinieerd.

OPMERKING: De naam van het rapportbestand kan worden geconfigureerd in Voorkeuren. Zie Selecties voor 
Rapportvoorkeuren op pagina 30.

BELANGRIJK: Waarden die in rood worden weergegeven, vallen buiten het bereik, wat niet duidelijk zal zijn als het 
rapport op een zwart-witprinter wordt afgedrukt. 

FIGUUR 8. Opslaan-venster

4. Selecteer Afdrukken om het rapport af te drukken.

WAARSCHUWING: Het rapport moet voor goedkeuring en distributie worden gecontroleerd om ervoor te 
zorgen dat de inhoud overeenstemt met de analyse. Onjuiste rapportinhoud kan leiden tot 
een vertraagde of verkeerde diagnose. Analyse en interpretatie dient te worden uitgevoerd 
door goed opgeleid en gekwalificeerd personeel.
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Het onderzoek goedkeuren 
De applicatie bevat een functie om rapporten goed te keuren en af te sluiten. Het goedgekeurde rapport wordt 
opgeslagen en kan worden bekeken maar niet veranderd.

OPMERKING: Voorwaarden: De gebruiker moet een geautoriseerde rapportondertekenaar zijn. Zie Bevoegden om 
rapporten goed te keuren op pagina 31.

OPMERKING: De knop „Goedgekeurd onderzoek” en het menu worden pas ingeschakeld als er een actie op een 
afbeelding is uitgevoerd. 

1. Selecteer Onderzoek goedkeuren of selecteer Bestand > Onderzoek goedkeuren.

FIGUUR 9. Venster Onderzoek goedkeuren

2. Voer, indien gewenst, een beschrijving van de ondertekening in.

3. Selecteer uw naam in het keuzemenu Naam.

4. Typ uw wachtwoord.

5. Klik op Goedkeuren om te bevestigen en het venster te sluiten. Klik op Annuleren om het venster te sluiten zonder de 
ondertekenprocedure te voltooien.

Met behulp van de gegeven beschrijving wordt een serie gemaakt.

OPMERKING: Wanneer een goedgekeurd onderzoek is uitgevoerd, krijgt het rapport de datum- en tijdstempel.
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Exportopties
1. Selecteer Tools > Exporteren > Rapporteren aan DICOM.

Een secundaire opname (SCPT) wordt gemaakt en opgeslagen in de serielijst.

2. Selecteer Tools > Exporteren > Rapport naar Excel.
Exporteert een rapport als een Excel-bestand.

3. Selecteer Tools > Exporteren > Rapport exporteren naar XML.
Exporteert een rapport als een XML-bestand.

4. Selecteer Tools > Exporteren > Afbeeldingen naar DICOM.
Een secundaire opname (SCPT) wordt gemaakt en opgeslagen in de serie.

5. Selecteer Tools > Exporteren > Rapporteren naar...
Exporteert resultaten naar rapportagesysteem van derden.

6. Selecteer Tools > Exporteren > Afbeeldingen naar JPEG, AVI, enz.
Het pop-upvenster Cine opslaan wordt weergegeven.

7. Selecteer Tools > Exporteren > Gegevens naar Matlab (alleen licentie).
Exporteert een Mat-bestand in binaire vorm.

FIGUUR 10. Venster Film opslaan

1. Selecteer de te exporteren bestandstypen.

2. Blader naar de locatie waar u het bestand (de bestanden) wilt opslaan.

3. Klik op Opslaan om het exporteren te starten en het venster te sluiten. De actueel bekeken serie is het enige bestand 
dat wordt geëxporteerd.

OPMERKING: Bij het exporteren van gegevens naar AVI- of MOV-bestanden stelt suiteHEART® Software de maximale 
framesnelheid per seconde in op 20 frames per seconde, ongeacht de instellingen die worden gebruikt 
voor het bekijken binnen de applicatie.

OPMERKING: Als u een aangepaste serie met zowel meerfasige als eenfasige afbeeldingen exporteert als een .avi- of 
.mov-bestand, zorg er dan voor dat een kijkvenster met een meerfasige afbeelding is geselecteerd 
voordat u exporteert.
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Een goedgekeurd onderzoek beoordelen 
1. Select Bestand > Goedgekeurd onderzoek laden. 

Nu wordt het venster Goedgekeurd onderzoek selecteren getoond. Alle goedgekeurde onderzoeken betrekking 
hebbende op het onderzoek worden in de lijst weergegeven.

FIGUUR 11. Venster Selectie goedgekeurde onderzoeken

2. Selecteer de serie in de lijst.

3. Klik op Laden om het goedgekeurde onderzoek en de bijbehorende analyse te laden en te tonen. 
• Een goedgekeurd onderzoek kan alleen worden bekeken.
• Een nieuw onderzoek kan worden aangemaakt op basis van een goedgekeurd onderzoek door dat te wijzigen en de 

veranderingen in een nieuw onderzoek op te slaan. Het nieuwe onderzoek wordt opgeslagen als een secundaire-
opnameserie.

OPMERKING: Als een goedgekeurd onderzoek en analyse wordt geladen, wordt de informatie in de actuele 
analysesessie overgeschreven.

OPMERKING: Bij het herstellen van examens die zijn geanalyseerd met eerdere versies van suiteHEART® Software en 
als een „Load Approved Exam” (Goedgekeurd onderzoek laden) is uitgevoerd, heeft het rapport niet de 
naam van de goedkeurder of de datum- en tijdstempel. Het wordt aanbevolen om alle analyses te 
controleren en alle resultaten te bevestigen voordat het rapport opnieuw wordt uitgegeven.
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Rapportdatabase

Met de tool rapportdatabase kunt u zoeken in de inhoud van eerder goedgekeurde rapporten. Een rapport wordt pas in 
de rapportdatabase opgenomen als het is goedgekeurd.

Procedure tool rapportdatabase
1. Selecteer Tools > Rapportdatabase.

Selecteer Zoekcriteria

2. Selecteer de juiste sjabloon voor de zoekopdracht uit het keuzemenu Sjabloon zoeken.

3. Selecteer de zoekopdracht uit het keuzemenu Geschiedenis. De actuele opdrachtbalk toont uw geselecteerde 
waarden.

FIGUUR 1. Zoekopties

OPMERKING: Maak als de gewenste zoekopdracht nog niet bestaat een nieuwe.

Een zoekopdracht maken
1. Selecteer New rechts van de geschiedenisbalk, zoals weergegeven in Figuur 1. 

Nu worden de maak-zoekopdrachtpanelen getoond in het Rapportdatabasevenster.
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FIGUUR 2. Paneel zoekopdracht database

1. Zoekopdracht-operators, 2. Zoekopdracht operanden, 3. Tabbladen zoekopdrachtanalyse, 4. Zoekopdrachtgroep, 5. Zoekopdrachtvelden, 
6. Zoekopdrachtregels, 7. Zoekopdrachtopties, 8. Toets voor uitvoeren, 9. Toets zoekopdracht toevoegen, 10. Toets nieuwe zoekopdracht

2. Selecteer het tabblad zoekopdrachtcategorie uit Onderzoek, Functie, ME, T2 Ster, T1 Mapping en T2 Mapping. 
De zoekopdrachtgroepen en -velden worden navenant bijgewerkt.

3. Selecteer de zoekopdrachtgroep.

4. Selecteer het zoekopdrachtveld.

OPMERKING: De rapportdatabase kan geen zoekopdracht uitvoeren op zelfgedefinieerde metingen.

5. Selecteer de operator om de zoekopdrachtparameters te definiëren.

6. Voer de operand(en) in om waarden te geven voor de zoekparameters.

7. Selecteer Toevoegen om de zoekopdrachtwaarden te tonen in het Regels-paneel. Tijdens een enkele zoekactie 
kunnen meerdere zoekopdrachten worden uitgevoerd. Herhaal stappen 1-7 voor elke extra regel.

De Niet-toets zal een zoekwaarde tenietdoen.

De Of-toets zal meerdere zoekopdrachten koppelen terwijl de zoekopdracht wordt afgerond met een van de 
zoekopdrachten. De Of-functie geldt voor de zoekopdrachtregel boven de selectie.

De Verwijderen-toets biedt de mogelijkheid een zoekopdrachtregel te selecteren en verwijderen.

1 2
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De zoekactie activeren
1. Selecteer Starten om in de database te zoeken.

De resultaten worden getoond in het gebied Resultaat zoekopdracht. De zoekopdrachtwaarden die de zoekactie 
afronden worden getoond in de meest rechtse kolom van het resultatenvenster.

FIGUUR 3. Venster zoekopdrachtresultaten

1. Geschiedenisbalk, 2. Zoekopdrachtresultaten, 3. Knop Lijst afdrukken, 4. Knop rapporten afdrukken, 5. Knop Lijst exporteren, 6. Verwijderen-knop

OPMERKING: Nieuwe zoekopdrachtresultaten worden alleen aangemaakt op basis van een unieke combinatie van 
onderzoekidentificatienummer, onderzoeksdatum, geautoriseerde ondertekening en rapportsjabloon. 
Als een duplicaat van deze velden wordt gevonden, wordt het oude rapport vervangen door het nieuwe.

Resultaten bekijken
1. Dubbelklik om een rapport te bekijken op een ingang in het gebied Zoekopdrachtresultaten. 

Nu opent een nieuw venster met het geselecteerde rapport. Ga als er meerdere rapporten beschikbaar zijn met 
behulp van Volgend rapport en Vorig rapport van het ene naar het andere rapport. Klik op de marker Venster 

sluiten  om het rapportcontrolevenster te sluiten.

1

2 3
4

5
6
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FIGUUR 4. Rapportviewer

2. Gebruik de selectieopties in het Wijzigenmenu om de geselecteerde resultaten aan te passen:

Edit (Wijzigen) > Select All (Alles selecteren) selecteert alle zoekresultaten.

Edit (Wijzigen) > Clear Selection (Selectie verwijderen) deselecteert alle zoekresultaten.

Edit (Wijzigen) > Invert Selection (Omgekeerde selectie) keert de selectie van de zoekresultaten om.

Edit (Wijzigen) > Clear History (Geschiedenis verwijderen) verwijdert de lijst van vorige zoekopdrachten.

3. Selecteer Print List (Lijst afdrukken) om een lijst van zoekopdrachten naar de printer te sturen.

4. Selecteer Print Reports (Rapport afdrukken) om de geselecteerde rapporten naar de printer te sturen.

5. Selecteer Export List (Lijst exporteren) om de lijst op te slaan als een html-bestand.

6. Selecteer Delete (Verwijderen) om het (de) geselecteerde rapport(en) uit de rapportdatabase te verwijderen.
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Een zoekopdracht opslaan
1. Selecteer Favorites (Favorieten) > Add to Favorites (Aan favorieten toevoegen). 

2. Typ in het tekstveld Add to Favorites (Aan favorieten toevoegen) een label voor de zoekopdracht en klik op OK.

FIGUUR 5. Favorietenmenu

FIGUUR 6. Keuzemenu favorieten



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      179

Een favoriet verwijderen
1. Selecteer Favorites (Favorieten) > Manage Favorites (Favorietenbeheer) in het rapportdatabasevenster.

FIGUUR 7. Venster favorietenbeheer

2. Selecteer het favoriet item.

Nu wordt de hele zoekopdrachtformule in het resultatenvenster weergegeven.

3. Klik op Delete (Verwijderen).

Een bevestiging zal uw te verwijderen selectie bekrachtigen. Selecteer Yes (Ja).

4. Selecteer Close (Sluiten).
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Zoekresultaten exporteren naar een HTML-
bestand
1. Selecteer Export List (Lijst exporteren) rechts van het rapportdatabasevenster. 

FIGUUR 8. Exportvenster

2. Selecteer de map waarnaar u de lijst wilt exporteren.

3. Selecteer OK.
• Een pop-upvenster vraagt of de rapporten moeten worden opgenomen.
• De lijst en rapporten worden naar een HTML-bestand geëxporteerd. 

De database exporteren
Naarmate de database groter wordt, is het raadzaam om de gegevens te archiveren.

1. Selecteer File (Bestand) > Export (Exporteren) in de menubalk Rapportdatabase.

2. Selecteer de map waarnaar u de lijst wilt exporteren.

3. Selecteer OK. De database wordt geëxporteerd naar het externe-opslagapparaat.
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Een database importeren
De database kan worden geïmporteerd vanaf een andere pc waarnaar deze is geëxporteerd. 

1. Selecteer File (Bestand) > Import (Importeren). 

FIGUUR 9. Importvenster

2. Selecteer de map waaruit u de database wilt importeren.

3. De geïmporteerde database wordt samengevoegd met de bestaande. 
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Tabletmodus
suiteHEART® Software wordt ondersteund op tablets met een 64-bits processor die draait op het besturingssysteem 
Windows 10 Professional of Windows 10 Enterprise. Lees het volgende gedeelte voor het gebruik van suiteHEART® 
Software op een tablet.

De tabletmodus inschakelen

1. Selecteer vanuit de Image View menubalk Tools > Preferences > Edit. 

2. Selecteer het tabblad Globaal. 

3. Vink het selectievakje Tabletmodus aan onder Algemeen. 

4. Op de rapportweergave is een toetsenbordpictogram actief, zoals weergegeven in Figuur 1.
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FIGUUR 1. Toetsenbord aan-/uitzetten

5. Wanneer een tekstveld wordt gebruikt, verschijnt een virtueel toetsenbord.
Het virtuele toetsenbord kan op de interface worden verplaatst.

6. Wanneer een selectie wordt gemaakt buiten een tekstgebied, wordt het toetsenbord gesloten.

7. Klik op  om het virtuele toetsenbord handmatig te activeren. Klik op  om het te sluiten.

Beeldmanipulatietools

Als u de beeldmanipulatietools op een tablet wilt gebruiken, drukt u met een stylus of, als er een muis is aangesloten, 
klikt u met de linkermuisknop en sleept u op de tool. 

Als u afbeeldingen op het tabblad Afbeeldingen opnieuw wilt rangschikken, klikt u met de rechtermuisknop en selecteert 

u het drop hand-pictogram .



suiteHEART® Software-gebruiksaanwijzing NS-03-040-0008 Versie 3                                                                                                                      184

Bijlage
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Bijlage B – Voorbeeld van functionele analyse van scanvlak
Voor nauwkeurige functieresultaten moet de analyse worden uitgevoerd op een korte-asweergave zoals weergegeven in de eerste 
afbeelding hieronder.
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Corrigeer het scanvlakvoorschrift voor het verkrijgen van de korte-asweergave. Plakjes moeten worden voorgeschreven loodrecht op 
de lange as van de linker ventrikel met minimaal 2 plakjes boven de basis en 1 plakje na de top in de serie.
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